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Introduction 
This document is used for all People-Trak training courses.  
Part 1 is a self-study segment that is not taught in class.  It is 
assumed that all users in class are familiar with this material 
prior to class.  Parts 2, 3, and 4 are taught in class.  The actual 
parts you cover will depend on the course variation you are 
taking.  Part 5 is a self-study segment that is not taught in 
class.  It is supplementary material for users who wish to learn 
more about the administration features provided by People-
Trak. 

Lesson Format 
Each lesson in this Training Guide is designed to last about 30 
minutes.  In a classroom environment, the first half of the 
lesson is presented by the instructor and covers the material 
presented in the lesson.  If a self-teaching environment, the 
first half of the lesson is used to read the course material for 
the lesson.  The last half of the lesson is a series of tutorials 
used to reinforce what you have learned in class or read on 
your own. 

Daily Schedule 

Segment 1 8:30 AM – 9:00 AM 

Segment 2 9:00 AM – 9:30 AM 

Segment 3 9:40 AM – 10:10 AM 

Segment 4 10:10 AM – 10:40 AM 

Segment 5 10:50 AM – 11:20 AM 

Segment 6 11:20 PM – 11:50 AM 

Lunch 11:50 AM – 1:00 PM 

Segment 7 1:00 PM – 1:30 PM 

Segment 8 1:30 PM – 2:00 PM 

Segment 9 2:10 PM – 2:40 PM 

Segment 10 2:40 PM – 3:10 PM 

Segment 11 3:20 PM – 3:50 PM 

Questions and Assessment 3:50 PM – 4:20 PM  

 

Part 1  
Fundamentals (pre-course) 

Lesson A – Getting Started 
Tutorial A.1 – Start People-Trak 
Tutorial A.2 – Menu Navigation 
Tutorial A.3 – Changing the Current Company 
Tutorial A.4 – Stopping People-Trak 
Tutorial A.5 – Logging Off  

Lesson B – Navigation and Validation 
Tutorial B.1 – Screen Selection 
Tutorial B.2 – Selecting Sub-Screens 
Tutorial B.3 – Data Validation 
Tutorial B.4 –  Formatting Examples 

Lesson C – Operating Conventions 
Tutorial C.1 – Undoing Fields 
Tutorial C.2 – Undo an Entire Screen 
Tutorial C.3 – Deleting and Inserting Rows in a Grid 
Tutorial C.4 – Sorting Rows In a Grid 

Lesson D – Field Types and Popups 
Tutorial D.1 –  Data Entry at a Table Supported Field 
Tutorial D.2 –  Using the Date Popup 
Tutorial D.3 –  Data Entry at Multi-Line Field 
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Part 2  
Data Entry  

Lesson 1 – Using Help 
Tutorial 1.1 – Use F1 for Field Help 
Tutorial 1.2 – Using the Contents Tab 
Tutorial 1.3 – Using the Index Tab 
Tutorial 1.4 – Using the Find Tab 
 
Lesson 2 – Record Selection and Navigation 
Tutorial 2.1 – Selecting Records by ID and Name 
Tutorial 2.2 – Navigating Records 
Tutorial 2.3 – Edit a Record Group 

Lesson 3 – Add, Delete, Copy, Transfer 
Tutorial 3.1 – Add a Record 
Tutorial 3.2 – Transfer a Record 
Tutorial 3.3 – Delete a Record 
Tutorial 3.4 – Print Labels for a Group 

Lesson 4 – Notes and Attachments 
Tutorial 4.1 – Adding and Deleting Notes 
Tutorial 4.2 – Working with Note Categories 
Tutorial 4.3 – Attaching a File 
Tutorial 4.4 – Activating an Attachment 

Lesson 5 – Tables  
Tutorial 5.1 – Edit a Simple Table 
Tutorial 5.2 – Reverse Populate a Table 
Tutorial 5.3 – Print a Table 
Tutorial 5.4 – Working with a Very Complex Table 

Lesson 6 – Working with Documents  
Tutorial 6.1 –  Retrieve and Print a Document  
Tutorial 6.2 – Create a Document 
Tutorial 6.3 – Delete a Document 
Tutorial 6.4 – Copy a Document 
Tutorial 6.5 – Working with Categories 

Lesson 7 – Using the Document Viewer  
Tutorial 7.1 – Navigating a Document 
Tutorial 7.2 – Viewing, Zooming and Scrolling 
Tutorial 7.3 – Output Options 
Tutorial 7.4 – Using Page Setup 

Lesson 8 – Email  
Tutorial 8.1 – Sending an Email to the Current Record 
Tutorial 8.2 – Sending “Bulk” Email 
Tutorial 8.3 – Emailing Documents 

Lesson 9 – Batch Processing 1  
Tutorial 9.1 – Loading a Batch 
Tutorial 9.2 – Posting a Batch 
Tutorial 9.3 – Postponing and Recalling a Batch 

Lesson 10 – Batch Processing 2  
Tutorial 10.1 – Using a Combo Style Dialog 
Tutorial 10.2 – Using Lookup to Load Batches 

Lesson 11 – Using a Workflow  
Tutorial 11.1 – Modify an Existing Record 
Tutorial 11.2 – Add a New Record 

Part 3  
Query and Reporting  

Lesson 12 – Introduction to Reporting 
Tutorial 12.1 – Create a Simple Report 
Tutorial 12.2 – Changing the Report Type 
Tutorial 12.3 – Basic Formatting Options 
Tutorial 12.4 – Auto-format 

Lesson 13 – Introduction to Query 
Tutorial 13.1 – Developing Simple Queries 
Tutorial 13.2 – Trying Other Operators 
Tutorial 13.3 – Compound Operators 

Lesson 14 – Sorting and Calculating 
Tutorial 14.1 – Simple Sorting 
Tutorial 14.2 – Advanced Sorting 
Tutorial 14.3 – Using Calculations 

Lesson 15 – Report Field Modifiers 
Tutorial 15.1 – Using Date Field Modifiers 
Tutorial 15.2 – Reporting on Specific Rows 
Tutorial 15.4 – Using Query and Report Modifiers 

Lesson 16 – Design Mode 
Tutorial 16.1 – Changing Column Headings 
Tutorial 16.2 – Changing Column Widths 
Tutorial 16.3 – Changing Font Attributes 

Lesson 17 – Query Operators and Modifiers 
Tutorial 17.1 – Using Telephone Operators 
Tutorial 17.2 – Using Date Operators 
Tutorial 17-3 –  Using Modifiers 

Lesson 18 – Linking Query Equations 
Tutorial 18.1 – Creating Simple Multi-line Queries 
Tutorial 18.2 – Mixing Link Types 
Tutorial 18.3 – Point in Time Queries 

Lesson 19 – Date Substitution Variables 
Tutorial 19.1 – Entering Date Variables 
Tutorial 19.2 – Performance Reviews Due Example 

Lesson 20 – Advanced Lookup and Favorites 
Tutorial 20.1 – Creating Custom Queries 
Tutorial 20.2 – Creating a Favorite 
Tutorial 20.3 – Using Favorites 

Lesson 21 – Letter and Label Templates 
Tutorial 21.1 – Select and Modify an Existing Template 
Tutorial 21.2 – Create a Label Template 
Tutorial 21.3 – Create and Print a Label Document 

Lesson 22 – Advanced Editing and Mail Merge 
Tutorial 22.1 – Create a Letter Template 
Tutorial 22.2 – Add a Header and Footer 
Tutorial 22.3 – Insert an Image 
Tutorial 22.4 – Add a Table 
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Part 4 
Advanced Features 

Lesson 23 – Using Other Document Types 
Tutorial 23.1 – Export an Address List 
Tutorial 23.2 – Export a Birthday List 
Tutorial 23.3 – Export Compensation History 
Tutorial 23.4 – Standard Reports 

Lesson 24 – Workflows  
Tutorial 24.1 – Modify a Workflow 
Tutorial 24.2 – Create a New Workflow 
Tutorial 24.3 – Deactivate a Workflow 

Lesson 25 – Customization 1 
Tutorial 25.1 – Changing the Screen Caption 
Tutorial 25.2 – Changing the Field Name 
Tutorial 25.3 – Changing Edit Attributes 

Lesson 26 – Customization 2 
Tutorial 26.1 – Changing a Support Table 
Tutorial 26.2 – Activating the ‘Not Used’ Feature 
Tutorial 26.3 – Using ‘Mandatory’ Fields 

Lesson 27 – Scheduler 1 
Tutorial 27.1 – Create a Scheduled Item 
Tutorial 27.2 – Modify a Scheduled Item 
Tutorial 27.3 – Delete a Scheduled Item 

Lesson 28 – Scheduler 2 
Tutorial 28.1 – Schedule a Document 
Tutorial 28.2 – Running an Item ‘At Login’ 
Tutorial 28.3 – Schedule with Document Explorer 

Lesson 29 – Alerts 
Tutorial 29.1 – Create and Test a New Alert 
Tutorial 29.2 – Modify a Existing Alert 
Tutorial 29.3 – Delete a Existing Alert 

Lesson 30 – Inbox 
Tutorial 30.1 – Using Inbox Features 
Tutorial 30.2 – Running Scheduled Items and Alerts 
Tutorial 30.3 – Reactivating a Postponed Batch 

Lesson 31 – User Preferences 
Tutorial 31.1 – Setting Data Entry Preferences 
Tutorial 31.2 – Changing Screen Order 
Tutorial 31.3 – Changing Report Preferences 

Lesson 32 – Contact Manager 
Tutorial 32.1 – Add a Contact 
Tutorial 32.2 – Delete a Contact 
Tutorial 32.3 – Using Ticklers 
Tutorial 32.4 – Making a Contact Common 

Lesson 33 – Inter-Module Communication 
Tutorial 33.1 – Applicant to Personnel 
Tutorial 33.2 – Personnel to Applicants, Safety, COBRA 
Tutorial 33.3 – Position Control to Personnel, Applicants 

Part 5 
Setup and Administration 

Lesson E – Enterprise/Company Setup 
Tutorial E.1 – Adding/Deleting Companies 
Tutorial E.2 – Changing Logo and Report Appearance 
Tutorial E.3 – Changing Formats 
Tutorial E.4 – Using External Programs 

Lesson F – Module Setup 
Tutorial F.1 – Changing Active Screens 
Tutorial F.2 – Changing Lookup Fields 
Tutorial F.3 – Using Auto-Numbering 

Lesson G – Security Setup 
Tutorial G.1 – Securing Companies and Modules 
Tutorial G.2 – Securing Menu Options 
Tutorial G.3 – Setting Field Security 
Tutorial G.4 – Setting Record Security 

Lesson H – Import 
Tutorial H.1 – Setting Up Import 
Tutorial H.2 – Performing the Import 
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Document Conventions 
The standard writing conventions used in this document are 
described below. 

Pressing Keys 
When an instruction involving a key on the keyboard is issued, 
the standard format shown below is used. 

Press the ENTER key. 
Press the DOWN ARROW key. 

The phrase "press" indicates that a key is to be pressed down.  
The key name (ENTER and DOWN ARROW in the 
examples) is written out and capitalized.  The phrase "key" 
always follows the key name. 

The key names used in all instructions are generic and may 
differ slightly from the keys on your keyboard.  For example, 
the ENTER key may be labeled RETURN or NEWLINE.  

Entering Information 
When an instruction involving a typed response is issued, the 
standard formats shown below are used. 

Enter the employee number. 
Enter "N." 

The phrase "enter" indicates that a letter or phrase is to be 
typed on the keyboard.  When a single letter or short phrase 
(such as "N" in the second example) is to be entered, the re-
sponse is highlighted by quotation marks.  When the response 
is actually typed, the quotation marks are not required and 
should not be entered. 

The Phrase "Display" 
The phrase "display" is used as a verb to describe the ap-
pearance of menus, prompts, processing screens, reports, and 
messages on the video screen.  Examples are shown below. 

The Color Dialog is displayed. 
The message shown below is displayed. 

The Phrase "Print" 
The phrase "print" is used as a verb to describe the appearance 
of reports on the printer.  Examples are shown below. 

When the report has printed ... 
This option is used to print the ... 

The Phrase "Point" 
The phrase "point" is used as a verb to describe how to move 
the mouse pointer such that the tip of the pointer (also known 
as the “hot zone) rests on a specific field, menu option, button, 
or area on the screen.  An example is shown below. 

Point to the Employee Last Name field. 

The Phrase "Click“ 
The phrase “click“ is used as a verb to describe the process of 
pressing and immediately releasing the mouse button without 
actually moving the mouse. 

Click the Run button. 

The Phrase "Double-Click“ 
The phrase “double-click“ is used as a verb to describe the 
process of pressing and immediately releasing the mouse 
button two consecutive times without actually moving the 
mouse. 

Double-click the desired item 



 

Basic Training Guide - 7 

1 

Fundamentals 
Lesson A – Getting Started 
Tutorial A.1 – Start People-Trak 
Tutorial A.2 – Menu Navigation   
Tutorial A.3 – Changing the Current Company 
Tutorial A.4 – Stopping People-Trak 
Tutorial A.5 – Logging Off  

Lesson B – Navigation and Validation 
Tutorial B.1 – Screen Selection 
Tutorial B.2 – Selecting Sub-Screens 
Tutorial B.3 – Data Validation 
Tutorial B.4 –  Formatting Examples 

Lesson C – Operating Conventions 
Tutorial C.1 – Undoing Fields 
Tutorial C.2 – Undo an Entire Screen 
Tutorial C.3 – Deleting and Inserting Rows in a Grid 
Tutorial C.4 – Sorting Rows In a Grid 

Lesson D – Field Types and Popups 
Tutorial D.1 –  Data Entry at a Table Supported Field 
Tutorial D.2 –  Using the Date Popup 
Tutorial D.3 –  Data Entry at Multi-Line Field 
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Lesson A 
Getting Started 

The lesson introduces the techniques used to start People-
Trak, navigate through the menus, change the current 
company, logoff, and stop People-Trak. 

Source Text 
People-Trak Basics – Chapter 3 
People-Trak Basics – Chapter 4 

Tutorials 
Start People-Trak: This tutorial demonstrates the techniques 
used to start People-Trak.  

Menu Navigation: demonstrates the methods used to select 
and navigate menu options. 

Changing the Current Company: demonstrates two methods 
used to change the current company to one of the companies 
to which you have been granted access. 

Stop People-Trak: shows how to stop People-Trak when a 
processing session has been completed. 

Logging Off: shows how to logoff the current user without 
actually stopping People-Trak. 

Tutorial A.1 
Start People-Trak 
1. Select People-Trak using the appropriate icon or menu 

entry. The Login dialog is displayed. 

2. The Login dialog is the gateway to People-Trak. The user 
ID/password you enter here determines which programs 
you can use and which information you can see. When the 
User ID/Password window is displayed, the cursor is 
positioned to the user ID field. Let's learn a few things 
about entering user ID/password combinations as well as 
other information in People-Trak. 

3. Enter the user ID "DEMO" and press the TAB key. The 
cursor moves to the Password field. Enter the bogus 
password "BOGUS", but do not press the TAB or ENTER 
key. As the password is entered, note that an asterisk is 
displayed for each character entered. The asterisks are 
displayed to let you know that something is happening. 
The actual characters of the password are not displayed 
for security reasons. 

4. Press the ENTER key when complete or select the OK 
button. The message shown below is displayed because 
the password "BOGUS" is indeed bogus. 

Invalid User ID/Password Combination 

5. This message and all similar messages are displayed in a 
message box. The message box pops up to get your 
attention and is cleared when you take the appropriate 

action. In this case, the message box contains a single 
button. You can press ENTER to select the action 
indicated by the button, or you can use the mouse to click 
on the button. 

6. Press the ENTER key to continue. The user ID and 
password entries are cleared and the cursor is returned to 
the user ID field so that you may try again. Each time you 
start People-Trak, you have three attempts to enter a 
correct user ID/password combination. If the third attempt 
fails, you are automatically returned to Windows. Let's 
demonstrate this. 

7. Enter "BOGUS" and press the ENTER key. This time, use 
the mouse to select the OK button. Repeat this process 
one more time. After the invalid user ID/password, you 
are swiftly returned to Windows. People-Trak has 
assumed that you are an unwanted intruder because you 
do not know a valid password and has forced you to start 
over. This may seem rude, particularly if you tend to 
forget your password or make a lot of typing errors, but it 
does thwart hackers who will sit for hours trying to break 
the security. 

8. Select the People-Trak icon again. The Select User dialog 
is again displayed. 

9. Enter the user ID "DEMO" and the password "DEMO" 
and press the ENTER key.   The Select Module dialog is 
displayed. 

10. The Select Module dialog is used to select the module you 
wish to work with.  A module can be selected by a simple 
mouse-click.  Try it now.  Select the Personnel module.  
After a few seconds, the basic environment screen is 
displayed.  Other than the menu bars and tool bars, it is 
just a big gray background.  However, you are in the 
module and you are ready to continue with the next 
tutorial. 

Tutorial A.2  
Menu Navigation 
When you first select a module you can start virtually all of 
the options in that module. As you will see later, once a record 
or another process has been selected, or if a new record is in 
progress , many options are disabled to avoid processing 
conflicts. For now, let's learn how to navigate in People-Trak. 

1. People-Trak uses standard Windows operating 
conventions. You can see the Menu Bar at the top of the 
screen. You can activate the menu by using the mouse to 
click on the menu title, (or you can press the ALT key and 
the underlined letter in the menu title for you keyboard 
people). Let's try it now. 

2. Use the mouse to click on the File Menu. The menu is 
popped up and lists the various options that are available. 
Those options that are listed in black are available, while 
those that are grayed out are not. You can highlight and 
select any available option. We'll do that later. For now, 
let's clear the menu. 
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3. To clear a menu, move the mouse off the menu and click. 
The menu is cleared. You can also clear a menu by 
pressing the ESC key.  

4. Now is a good time for you to peruse each of the menus. 
Using the desired technique, select each of the menus 
listed and review the menu. Do not select any of the menu 
options themselves at this time. If you note that options 
are grayed out, this is because the option is either not 
available because it is dependent on another process or 
because you have been restricted by the System 
Administrator. Once you have made yourself familiar 
with the menus, continue with the next step. 

5. Now it's time to select an option from one of the menus. 
First, select the File Menu and then select the Open 
Employee option.  

6. The Lookup dialog is displayed. We'll learn more about 
this later. For now, press the Cancel button to clear the 
option.  

7. This is really all there is to menu navigation. Certain 
menu options will display other menus, but in each case 
these same operating conventions apply. 

8. Clear any menus or dialogs and continue with the next 
tutorial. 

Tutorial A.3 
Changing the Current Company 
You can change the current company at any time to any other 
company to which you have access.  There are two ways to do 
this.  You’ll try each below. 

1. Using your recently acquired menu navigation skills, 
choose the Select Company option from the File Menu.  
A list of the companies to which you have been granted 
access is displayed. 

2. To select a company, highlight the company name and 
press OK.  Or, highlight the company and press the 
ENTER key.  Or, highlight the company and double-click 
the highlighted row. 

3. Go ahead and select a company.  You may now continue 
processing just as before except that all processing will 
now be within the company you have just switched to.  
Nothing else has changed.  You are just working with a 
different collection of data. 

4. Now we’ll use another method to select a company and 
conveniently set the company back to the one we wish to 
work with.  Locate the Company Dropdown on the Tool 
Bar.  You’ll see the current company name and the small 
arrow just to the right.  Click on the company name and 
you will see a dialog with details about the current 
company.  Try it now.  Then, close the dialog. 

5. Now click on the arrow portion of the Company 
Dropdown.  This time, the same list of companies is 
displayed as with the first company selection method 
described above.  Go ahead and select the company you 

originally started with.  Be creative, use a different 
selection method than you did the first time. 

6. Continue with the next tutorial 

Tutorial A.4 
Stopping People-Trak 
People-Trak uses standard Windows operating conventions. 
Closing dialogs can be done in two different ways: you can 
use the “X” button (Close Dialog button) in the upper right 
hand corner of the dialog, or you can use the appropriate 
option on the File Menu.  If any dialogs are in use when it is 
time to exit, that dialog and any other open dialogs must first 
be closed. Let's set up this scenario and then exit. 

1. Select the Tables menu. At the Tables menu, select the 
Table Edit option. From the list of tables, select the 
Department table. Unofficially, you are now editing the 
Department table.  Now let's assume that it's time to go to 
lunch and you wish to exit. 

2. Select the Exit option from the File Menu or click the “X” 
in the corner of the dialog.  This will close the dialog and 
return you to the generic environment screen. 

3. Now select the Exit option from the main File Menu or 
click the “X” in the corner of the dialog.  You will exit 
People-Trak and return to Windows. 

4. Continue with the next tutorial. 

Tutorial A.5 
Logging Off 
You do not have to exit People-Trak completely when you 
wish to stop processing.  You have the option of simply 
logging off.  You may wish to do this when you are finished 
with a session, or when you wish to log on as another user.  
This final tutorial will test many of the things you have 
already learned.   

1. Start People-Trak and login with DEMO / DEMO.  

2. Select the Personnel module 

3. Now let’s assume that you wish to logout.  Select the File 
Menu and you will notice that there is an option labeled 
“Logoff ‘DEMO’”.  Before you select this option, you 
should note that the actual message differs depending on 
the user ID of the user who is logged in.  Now go ahead, 
and select the option. 

4. The Select User dialog is displayed.  You can now login 
again as the same user or as any other user. 

5. This tutorial and this lesson are now complete.  Exit 
People-Trak by clicking the Cancel button on the Select 
User dialog. 
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Lesson B 
Navigation and Validation 

This lesson describes the techniques used to navigate between 
the various screens in a People-Trak module.  It also describes 
the data validation and formatting features of People-Trak. 

Source Text 
People-Trak Basics – Chapter 4 

Tutorials 
Screen Navigation: demonstrates how to navigate among the 
screens that are provided within each module.  This includes 
three different methods for changing the current screen. 

Selecting Sub-Screens: shows how to select a sub-screen 
from a primary data entry screen and to subsequently exit the 
screen either saving or abandoning any changes made on the 
sub-screen. 

Data Validation: demonstrates how the data validation 
features work to prevent invalid data from being saved to the 
underlying People-Trak database. 

Formatting Examples: demonstrates how data is formatted 
when it is entered. 

Tutorial B.1 
Screen Navigation 
It takes a number of screens to collect and display all of the 
information for an employee or applicant.  This tutorial 
demonstrates multiple ways to navigate these screens. 

1. Start People-Trak, login with DEMO/DEMO, and select 
the Personnel module using the techniques learned in 
Lesson 1.  Now follow the instructions below to select an 
employee.  (You will learn more about selecting records 
in subsequent lessons.) 

2. Select the Lookup option using the Open Employee 
option on the File Menu or the Open icon on the Tool 
Bar.  The Lookup dialog is displayed.  Click on the search 
button to display the list of records in the DEMO 
company.  Select Donald Stern from the list by 
highlighting his name and double-clicking on that row. 

3. The “Personal” screen is displayed for Donald Stern.  The 
name of the current screen is listed in the Screens 
Dropdown on the Navigation Bar.  Look for the phrase 
"Personal". This box acts as a both a label for the current 
screen as well as a list box for selecting any of the other 
screens. Let's use this Screens Dropdown to select a 
different screen now. 

4. Use the mouse to click on the arrow button connected to 
the Screens Dropdown.  A list of the available screens is 
displayed. Click on the Status screen. The Status screen 
with the status information for Donald Stern is displayed. 

5. Try it again. Select any of the screens listed and see the 
information. When you are comfortable with the concept 
of selecting screens using the Screens Dropdown, 
continue with the next step. 

6. There are a couple of other techniques that can be used to 
move to another screen. Let's try these now. Look at the 
blue arrow buttons just to the right of the Screens Box.  

7. Click the right arrow button. The next screen is displayed 
and the screen name in the Screens Dropdown is updated. 
The next screen that is displayed is always the next screen 
relative to the current position in the Screens Dropdown. 
For example, if you are at the Personal screen and click 
the right arrow button, the Status screen will be displayed. 
If you are at the Status screen, the Compensation screen 
will be displayed. If you are at the last screen in the list, 
the first screen will be displayed.  

8. You have probably already guessed, but the left arrow 
identically to the right arrow except in the opposite 
direction. Try it now. Again, note how the screen name in 
the Screens Box is updated to let you know where you 
are. When you are comfortable with the function of the 
buttons, continue with the next step. 

9. There is one final method for browsing through the 
screens using keys. The PAGE UP and PAGE DOWN 
keys perform the same functions as the right and left 
arrow buttons. Try the PAGE UP and PAGE DOWN keys 
now. The succeeding and preceding screens are displayed 
and the screen name is updated in the Screens Dropdown. 

10. Any of these techniques can be used at any time. There is 
no right or wrong way. You will find that it takes two 
clicks on the mouse to pick any screen using the Screens 
Dropdown, while it can take multiple button presses or 
PAGE keys to move to the desired screen. The particular 
techniques you use in any particular case will become 
second nature as you grow accustomed to People-Trak. 

11. Use any desired technique to return to the Personal 
screen.  Continue with the next tutorial. 

Tutorial B.2 
Selecting Sub-Screens 
There are both "full-screen" data entry screens as listed in the 
Screens Dropdown and pop-up sub-screens that are used to 
capture and display additional information that is related to the 
general subject defined by the full screen. For example, on the 
Personal screen, there are sub-screens for emergency contacts, 
company property, and notes.  Let's show you some pop-up 
windows and how to select them. 

1. When concluding the last tutorial, you left the Personal 
screen displayed for Donald Stern. On that screen, note 
that there are three (or four) large buttons just to the right 
of the data entry screen. Each of these buttons is labeled 
with the name of a sub-screen. 

2. The technique used to display a sub-screen is quite 
simple. Just use the mouse to click on the button. Try it 
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now to select the Emergency button. When the sub-screen 
is displayed, you can see the additional information 
regarding the emergency contacts for Donald Stern. 

3. Each sub-screen has a File Menu, as well as an “X” in the 
upper right hand corner.  When you are finished viewing, 
changing, or adding information, simply use the “X” or 
the Exit option on File Menu to exit.  If you have made 
any changes and you use the File Menu, the changes are 
automatically saved.  If you have made changes and use 
the “X” button, you will be prompted to save the changes 
in process.  Let’s try both. 

4. Make a simple change to the Emergency Contact sub-
screen.  Then use the Exit option on the File Menu.   

5. Return to the Emergency Contact sub-screen using what 
you have learned earlier in this tutorial.  Note that your 
change was saved.  Now change the information back to 
way it was and press the “X” button.  The prompt shown 
below is displayed. 

Do you want to save the changes in process?  

6. Click on the Yes button to save the change.  If you had 
clicked on the No button, the changes (any and all) would 
have been ignored.  If you had clicked on the Cancel 
button, you would have been left on the sub-screen to 
continue processing. 

7. Now try the sub-screens for Property and Notes just to 
show that sub-screens all work alike. 

8. The sub-screens on each screen are of the same subject 
matter as the screen itself. You can see this for yourself 
by browsing through each of the screens and popping 
each of the windows. Try it now.  

9. Once you have popped a sub-screen, the pop-up feature is 
disabled until you return to the current main screen. In 
other words, it is not possible to pop a sub-screen on top 
of a sub-screen.. To see for yourself, return to the 
Personal screen and select the Property pop-up. While the 
Property sub-screen is displayed, the buttons for all of the 
other sub-screens are disabled.   

10. Return to the Personal screen and continue with the next 
tutorial. 

Tutorial B.3 
Data Validation 
Data validation protects the database from receiving incorrect 
or inappropriate data from the data entry process.  Data is 
validated during data entry both when keys are pressed and 
when you leave the field.   

1. On the Personal screen for Donald Stern, position the 
cursor to the Birth Date field.  This field contains the 
current birth date.  Clear the birth date. 

2. Try to enter a birth date that contains letters.  Note that 
the letter characters are rejected and are not displayed in 
the date field.  This is an example of data validation that 

is performed during the data entry process.  The only keys 
that are valid at date field are the dash, the slash, and the 
numbers.  This same principle also applies to numeric 
fields.  Let’s try it. 

3. Use your newly acquired screen navigation skills to 
position the cursor to the Rate field on the first blank row 
of the Compensation Screen.  The Rate field is a numeric 
field and can only accept numeric values.  Try a few 
characters and then try a few numbers.  Finally, try the 
period (decimal point) and the dash.  The dash is needed 
because it is used to indicate negative (less than 0) 
numeric values.  You cannot enter the dollar sign. 

4. Preventing unwanted keys is not a foolproof way of 
preventing invalid data.  You can still enter an invalid 
date using only the valid keys and you can still enter an 
invalid number using only the valid keys.  Return to the 
Birth Date field on the Personal screen and we will 
demonstrate what happens. 

5. Enter the birth date “33-33-3333”.  No invalid keys have 
been used, but the date is invalid because there are only 
12 months in a year and no more than 31 days in a month.  
To see what happens, press the ENTER key.  The 
message shown below is displayed. 

6. Invalid Date 

7. Data entry errors are not often as obvious as this 
outrageous date.  Try the example again, but enter the 
date “06-31-2002”.  This looks like a valid date, but June 
has only 30 days.  This error will be detected and the data 
entry rejected.  If you need further examples, try February 
29 in a non-leap year or some other subtle but incorrect 
date.  The invalid data entry will be caught and rejected 
before it can be stored in the database. 

8. As mentioned, validation must occur whenever you leave 
the field, not just when you press the ENTER key or TAB 
key.  Try this.  Enter an invalid date, but do not press 
ENTER or TAB.  Instead, try to select another screen as a 
way of getting past the error.  You won’t make it.  The 
error will still be detected and your bad date rejected.  
This same feature works with any field that requires 
validation including numeric fields that do not match the 
decimal pattern or size constraints of the field.  You can 
try your own examples if you like. 

9. Return to the Personal screen and then continue with the 
next tutorial. 
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Tutorial B.4 
Formatting Examples 
Formatting is the process of displaying data in a desired form.  
There are many ways to display dates, numeric values, and 
text phrases.  The formatting attributes of each field are stored 
within People-Trak.  These attributes can be changed using the 
customization features in People-Trak, but that is another 
lesson in another course.  This tutorial will show how the 
formatting actually works. 

1. Position the cursor to the Last Name field on the Personal 
Screen.  By default, the Last Name field has been 
provided with the “proper case” formatting attribute.  In 
general, the proper case attribute makes the first character 
of each word upper case and makes the other characters 
lower case. 

2. Clear the Last Name field and then the last name “jones” 
in full lower case.  Then press the ENTER key.  The last 
name will be reformatted to “Jones”.  Try it again, but key 
the entire name in upper case.  When you press the 
ENTER key, the last name will be formatted as before. 

3. The proper case attribute is reasonably smart when it 
comes to formal names.  To see what I mean, enter the 
last name “macdougal” in any desired case pattern and 
watch what happens when you press the ENTER key.  
The last name will be echoed in the format “MacDougal” 
as is appropriate.  Most variations of names are handled 
correctly, as are common abbreviations such as RR, PO 
Box, etc.   

4.  There are other formatting attributes for different types of 
fields and they work the same.  If you enter the field in 
the wrong format, but the entry is valid, the entry will be 
formatted appropriately.  For example, numeric fields 
have a formatting attribute that determines total length 
and decimal places.  Let’ see how this works. 

5. Position the cursor to the Std Hours field on the first 
blank row of the Compensation screen.  This field has the 
format “##.##” which means that you can enter  up to two 
digits to the right of the decimal place and up to two digits 
to the left of the decimal place.  If you enter the value 
“9999”, you will receive a validation error because the 
entry is not valid according to the format.  However, if 
you enter the value “99.9” or “9.99” you will not receive 
a validation error, because the values can be formatted to 
“99.90” and “9.99” respectively.  Try these examples and 
any other range of numeric values that are or are not 
applicable to this format. 

6. This tutorial and this lesson are now complete.  Exit 
People-Trak using the techniques you have learned. 
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Lesson C 
Operating Conventions 

The lesson describes and demonstrates many of the standard 
operating conventions provided by People-Trak including 
special colors, cut/copy/paste, date stamp, undo, and grid 
features such as inserting, deleting, and sorting rows. 

Source Text 
People-Trak Basics – Chapter 4 

Tutorials 
Undoing Fields: demonstrates the techniques used to undo 
individual fields one at a time, including the ability to perform 
multiple undo’s on the same field. 

Undo an Entire Screen: shows how to undo the data entry on 
an entire screen with a single action.  

Deleting and Inserting Rows in a Grid: demonstrates the 
button based and key based methods for deleting and inserting 
rows on any grid where these capabilities are enabled. 

Sorting Rows in a Grid: shows how to sort the rows on any 
grid where the sort capability has been enabled. 

Tutorial C.1 
Undoing Fields 
Undo is a powerful feature that lets you correct mistakes and 
return data to a prior state.  Here’s how to use the feature on a 
field-by-field basis. 

1. Start People-Trak and login as you have learned in prior 
lessons.  Select Donald Stern as we did in the last lesson.  
Here’s how. 

2. Select the Lookup option using the Open Employee 
option on the File Menu or the Open icon on the Tool 
Bar.  The Lookup dialog is displayed.  Click on the search 
button to display the list of records in the DEMO 
company.  Select Donald Stern from the list by 
highlighting his name and double-clicking on that row. 

3. To demonstrate the Undo feature, we need to make 
changes to some fields.  Rather than just making changes, 
we will demonstrate the cut, copy, and paste feature of 
People-Trak to make these changes. 

4. Position to the Last Name field.  Select the contents of the 
field using the mouse or using the Select All option from 
the Edit Menu.  Then use the Cut button on the Tool Bar 
or the Cut option on the Tool Bar to cut (delete) the 
contents of the Last Name field.  The Last Name field 
should end up blank. 

5. Move the cursor to the First Name field and use the Paste 
button on the Tool Bar or the Paste option on the Edit 
Menu to paste (insert) the text that was cut from the Last 
Name field into the First Name field.   

6. Position to a few other fields and paste the contents of the 
Last Name field into those fields as well.  Now we have 
some changes to work with. 

7. First, note that the fields that have been changed are in a 
different color than the fields that have not been changed.  
This makes it easy to see what you have done.  Now 
position the cursor to blank Last Name field.  Note that 
the Undo button becomes enabled.  (If you position to an 
unchanged field, the button will be disabled.  Try it if you 
do not believe me).   Any field that has been changed, as 
indicated by the modified color, can be undone.  Let’s try 
a few. 

8. Click the Undo button and the Last Name field that was 
modified (by having been deleted with the Cut feature) is 
restored.  The color is reset to the unmodified state and 
the Undo button is disabled because there is now nothing 
to undo at this field.  

9. Before you undo any other fields, use the Edit History 
button on the Edit Menu to display the Edit History log.  
Note that all of the changes you have made, except for the 
Last Name change that was undone, are listed.  Now close 
the Edit History dialog and undo all of the other fields one 
after another.  When there are no fields in the modified 
color, you are finished.  Now try the Edit History Log 
again.  There should be no remaining changes because all 
of them have been undone. 

10. The undo feature supports multiple undo’s for the same 
field.  To show how this works, change the Last Name 
field four or five times.  Use whatever technique you 
want.  Use the Edit History log to verify that all of the 
changes to the field have been recorded.  The Before and 
After columns should indicate the progress you made. 

11. Now use the Undo button to undo the first change.  Note 
that the color does not revert back to the unmodified state 
and that the Undo button remains enabled.  Now, undo 
each of the changes until you have restored the Last Name 
field to the original phrase.  Now the color has been 
restored and the Undo button is disabled. 

12. Continue with the next tutorial. 

Tutorial C.2 
Undo an Entire Screen 
The last tutorial showed you how to undo fields one at a time.  
If you make a lot of mistakes or if you inadvertently delete 
rows in a grid, you can undo all of the changes on a screen at 
one time.  The technique is quite simple. 

1. Use whatever method you want to change four or five 
fields on the current screen.  When the changes are 
complete, use the navigation skills learned in the last 
lesson to move to any other screen.   

2. Now return to the Personal screen and note that the fields 
you had changed are still in the modified color and that 
they are still listed in the Edit History log.  These changes 
have been recorded in the database when you changed 
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screens, but they can still be undone.  The undo feature 
simply uses the “before” value in the Edit History log to 
restore the field contents.  Try the Undo on one of the 
fields you have changed. 

3. The Undo capability persists until you leave the current 
record.  Whatever changes are visible in the Edit History 
Log can be undone using the Undo Field feature.  

4. The Undo Screen is not as flexible.  It can only undo 
changes that have been made on the current screen before 
the changes have been saved.  The Undo Screen can undo 
all the changes at once, but it cannot recover saved 
changes. 

5. The changes that you have made were saved when you 
left the screen and came back.  These cannot be undone 
all at once.  Try it using the Undo Screen option on the 
Edit Menu.  What happens?  Nothing. 

6. Now make a few other changes.  Then use the Undo 
Screen feature.  What happens this time? All of the 
changes made since the screen was saved are undone. 

7. Undo Screen is particularly useful on grids.  At the 
current time, there is no way to undo a row delete.  If you 
inadvertently delete a row when you meant to insert a 
row, the best way to recover is to undo the entire screen.  
This works great for the first mistake, but if you have 
already successfully entered rows and then make a 
mistake, you would lose the rows just entered if you undo 
the screen. 

8. To see how the Undo Screen feature works on grids, 
select the Compensation Screen.  Delete a few rows and 
then insert a few other blank rows.  When you have the 
grid completely ruined, use the Undo Screen feature and 
see what happens.  The grid is restored to its original 
state.  Continue with the next tutorial. 

Tutorial C.3 
Deleting and Inserting Rows in a 
Grid 
1. Select the Performance Reviews screen. Note that Donald 

has multiple performance review rows in the grid.  

2. There is no limit to the number of performance review 
rows available, but only a portion of these can be seen at 
any one time. To view performance review rows are not 
in the viewable area, use either the DOWN ARROW key 
or the scroll bar on the right (Remember, the PAGE 
DOWN key will move to the next screen).  

3. When rows in a grid are dated, it is strongly 
recommended that the rows be maintained in descending 
order. To do this you need to know how to insert rows. 

4. Check the Tool Bar and note that Insert Row button in 
enabled.  Click on the button.  Note that all subsequent 
rows are pushed down and that the current record is 
cleared for a new entry. The Insert Record feature 
performs this task on nearly all grid screens (some do not 

allow insert and delete).  You can insert a row for a new 
first record, or you can insert a row at any other row. Try 
it now and do not worry about the blank rows. We'll learn 
how to delete rows next. 

5. Position to the first blank row you inserted. Now press the 
Delete Row button on the Tool Bar.  The row is deleted 
and all subsequent rows are scrolled up.  Use the Delete 
Row button to delete any other rows you have entered.  
The Insert Row and Delete Row functions are also 
available as options on the Edit Menu.   

6. The Insert Row and Delete Row functions are available at 
nearly all grids.  In a few cases, rows are displayed and 
can be edited, but rows cannot be inserted or deleted.  In 
those instances, the Insert Row and Delete Row buttons 
and menu options will be disabled. 

7. This tutorial is complete. Leave the cursor on the 
Performance Reviews screen and continue with the next 
tutorial. 

Tutorial C.4 
Sorting Rows in a Grid 
In the last tutorial, we mentioned that rows on grids can be 
entered in ascending, descending, or totally random order. 
This may occur intentionally or unintentionally. Fortunately, 
you can sort these rows. You'll learn how in this tutorial. 

1. First, determine the order of the rows on the Performance 
Review screen by checking the Review Date field. The 
rows were originally recorded in descending order so that 
the most recent record is on top. Perhaps this is acceptable 
for your organization and perhaps it is not. Let's assume it 
is not. 

2. Sorting is almost always applicable for grids (it is 
disabled in a few cases) and is easy to perform.  To sort 
based on the Review Date, position the cursor to one of 
the fields in the Review Date column.  Then click on the 
header for that column.  The rows were listed in 
descending order; therefore, People-Trak has now 
switched them to ascending order. If you click on the 
header again, they will be resorted back in descending 
order.  As many times as you click, People-Trak will 
reverse the sort order from Ascending to Descending. 

3. It is essential that you position the cursor to a field in the 
column you wish to sort.  If you just click on the header 
for another column in which the cursor is not located, the 
rows are not sorted.  It may appear that sorting is 
disabled, but it is probably not. 

4. To show that you can sort by any desired column, 
position the cursor to a field in the Rating column.  Then 
sort on the Rating column by clicking on the header.  
Click again to resort in the opposite order.  You can try 
this with as many columns as you wish. 

5. When you sort rows on a grid, the sorting is persistent.  
This means that the rows are stored back into the database 
in the order in which you last sorted them.  We’ll show 
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this.  Sort the performance reviews in some obvious order 
and then move to another screen.  Remember, changes are 
saved when you leave the screen, including sorting.  Now, 
return to the Performance Reviews screen.  Note that the 
rows are retrieved and displayed in the order in which you 
last left them.  Sort the rows again and leave the screen 
and come back.  Note that the sort order persists. 

6. People-Trak provides a capability to prevent specific 
users from sorting grids.  This is something you may 
consider if rows are continually sorted in different orders 
because users are too casual with their sorting.  You can 
check with your support representative to show you how 
to enable and disable grid sorting. 

7. This tutorial and this lesson are now complete.  Exit 
People-Trak using the techniques you have learned. 
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Lesson D 
Field Types and Popups 

This lesson introduces the field types used within People-Trak 
and demonstrates the conventions used with each type.  In 
addition, this lesson describes the popup dialogs that are 
associated with the various field types. 

Source Text 
People-Trak Basics – Chapter 4 

Tutorials 
Data Entry at a Table Supported Field: demonstrates the 
use of the table popup and table validation rules.  Includes 
keyboard equivalents and multi-field tables. 

Using the Date Popup: describes the date popup and provides 
unique time saving ways to enter dates. 

Data Entry at a Multi-line Field: shows how the multi-line 
popup is best keyed using the multi-line popup. 

Tutorial D.1 
Data Entry at a Table Supported 
Field 
People-Trak utilizes optional table files. This means that many 
of the standard entries can be pulled from pre-defined tables. 
The advantage of using tables is that data entry can be 
standardized. When used correctly, there won't be a different 
version of an entry for every employee entered.  

1. Start People-Trak, login, and select Donald Stern for 
processing.  Position the cursor to the Personal screen. 

2. To avoid the tremendous distraction of popup buttons all 
over the screen, People-Trak only displays the popup 
button when the cursor is actually positioned to a field 
supported by a popup.  Use the TAB or ENTER key to 
move through each of the fields on the Personal screen.  
Note that both table and date popups appear in many 
places.  If you see a popup button of some type, the field 
is supported by a popup. 

3. Position the cursor to the City field.  The City field is 
supported by the City table.  The City table is normally a 
list of those tables in the general vicinity of your facility. 

4. The simplest way to complete a field at a field supported 
by a table is to use the popup feature.  Try it now, click on 
the button adjacent to the City field and select an entry 
from the table.  Note that when the entry is returned from 
the table, the color is changed and the Undo button is 
enabled.  Selecting an entry from a table is just like 
keying, only faster. 

5. If you are accustomed to keying rapidly and do not like to 
leave the keyboard to use the mouse, any popup can be 

activated using the F3 key.  Try it now.  The popup will 
be displayed just as if you clicked on the button. 

6. You are not limited to using the popup on tables and 
certain other popup supported fields.  You can key the 
value directly and validation against the table will be 
performed.  Let’s try this. 

7. Enter the city name “Vista” and press the ENTER key. 
The value is validated against the entries in the table and 
is accepted.  Now let's try something else. Enter the city 
"QQQQ" and press the ENTER key. This is a bogus city 
(as you might have expected) and one of the two 
messages shown below is displayed. 
 
Table Entry Does Not Exist – Override Table Y/N 
Table Entry Does Not Exist 

8. The first message is displayed when the usage of the table 
has been defined as optional. When a table is optional, 
entries are validated against the table, but you have the 
option of entering a value that is not in the table. The 
second message is displayed when the usage of the table 
is mandatory. When a table is mandatory, the entry must 
match an entry in the table or the entry will be disallowed. 

9. Enter "Y" or press the ENTER key to continue.  The 
value will be accepted or rejected according to the 
validation rules for the table.  A table such as the City 
table is normally set to optional because there are many 
city possibilities.  Other tables such as departments or job 
codes would be set to mandatory because these tables 
would never be overridden. 

10. There are dozens of tables just like the City table 
throughout People-Trak.  The operating conventions are 
always the same. 

11. Tables (and all popups) work on grid text boxes just like 
they do on regular text boxes.  Let’s try one. 

12. Select the Compensation screen and position the cursor to 
the Change Reason field.  This field is supported by the 
Change Reason table that provides a list of reasons why a 
salary change was made.  Note that the table popup 
appears adjacent to the field for the current row only.  
You can select from the table by clicking the popup or by 
using Function Key 3.  Try it now. 

13. Because a table field is a table field is a table field, you 
can also key the field directly.  The entry will be validated 
just as it was with the City field.   

14. The City table and the Change Reason table are simple 
tables and support the entry of a single field.  There are 
other more complex tables that support the entry of 
multiple fields.  Let’s see how one of these works. 

15. To view/edit the Job Details information for the first 
compensation row, click on the black RIGHT ARROW 
located on the first row of the compensation grid.  The 
Job Details popup is displayed. 
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16. Position the cursor to the Job Code field.  Click on the 
popup button to activate the table and select the Sales 
Manager entry.  Multiple fields from the table are then 
placed into the corresponding fields on the Job Details 
screen. 

17. The color of all returned fields is changed and an entry is 
placed into the Edit History Log for each field.  As far as 
People-Trak is concerned, all of the data entry performed 
from this table selection might just as well have been 
performed manually, field by field.  If you move the 
cursor around on the returned fields, you will note that 
you can undo them individually and that you can override 
them with values that did not originate from the table.  (If 
you change the Job Code field itself, you will be selecting 
another entry.) 

18. If your organization elects not to use one or more of the 
tables, the key field works like any other field. It can 
accept any value that the length of the field allows. No 
special editing is performed, nor are any of the related 
fields displayed. 

19. Continue with the next tutorial. 

Tutorial D.2 
Using the Date Popup 
Date fields are used throughout People-Trak and date fields 
are notoriously difficult to enter.  As you saw in the last 
lesson, the dashes or slashes are automatically inserted into 
dates as you key the digits to assist in the data entry and 
formatting process.  However, dates still present a data entry 
dilemma for many users.  Fortunately, People-Trak provides a 
date popup feature at all date fields to allow you to select dates 
graphically with the mouse..  Let’s see how to use it. 

1. Position the cursor to the Birth Date field on the Personal 
screen.  Note that the date popup is displayed adjacent to 
the field.  This same popup is displayed whenever the 
cursor is positioned to a date field on both regular text 
boxes and on grids. 

2. As with all popups, you can activate the popup by 
clicking on the button or by using Function Key 3.  Try 
Function Key 3 this time to activate the popup. 

3. When the date popup is displayed, the settings for the 
month, day, and year are initialized according to the 
contents of the date field from which the popup was 
selected.  If the date field contains a date, the values are 
initialized for that date.  If the date field is blank, the 
values are initialized for the current date.  Check this now.  
Close the date popup and manually change the Birth Date 
to a birth date you know, perhaps your own.  Then, 
activate the popup and note the month, day, and year 
reflect that date. 

4. The date popup is easy to use and is self-explanatory.  
However, there are few tips that might help you.  Let’s 
look at a few. 

5. Often when keying dates, you wish to set the date forward 
one year or one month.  The fastest way to achieve this is 
to trust the fact that the date popup is initialized to the 
current date.  Position the cursor to the Next Review Date 
on the Performance Review Screen.  Enter date one year 
ago today manually.  Now let’s assume that you wish to 
set the date one year forward… quickly.  What would you 
do? 

6. The fastest way to advance the current date one year 
requires three clicks of the mouse.  1.  Click on the date 
popup.  2. Click on the right arrow button adjacent ot the 
Year Dropdown.  3. Click on the OK button to close the 
date popup and to return the value to the Birth Date field.  
Try it.  You do not even need to look at the month or day 
values.  Just click, click, click. 

7. You may think that keying the year is faster, but let’s 
count the actions.  1. Click on the first digit of the year to 
locate the cursor.  2.  Press the Back Space key twice to 
clear the current year.  3.  Enter the new four-digit year.  
4. Press the ENTER key to accept the entry.  That’s seven 
separate actions rather than three clicks. 

8. Of course, the same technique works for advancing a date 
a single month.  Just click the popup, click the right arrow 
adjacent to the Month Dropdown, and click OK to 
continue.  You will learn your own tricks like this.  The 
best way is to simply understand the date popup feature 
and to apply common sense. 

9. Continue with the next tutorial. 

Tutorial D.3 
Data Entry at Multi-Line Field 
There are times when a field must contain more text that can 
fit on a single line.  This applies to comment fields, notes, 
short descriptions etc.  Rather than have the field scroll to the 
right indefinitely and be impossible to read, People-Trak 
provides larger field areas to work with.  These are known as 
multi-line text fields.  Multi-line text fields present a dilemma 
in that you sometimes wish to format the field by using the 
ENTER key to create a new line.  This is certainly acceptable, 
but normal operating conventions use the ENTER key to move 
to the next field.  Thus, each time you might press the ENTER 
key at a multi-line field, the cursor would jump to the next 
field and you would get very frustrated. 

If the ENTER key was trapped and was used to insert a new 
line directly in the field, this scenario would result.  When you 
press the ENTER key five or six times to position to a field 
lower on the screen and you pass through a multi-line text 
field, the ENTER keys would be used to insert rows in the 
multi-line field and you would grow very frustrated deleting 
the line and then remembering not to use ENTER on that 
screen to move the cursor rapidly. 

Fortunately, People-Trak has provided a popup for multi-line 
text fields.  Here’s how it works. 
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1. Position the cursor to the Medical/Wellness screen.  Note 
that there are multi-line text fields on the screen.  These 
are easily identified by the height of the field. 

2. Press the ENTER key a number of times to move the 
cursor all the way around the screen.  Note that the 
ENTER key passes through the multi-line text field just 
like other text fields. 

3. Now position the cursor to the Restrictions field.  Start 
typing a sentence and then press the ENTER key as if you 
wish to create a new line.  Oops, the cursor just jumped to 
the next field.  Now you have to position back to field and 
try again, but the results will be the same. 

4. Instead, click on the multi-line popup button.  Now type 
your sentence and add lines and use the ENTER key as 
you please.  Format the text the way you want.  Now, 
close the popup and return the text to the underlying field. 

5. The text you have keyed should be echoed just as you 
keyed it in the popup.  Now, press the ENTER key a 
bunch of times again.  As with the last time, the ENTER 
keys will not be trapped by the multi-line text box  and 
will not mess up your entry. 

6. Now, position the cursor back to the Restrictions field and 
try to edit the field directly.  It does not work well.  Try 
the popup button again.  Now it will work very nicely. 

7. The multi-line popup dialog will actually adjust it’s height 
to display the entire contents of the text box.  Even if the 
entire contents are not visible in the space provided in the 
underlying field, the popup will show you all of the text if 
it can.    

8. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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2 
Data Entry 
Lesson 1 – Using Help 
Tutorial 1.1 – Use F1 for Field Help 
Tutorial 1.2 – Using the Contents Tab 
Tutorial 1.3 – Using the Index Tab 
Tutorial 1.4 – Using the Find Tab 
 
Lesson 2 – Record Selection and Navigation 
Tutorial 2.1 – Selecting Records by ID and Name 
Tutorial 2.2 – Navigating Records 
Tutorial 2.3 – Edit a Record Group 

Lesson 3 – Add, Delete, Copy, Transfer 
Tutorial 3.1 – Add a Record 
Tutorial 3.2 – Transfer a Record 
Tutorial 3.3 – Delete a Record 
Tutorial 3.4 – Print Labels for a Group 

Lesson 4 – Notes and Attachments 
Tutorial 4.1 – Adding and Deleting Notes 
Tutorial 4.2 – Working with Note Categories 
Tutorial 4.3 – Attaching a File 
Tutorial 4.4 – Activating an Attachment 

Lesson 5 – Tables  
Tutorial 5.1 – Edit a Simple Table 
Tutorial 5.2 – Reverse Populate a Table 
Tutorial 5.3 – Print a Table 
Tutorial 5.4 – Working with a Very Complex Table 

Lesson 6 – Working with Documents  
Tutorial 6.1 –  Retrieve and Print a Document  
Tutorial 6.2 – Create a Document 
Tutorial 6.3 – Delete a Document 
Tutorial 6.4 – Copy a Document 
Tutorial 6.5 – Working with Categories 

Lesson 7 – Using the Document Viewer  
Tutorial 7.1 – Navigating a Document 
Tutorial 7.2 – Viewing, Zooming and Scrolling 
Tutorial 7.3 – Output Options 
Tutorial 7.4 – Using Page Setup 

Lesson 8 – Email  
Tutorial 8.1 – Sending an Email to the Current Record 
Tutorial 8.2 – Sending “Bulk” Email 
Tutorial 8.3 – Emailing Documents 

Lesson 9 – Batch Processing 1  
Tutorial 9.1 – Loading a Batch 
Tutorial 9.2 – Posting a Batch 
Tutorial 9.3 – Postponing and Recalling a Batch 

 
 
Lesson 10 – Batch Processing 2 
Tutorial 10.1 – Using a Combo Style Dialog 
Tutorial 10.2 – Using Lookup to Load Batches 

Lesson 11 – Using a Workflow 
Tutorial 11.1 – Modify an Existing Record 
Tutorial 11.2 – Add a New Record 
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Lesson 1 
Using Help 

This lesson demonstrates how to select records for editing, 
how to navigate the records that are returned from the lookup 
process, and how to edit the group of records to reflect the 
specific group you wish to use. 

Source Text 
People-Trak Basics – Chapter 4 

Tutorials 
Tutorial 1.1 – Use F1 for Field Help 
Tutorial 1.2 – Using the Contents Tab 
Tutorial 1.3 – Using the Index Tab 
Tutorial 1.4 – Using the Find Tab 
 

Use F1 for Field Help: demonstrates how to select records 
using full and partial entries.  Also shows how to manipulate 
the group of records returned from the lookup process. 

Using the Contents Tab: shows how to navigate through the 
current record group using the Record Dropdown and the first, 
last, previous, and last record functions. 

Using the Index Tab: demonstrates techniques for adjusting 
the group of records after the lookup has been performed.  
This is useful when group functions such as transfer and 
letter/label printing are to be performed and the group is not 
easily retrieved. 

Using the Find Tab: demonstrates techniques for adjusting 

Tutorial 1.1 
Use F1 for Field Help 
1. Start People-Trak and select the Personnel module. 

2. Start the lookup process using the Open Employee button 
on the Tool Bar or the Open Employee option on the File 
Menu.  The Lookup dialog is displayed. 

3. Click on the Search button to display a list of employees 
and then select Donald Stern. 

4. Function Key 1 can be used to display the field help for 
the current field.  Position the cursor to the Last Name 
field and press the F1 key. 

5. The Help dialog is opened and the cursor is moved to the 
appropriate portion of help document.  The document 
displayed should be the field help for the Last Name field. 

6. Close the Help dialog and move to the First Name field.  
Try the F1 key again.  This time, the field help for the 
First Name should be displayed. 

7. Close the Help dialog and close the record for Donald 
Stern.  Continue with the next tutorial. 

Tutorial 1.2 
Using the Contents Tab 
The Help menu provides three ways to access the help 
provided with People-Trak.  Each of three ways displays the 
Help dialog, but it starts the dialog at different places within 
the help structure.  Let’s start with the Contents section. 

1. Select the Contents option on the Help menu.  The Help 
dialog is displayed and the cursor is positioned to the 
Contents tab. 

2. The Contents tab presents the help organized into the 
documents, chapters, sections, and topics that comprise 
the documentation suite provided with People-Trak.  If 
you know what you are looking for, the Contents tab is a 
good place to start.  Let’s try a few things now. 

3. Locate the Personnel Management User Guide and opoen 
the document by clicking on the box adjacent to the 
document name. 

4. Now open the chapter titled “Field Definitions by Field”.  
This chapter provides a section for each of the standard 
data entry screens. 

5. Open the section titled “Personal.”  This section lists each 
of the fields on the Personal screen. 

6. Open the field help for the Last Name field.  This is the 
same help that was displayed using the F1 key.  We just 
used the long method to get here.  The point being made 
is that all of the help is available.  You can get to the field 
help with a single F1 key at the field, or you can navigate 
the entire documentation suite by opening the appropriate 
documents, chapters, sections, and topics. 

7. Close the Help dialog and continue with the next tutorial 

Tutorial 1.3 
Using the Index Tab 
1. Select the Index option on the Help menu.  The Help 

dialog is displayed and the cursor is positioned to the 
Index tab. 

2. The Index tab presents the help from the entire document 
suite in alphabetic order by topic.  The topics include field 
help for fields, table descriptions, operating conventions, 
and everything else. 

3. To continue with our theme, scroll the indexed list down 
until you find “Last Name”.  You will note that there are 
multiple entries for last name. 

4. Click and display each Last Name entry.  Note that one 
entry is the field help for the Personal screen in the 
Personnel Module that we have seen before.  Another is 
for the field help for a batch processing program.  And, 
another is the field help for the Personal screen in the 
Applicant Tracking module.   

5. Close the Help dialog and continue with the next tutorial. 
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Tutorial 1.4 
Using the Find Tab 
1. Select the Search option on the Help menu.  The Help 

dialog is displayed and the cursor is positioned to the 
Search tab. 

2. The Search tab does not display anything until you have 
specified a phrase.  Once you do specify a phrase, the tab 
will list those topics that contain the phrase you have 
entered. 

3. Position the cursor to the “phrase to find” space at the top 
of the tab.  Enter the phrase “last name” and then press 
the Search button. 

4. All topics that contain the phrase “last name” are 
displayed.  Again, you can navigate through this list to 
find the actual topic you wish to read about. 

5. Close the Help dialog. 

6. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 2 
Record Selection and 
Navigation 

This lesson demonstrates how to select records for editing, 
how to navigate the records that are returned from the lookup 
process, and how to edit the group of records to reflect the 
specific group you wish to use. 

Source Text 
People-Trak Basics – Chapter 5 

Tutorials 
Selecting Records by ID and Name: demonstrates how to 
select records using full and partial entries.  Also shows how 
to manipulate the group of records returned from the lookup 
process. 

Navigating Records: shows how to navigate through the 
current record group using the Record Dropdown and the first, 
last, previous, and last record functions. 

Edit a Record Group: demonstrates techniques for adjusting 
the group of records after the lookup has been performed.  
This is useful when group functions such as transfer and 
letter/label printing are to be performed and the group is not 
easily retrieved. 

Tutorial 2.1 
Selecting Records by ID and 
Name 
We have used the Lookup feature in prior lessons to select 
Donald Stern to demonstrate other features in People-Trak.  
However, we performed the Lookup in the simplest manner 
and did not take advantage of a wide range of features.  Let’s 
start using this feature more effectively now. 

1. Start People-Trak and select the Personnel module. 

2. Start the lookup process using the Open Employee button 
on the Tool Bar or the Open Employee option on the File 
Menu.  The Lookup dialog is displayed as before, but now 
we are ready to make it work for us. 

3. The Lookup dialog provides four individual tabs for 
selecting records.  The focus of this lesson will be the first 
tab: “ID and Name”.  You will learn more about the other 
tabs later. 

4. The “ID and Name” tab first provides up to four separate 
fields that can be used to look up records.  The actual 
fields can be defined by your organization.  It is normally 
assumed that one of these fields is the ID (employee, 
application, position, etc.) and one is the Name (employee 
or applicant last name, description, title, etc.).  When the 
Lookup dialog is displayed, the cursor is always 
positioned to the first field which we will assume is the 

Employee ID field in the Personnel module.  We will now 
attempt to select one of the existing demonstration 
employees for processing. The employee ID for one of the 
employees is "1060". Enter that ID now and press the 
ENTER key. The message shown below is displayed. 
Why? 
 
Matching Record Not Found or In Use by Another 
User 

5. The reason for this error is that you entered an incorrect 
employee ID, but it is not your fault. You were given an 
incorrect employee ID to demonstrate an important point. 
When selecting an existing employee, the employee ID 
entered must match an existing employee ID. If it does 
not, the program cannot retrieve the desired employee and 
the message shown above is displayed. When you see this 
message in the future, do not fear that the desired 
employee has disappeared. In most cases, the message 
appears because the ID has not been entered correctly. 

6. Press the ENTER key to clear the message.  Now try the 
employee ID "1006".  The Personal Screen for Donald 
Stern is displayed.  You did not see a list of employees as 
you have in the past because you entered a direct match.  
There is only one record with the ID “1006”.  You gave 
People-Trak enough information to save you further 
effort. 

7. You can provide sufficient information for a direct match 
at any of the fields shown on the “ID and Name”.  If you 
provide a unique last name, that record will be fetched.  If 
you provide a name that is not unique, you will see a list 
of employees that share that name and you can select the 
particular record that you want. 

8. Now let's learn how to use the "partial entry" method. 
First, we need to clear the record we have selected. You 
can do this using the Close button on the Tool Bar or the 
Close option on the File Menu.  Optionally, and to save a 
little work, you can directly select the Open Employee 
button.  The Close operation is assumed and you will 
proceed directly to the Lookup dialog.  If you had 
changes in process, they were saved.  You can try it 
yourself if you do not trust me. 

9. To continue, at the Employee ID field, enter the single 
digit "1" and press the ENTER key. A list of those 
employees with ID numbers starting with "1" is displayed. 
You can select the desired employee in three ways. You 
can double-click on the desired employee, you can 
position the highlight over the desired employee and press 
the ENTER key, or you can position the highlight over 
the desired employee and select the OK button. Finally, if 
you wish abandon the selection process, you can select 
the Cancel button. 

10. Let's select Donald Stern using the double-click method. 
The information for Donald Stern is displayed just as it 
was before. Now let's learn how to show a list of all 
employees in the database. 
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11. Clear the information for Donald Stern and move directly 
to the Lookup dialog using the Open Employee button. 
This time, perform a partial lookup using “S” in the Last 
Name field.  You will see a list of those employees who 
have a last name starting with “S”.  Do not select an 
employee this time.  Instead, use the Clear button to clear 
the entries so that we can try something else. 

12. Use the Search button to select all employees.  When the 
list is displayed, note that the headings for the list are the 
same fields listed for selection.  As mentioned before, up 
to four fields can be used to both allow flexible lookup 
and to allow you to identify the appropriate records.  If 
you happen to have dozens of employees named Smith 
and you cannot remember hundreds of individual 
employee ID numbers, the fields in the list assist you to 
determine just what Smith you wish to select. 

13. The list of records can also be sorted.  To sort the list, 
click on the column header for the appropriate field.  Try 
it.  Sort the list by Last Name and then by each of the 
other fields.  This feature can assist you in selection and 
in record navigation which we will discuss next 

14. Continue with the next tutorial. 

Tutorial 2.2 
Navigating Records 
When you select a record from a list, the record selected 
becomes the current record displayed, but in fact, the entire 
list of records is returned as a group that you can work with.  
That is why features are provided to allow you to manipulate 
the list before selecting the specific record.  The group of 
records that meet your selection criteria is added to the 
Records Dropdown on the Navigation Bar.  This tutorial will 
show you how to navigate the list. 

1. Use the Lookup dialog to create a list of all employees 
from the DEMO company.  Before selecting a record, sort 
the list in ascending (A to Z) order by last name.  Then 
select Donald Stern. 

2. Now lets evaluate what we have.  The name displayed in 
the Record Dropdown should be Donald Stern, but there 
are other records in the dropdown.  This is clearly 
indicated by the record counter that shows that Donald is 
the 23rd record in a list of 30.  Let’s check this.  Click on 
the dropdown and scroll through the list of names.  Select 
Michael Durkin and see what happens.  The current 
record changes to Michael Durkin and the record counter 
changes to reflect the Michael’s position in the list. 

3. Use this technique to return to Donald Stern.  The Record 
Dropdown can be used to select any record that has been 
returned from the lookup process.  The records are 
ordered in the dropdown according the manner in which 
they were sorted in the Lookup.  You will recall that we 
sorted by ascending by last name.  If we had sorted by ID, 
the dropdown list would be ordered by ID and Donald 
would not be 23 of 30.  He would be 2 of 30 because his 
ID is the second lowest. 

4. While the Record Dropdown is used to select a specific 
record by name, the four buttons adjacent to the Record 
Dropdown are used to move through the list 
incrementally.  The leftmost button is the “First Record” 
button.  It will select the first record in the list as the 
current record.  Try it now.  If your dropdown is still 
sorted by last name, the current record will become 
“Frank Adams” and the record counter will indicate “1 of 
30”.  The rightmost button is the “Last Record” button.  It 
will select the last record in the list as the current record.  
Try it now.  The current record should become “Cary 
Wilson” and the counter will indicate “30 of 30”. 

5. The inner buttons are used to select the previous and next 
records in the list.  Try these and see how they work.  If 
you locate to the last record and then select the next 
record, you will be cycled around to the first record.  If 
you locate to the first record and then select the prior 
record, you will be cycled around to the last record. 

6. Record navigation is frequently used in a process known 
as “browsing”.  From time to time, you may find the need 
to browse through a group of records checking a specific 
field or making relative comparisons.  Browsing is an 
easy way to do that.  Select the first record in the current 
list with the First Record button.  Now change the screen 
to the Compensation screen.  Let’s assume that you wish 
to “browse” salary history for this group.  Review the first 
record and then click on the next record.  Review the 
second record and then the third.  Continue browsing until 
you have seen what you wanted to see or you have 
returned to record 1.  You can use this technique for any 
primary data entry screen or for any other related purpose. 

7. Continue with the next tutorial.  

Tutorial 2.3 
Edit a Record Group 
The group of records returned from the lookup process can be 
acted upon as a group.  You can transfer records and print 
labels and letters for members of the group.  Sometimes, 
however, the group contains one or more records that you do 
not want and the exact group is not easily retrieved.  You can 
adjust the group to include the members you want using the 
Edit Lookup features.  Here’s how. 

1. Use the Lookup dialog to select a list of all employees.  
Order the list by ID in ascending (0 to 9) order and click 
the OK button.  Now let’s assume that we wish to print 
labels for this list, but that three of the employees are 
terminated and you do not need labels for them. 

2. Select the Edit Lookup option from the File Menu.  The 
Edit Lookup dialog provides a list of the current members 
in the order in which they are listed in the Record 
Dropdown.  Let’s exclude the three members who are not 
to receive labels. 

3. Locate Donald Stern and check the box adjacent to his 
name.  Do the same for Michael Durkin, and Penny 
Armstrong.  Press the Exclude button.  What happens?  
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The list is reduced from 30 members to 27 members and 
Donald, Michael, and Penny have been deleted.  

4. Close the Edit Lookup dialog and watch what happens.  
The record counter is reduced from 30 to 27 and the 
actual members in Record Dropdown are changed to 
reflect the exclusions.  Your new group is now 27 
members strong and works exactly as if you had selected 
the 27 in initial lookup.  If you realize that you needed to 
exclude further members, simply use the Edit Lookup 
dialog to exclude them.   

5. Once you have adjusted your list of employees to the 
precise list you desire, you can perform the group related 
function you wish to perform.  Only the current members 
of the group will be affected. 

6. Let’s try one more thing.  Select the Edit Lookup option 
from the File Menu again.  This time, select any five 
employees, but be sure to exclude the employee currently 
listed in the Record Dropdown.  Instead of selecting the 
Exclude button, select the Include button.  The list is 
adjusted to include only those five employees.   

7. Close the Edit Lookup dialog and see what happens this 
time.  Of course, the list is adjusted and the record count 
is modified, but what happens to the current record that is 
no longer in the list?  You can check this yourself, but 
what happens is that the next available member of the list 
is selected for you.  If you were on the last member of the 
list, the first member will be selected. 

8. Close your record group and exit People-Trak.  This 
tutorial and this lesson are complete. 
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Lesson 3 
Add, Delete, Copy, Transfer 

This lesson describes how to add, delete, copy, and transfer 
records.  A detailed description of the auto-numbering feature 
is also provided. 

Source Text 
People-Trak Basics – Chapter 5 

Tutorials 
Add a Record: shows how to add a new record and to supply 
a unique ID. 

Transfer a Record: demonstrates two different techniques for 
transferring a record from one company to another. 

Delete a Record: shows two methods used to delete records.  

Print Labels for a Group: shows how to select and edit a 
record group and to print labels for all members of the group. 

Tutorial 3.1 
Add a Record 
In the last lesson, we learned how to select an existing 
employee for processing. When an employee is added, there is 
no existing employee to select. It is necessary to add all 
employee information from scratch. The first step in adding an 
employee is getting a blank record and establishing an 
employee number. 

1. Start People-Trak and select the Personnel Management 
option. There are two ways to start a new.  You can use 
the New Employee button on the Tool Bar or the New 
Employee option on the File Menu.  Use the button this 
time. 

2. If you own the Applicant Tracking module, you may see a 
dialog that is used to select applicants as new employees.  
This is a feature within People-Trak for customers who 
primarily hire employees who have been tracked as 
applicants.  If a screen is displayed at this time, use the 
Cancel button to cancel the screen and continue with step 
3. 

3. When the Personal screen is displayed, the cursor is 
positioned to the Employee ID field. Enter the employee 
number "1006". The message shown below is displayed. 
 
Employee Number already Used 

4. The reason for this error is that we directed you to enter 
an existing employee number. As you can see from this 
example, when specifying a new employee number, the 
number entered must not match an existing number. A 
new ID must be unique.  That is one reason why some 
companies use the auto-numbering feature. 

5. Press the ENTER key to clear the message. Now enter an 
available employee number such as 1116. This value will 
be accepted.  Enter a few other fields and note that the 
fields are shown in the modified color.  If you return to 
one of the fields, you will see that the field can be undone 
(except the ID field for technical reasons) just as if it an 
existing record were being modified.  This is because an 
existing, albeit blank record, is being modified.  You are 
changing blank data to new data.  If you undo new data, 
the field will return to its original blank status. 

6. Use the Close Record button on the Tool Bar to close the 
record.  It is now saved and has become part of your 
DEMO company.  Do not worry, we will delete the record 
in a subsequent tutorial. 

7. Now, start a new record using the New Employee option 
on the Tool Bar.  This time do not add an ID, but start 
filling out other fields.  After a few fields, try to close the 
record.  The message show below is displayed. 

This record cannot be saved… 

8. The message is letting you know that you cannot save a 
record without providing a unique ID.  If you provide an 
ID as in the prior steps and close the record, you will get 
another unwanted record.  What do you do?  As stated 
before, this record is really a blank record that already 
exists.  You can thus delete the record to get rid of it 
without having to close it first.  Use the Delete Employee 
option on the File Menu.  The message shown below is 
displayed. 

Delete this Record? 

9. This message is provided to make certain that the record 
currently displayed is absolutely, positively the record 
you wish to delete because the record will be deleted 
permanently.  Click on the OK button to discard the 
record. 

10. Continue with the next tutorial. 

Tutorial 3.2 
Transfer a Record 
People-Trak is a multi-company product.  This means that you 
can track employee and applicant records in multiple separate 
companies.  For most organizations, there will be an active 
company that contains active records and an archive company 
that contains obsolete or non-active records.  This tutorial will 
show you how to transfer records between companies. 

1. There are two ways to transfer an employee.  You can 
select the employee and then transfer or you can select 
transfer and then pick the employee.  We’ll try both. 

2. Select the record that you created in the last tutorial.  The 
ID was 1116.   

3. Select the Transfer option on the File Menu.  A dialog 
box containing three option buttons is displayed.  The first 
button is used to transfer the current employee, the second 
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button is used to transfer all of the records in the group, 
and the third button is used to cancel the transfer process.  
Select the “current employee” option. 

4. A list of the companies to which you have access is 
displayed.  (The current database is not included).  Select 
the ARCHIVE company.  The record is immediately 
transferred and after a few seconds, the process is 
completed.  The transfer process is a move and not a 
copy.  Thus, the record in the DEMO company has been 
deleted and now exist only in the ARCHIVE company.  
Let’s prove it. 

5. Try to lookup record 1116.  You will not be able to do so.  
Now change the current company from DEMO to 
ARCHIVE using one of the methods you have learned 
earlier.  Now try to lookup record 1116.  The record you 
transferred will be found.   Close the record. 

6. As mentioned earlier, there are two ways to transfer a 
record.  We tried one to send the record from DEMO to 
ARCHIVE.  Let’s learn another as we transfer the record 
back to DEMO from ARCHIVE. 

7. Select the Transfer option from the File Menu.  The 
Lookup dialog is automatically displayed because no 
record has been selected.  Use the Lookup dialog to select 
record 1116.  The list of companies is displayed.  Note 
that DEMO is shown and that ARCHIVE is not because 
you cannot transfer a record within the same company.  
Select the DEMO company and transfer the record back.  
The record is now in DEMO again and deleted from 
ARCHIVE.  Return to the DEMO company. 

8. When a record transfers, everything in the record 
transfers.  If there are dozens of performance review, 
compensation history, benefits enrollments, it all 
transfers.  

9. Return to the DEMO company and continue with the next 
tutorial. 

Tutorial 3.3 
Delete a Record 
In actuality, it is rare to delete any type of record.  To 
completely discard information that has been painstakingly 
entered is odd.  Normally, information is transferred to some 
type of archive and left there for a long time, just in case it is 
needed.  However, if a record really does need to be deleted, 
this is how you can do it.  

1. Select the employee we added earlier.  The ID is 1116. 

2. Select the Delete Employee option from the File Menu.  
The message shown below is displayed.  

Delete this Record? 

3. Go ahead and delete the record. If you ever reach this 
message and do not wish to delete the employee 
displayed, select the CANCEL button to abandon the 
deletion process. 

4. For your protection, there is no obvious way to delete 
records in groups.  The feature would be too dangerous.  
If you ever need to delete a large number of records, you 
should consult with your support representative. 

5. Continue with the next tutorial.  

Tutorial 3.4 
Print Labels for a Group 
People-Trak provides a number of labels and letters. In 
addition, you can create additional labels and letters using the 
Template Manager. Each of the employee labels/letters can be 
printed with the Document Explorer option, but they can also 
be printed for any single employee or for a group of 
employees during an editing session.  Here's how. 

1. You learned how to select and edit a group of records in 
the previous lesson.  Use your skills to select a group 
now.  If you wish, use the Edit Lookup option to 
customize the group to contain exactly those members for 
whom you wish to print a label. 

2. When your list is ready, select the Labels option from the 
File Menu.  A list of the available label templates is 
displayed.  Pick a label such as the Avery 5160. 

3. A dialog box containing three option buttons is displayed.  
The first button is used to select the current employee, the 
second button is used to select the current group, and the 
third button is used to cancel the whole process.  Select 
the “current group” option. 

4. The list of employees is processed and after a brief delay, 
the Document Viewer will be displayed with your labels.  
There should be one label for each employee in the list.  
Use the Exit option on the File Menu to close the 
Document Viewer.  Then close the current record. 

5. The ability to perform group functions is limited to 
transferring records, printing labels and letters, and 
sending email.  The process is the same.  Once you have a 
group identified, you can select the appropriate option 
from the File Menu.  From there, you will be prompted to 
perform the function for the current record or for the 
entire group.  As mentioned earlier, we did not provide 
the ability delete records in a group for obvious reasons. 

6. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 4 
Notes and Attachments 

This lesson provides detailed instructions for using the notes 
and attachment features provided with People-Trak. 

Source Text 
People-Trak Basics – Chapter 6 

Tutorials 
Adding and Deleting Notes: shows how to add and delete 
notes.  This includes the special techniques for opening the 
note text area and the automatic assignment of the note 
category and User ID. 

Working with Categories: demonstrates how the note 
categories are used to organize notes based on the primary 
data entry screens. 

Attaching a File: shows how to create and attach a file to a 
note. 

Activating an Attachment: demonstrates how to activate an 
attachment file using the tool that was used to create the 
attachments.  

Tutorial 4.1 
Adding and Deleting Notes 
The Notes dialog is essentially a grid with some additional 
enhancements to support attachments and a large multi-line 
text box.  In this lesson, we’ll see how these enhancements 
work. 

1. Start People-Trak, select the Personnel Module, and select 
Donald Stern.  Verify that the Personal screen is 
displayed. 

2. The Notes dialog is available from virtually all of the 
primary data entry screens in People-Trak as a sub-screen.  
There is a Notes sub-screen button as the last or next to 
last button in the stack.  Confirm this now by selecting a 
few screens and finding the Notes button. 

3. Return to the Personal screen and select the Notes sub-
screen.  The Notes dialog is displayed.  As indicated, the 
primary component on the dialog is a grid, but this grid 
has some special features. 

4. The record for Donald Stern already has four notes 
defined for the Personal category.  Let’s add another.  
You can add a note on the first row or on any other row.  
Let’s add a note at the first blank row.  The first three 
columns in the grid are display-only.  Position the cursor 
to the Note Date column and enter today’s date manually, 
using the Date popup, or the Date Stamp feature. 

5. When you leave the field, the category and demo columns 
are automatically populated with the current category 
“Personal” and the current user ID “DEMO”.  These 

values are constant and cannot be changed.  The note was 
created on the date specified, by the current user, in the 
current category.  If these facts change, the note is 
invalidated and should be deleted. 

6. Position the cursor to the first row and use the Insert Row 
feature to insert a row.  Note that the category and user ID 
fields are completed just as before.  Enter a date for the 
note and now let’s enter the note text.  There are two 
methods.  If you wish to enter a relatively short note 
without using the ENTER key, you can enter the note 
directly into the field provided.  When you press the 
ENTER key, the note will be completed and the cursor 
will move to the next field.  Try that.  Enter the phrase 
“this is my note” and press the ENTER key.  The note is 
complete. 

7. If you wish to add a longer note with more than one line, 
you need to use the multi-line popup.  This is activated 
using the popup button adjacent to the Note Text column. 

8. Position the cursor to the Note Text column for the note 
on the last row.  Click on the button to open the multi-line 
editor.  The field size will be immediately increased to 
match the height of the grid.  You can now type away for 
as long as you like.  If you reach the end of the line, word-
wrap will be performed and the cursor will jump to the 
next line.  If you press the ENTER key, the current line 
will be broken and the cursor will jump to a new line.  Try 
these now.  Type a sentence or paragraph that wraps.  
Then on the second line, press the ENTER key to start 
another new line.  Add a few more lines with the ENTER 
key and make a nice long note. 

9. When you are finished with your note click on the button 
again to close the editor.  Only the first line of your note 
is displayed in the grid.  If you wish to review the text of 
your note or to add more text, click on the popup button 
to expand the note text area and view or edit the text. 

10. The notes dialog has been designed to allow you to 
rapidly view the first line of each note relative to the other 
notes.  If you wish to review the note in more detail (if the 
note has more detail), you need only click on the popup 
button.  In fact, you can actually browse your notes with 
the mouse.  Try this.  Position to the first row.  Expand 
the note text, read the note text, reduce the note text.  
Click on the next line.  Expand the note text, read the note 
text, reduce the note text.  Click on the next line.  Expand 
the note text, read the note text, reduce the note text.  You 
can use this technique to rapidly browse all notes for any 
record. 

11. Now that we know how to add notes, let’s see how to 
delete notes.  There is nothing special, just use the Delete 
Row button on the Tool Bar.  Use it now to delete the two 
notes that we just entered. 

12. Continue with the next tutorial. 
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Tutorial 4.2 
Working with Note Categories 
1. When we entered the notes in the last tutorial, the 

category was automatically set to “Personal”.  Because 
each primary data entry screen has a notes sub-screen, the 
category for the note is set to the name of the primary data 
entry screen. 

2. Select the Notes sub-screen from the Status screen.  
Unlike the Personal screen there are no “status” notes for 
Donald Stern.  Enter a note using the techniques you just 
learned.  Note that the category assigned is “Status”.  

3. Close the Notes dialog on the Status screen and open the 
Notes dialog on the Personal screen.  Use the Category 
Dropdown to change the current category to “Status”.  
The personal notes are cleared and the status note you just 
entered is displayed.  Try a few other categories.  Some 
may contain notes and others may not. 

4. If you wish to see all of the notes, use the “All” category 
listed at the top of the Category Dropdown.  Try it.  All of 
the notes for Donald Stern are displayed.  This ability to 
change categories and display notes from other categories 
is available on the Notes dialog regardless of where the 
dialog was selected. 

5. The grid used for notes shares the standard operating 
conventions with other grids in People-Trak.  This means 
that you can sort the grid using the any of the column 
headers.  Verify that you have displayed all of the notes.  
Then use the grid sort feature to sort the notes by different 
columns. 

6. The ability to display all notes and to sort them by 
category is especially useful when printing notes.  Use the 
Print button on the Tool Bar to print the notes now.  The 
notes will be printed in the order in which they are 
currently displayed.  In addition, the note text is expanded 
vertically so that the report shows the entire text of each 
note. 

7. When you have the Notes dialog displayed from a 
specific data entry screen and you add a note, the note 
category becomes the note for that screen, not necessarily 
for the screen listed in the Category Dropdown.  

8. Change the note category to Status.  This is not the 
current screen.   Add a note.  The category created for the 
note will be the “status” category because this is the value 
in the dropdown at the time the note was created. 

9. Continue with the next tutorial. 

Tutorial 4.3 
Attaching a File 
One of the more powerful features of the Notes dialog is the 
ability to attach external files to your notes.  These external 
files become an integral part of the record.  Attachments can 
be added to any existing note.  You cannot add an attachment 
to nothing.  Thus, you may need to add a note when you wish 
to add an attachment. 

1. At the end of the last tutorial, we added a note to the 
Personal screen.  We’ll add an attachment to that note.  
Verify that you are positioned to that note. 

2. Minimize People-Trak and use your word processor to 
create a small file containing any desired text.  Save the 
file in a folder where you can find it quickly.  Maximize 
People-Trak and continue. 

3. Select the Attach File option from the Attachments menu.  
This option displays the File popup that is used to select a 
file.  Locate the file you created with your word processor 
and select that file. 

4. Internal processing for the attachment is performed.  A 
copy of the file is first made.  This copy is compressed 
using ZIP technology and finally moved into the 
attachment file for the current record.  The attachment 
icon is then added to the first column for this note. 

5. Normally, you would now add note text that would 
identify the file that has been attached so that you do not 
always need to activate the attachment to know what it 
contains.   

6. Continue with the next tutorial. 

Tutorial 4.4 
Activating an Attachment 
Once a file has been attached, the file can be activated or 
opened for viewing at any time.  As long as the note row is 
displayed, you can activate the attachment associated with that 
note. 

1. Verify that the cursor is positioned to the note row 
containing the file you attached in the last tutorial. 

2. Click on the attachment icon in the first column.  The 
word processor used to create the attachment is started 
and the file is loaded into the word processor.  The file 
that has been loaded into the word processor is a copy of 
the attachment and not the attachment directly.  If you 
modify the loaded file and save it, it will not be written 
back as an attachment automatically.  There are very 
specific Windows related reasons for this. 

3. If you would like to modify a loaded file and have it 
replace the prior attachment, you must save the file.  Then 
you must delete the current attachment and attach the new 
file. 
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4. To continue, close the word processor without saving.  
Position to one of the other rows that has an attachment 
icon.  These other rows for Donald Stern have image 
attachments.  Click on the icon.  Some type of image 
editor or viewer will be loaded and you will see the 
attachments.  Try a couple of these images. 

5. You can attach all types of files except for those that are 
or would execute programs.  Please note, however, that if 
you attach a file from a tool that you use, another user can 
only activate that attachment if the user also has that tool.  
For example, if you attach a word processing file (as we 
just did) from your word processor and another user has a 
different word processor, the other user will not be able to 
view the attachment.  The attachments feature is a very 
powerful feature, but it must be used with appropriate 
discretion.  If your organization has standardized on word 
processors, spreadsheets, and other tools, there will be no 
problem. 

6. This tutorial and this lesson are complete. Exit the Notes 
dialog and then exit People-Trak. 
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Notes 
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Lesson 5 
Tables 

 

Source Text 
People-Trak Basics – Chapter 7  

 

Tutorials 
Eidt a Simple Table: shows how to edit a simple table using 
standard grid conventions. 

Reverse Populate a Table: demonstrates a powerful method 
of populating a table with the existing unique values in the 
records. 

Print a Table: shows how to print a table two different ways: 
while editing the table and using the Print Tables option. 

Working with a Very Complex Table: shows the techniques 
required to add and delete records in a very complex table. 

Tutorial 5.1 
Edit a Simple Table 
People-Trak provides a wide range of tables for tracking 
commonly used information. As you have seen in prior 
lessons, the tables are used to provide this information to 
records in a standard and consistent manner. All of the 
operating conventions used for tables you have seen before. 
This tutorial will be a quick refresher. 

1. Start People-Trak, select the Personnel Module, select the 
Tables menu, and select the Table Edit option. 

2. A list of the tables is presented in alphabetic order. Select 
the City table. 

3. The City table is a typical single field table. The City 
table uses standard grid conventions.  For example, you 
can insert rows, delete rows and sort rows.  Try each of 
these options now.  Note that the sort function within 
tables assumes ascending order. 

4. Position to the first blank record and make an entry. All of 
the field edit conventions are identical to those you have 
seen before.  Try a few such as cut, copy, and paste. 

5. Exit the table using the Exit option on the File Menu.  The 
list of tables is displayed.  Select the Department Table. 

6. This Department Table functions identically to the City 
table except that there are multiple fields in each row.  
Exit this table.  

7. If you need to, study other tables. After a few tables, it 
should become apparent that a table is a table is a table. 

8. Continue with the next tutorial. 

Tutorial 5.2 
Reverse Populate a Table 
Normally, you create tables by entering the values directly 
into the table.  In other instances, the table may have been 
imported from another source.  There is a third way to 
populate a table.  This is normally useful when a table is 
activated after data entry has been performed, or when records 
have been imported and you wish to build your table from the 
data already present in the records.  Here is how you do it. 

1. Select the City table.   

2. Use the Delete Row button on the Tool Bar to delete all of 
the existing rows.   

3. Select the Populate option on the File Menu.  The 
message shown below is displayed. 

Populate table with unique entries from all related 
fields for this company? 

4. Select “Yes” to populate the table.  The table is then 
populated with every unique city name from any city field 
used in the company.  This means that if different cities 
were used for applicants and dependents and employees 
within the records, this table will include each of the 
unique entries.  There will be no duplicates. 

5. When we set this table up, we cleared the table prior to 
populating.  This is not necessary, but was used for 
demonstration purposes.  If there are unique entries in the 
table when the populate option is selected, the unique 
entries will remain.  Let’s try. 

6. Clear the table again.  Then add three unique city names 
such as “XXX”, “YYY”, and “ZZZ”.  Save the table and 
then reselect the City table.  Now run the populate 
function.  Note that the new values from the existing 
records are added to the unique records in the table and 
that all of the records are sorted in ascending order.  Our 
“XYZ” cities will be at the bottom. 

7. The populate feature should be used carefully as it can 
lead to bad data entry habits.  Do not run this feature 
regularly on the same table so that the table will match the 
fields in the records.  That is exactly the opposite of what 
you want.  Your tables are used to ensure proper 
validation of the data that is entered into the records. 

8. This feature is only available on the simple tables.  You 
cannot populate complex or very complex tables in this 
manner. 

9. Continue with the next tutorial. 
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Tutorial 5.3 
Print a Table 
1. There are two ways to print tables.  You can print the 

table while you are editing it or you can print the table 
using the Print Table option on the Tables Menu.  We’ll 
do both.   

2. We ended the last tutorial in the City table.  Print the City 
table using the Print button on the Tool Bar.  Note that the 
table reflects the current entries in the table. 

3. Now let’s print the table the other way.  Close the City 
table and close the list of tables.   

4. Select the Print Tables option from the Tables Menu.  The 
list of tables is shown.   

5. Select the City table.  The table is printed directly from 
the menu and should appear exactly as the table printed 
from within the editing dialog.  Close the Document 
Viewer and the Print Tables dialog 

6. Continue with the next tutorial. 

Tutorial 5.4 
Working with a Very Complex 
Table 
Some tables have a lot of fields and cannot be maintained with 
a single grid.  In some cases, a table is actually composed of 
multiple parts: a main record and a series of detail records.  
These very complex tables are unique, but share a common set 
of operating conventions.   

1. Select the Edit Tables option from the Tables Menu and 
select the Location table.  The Location table is one of the 
“simpler” complex tables and is a good table to 
demonstrate. 

2. All of the very complex tables provide a list box that 
contains the existing table codes and either one or more 
tabs to maintain the information. The Location table has 
just one tab.   

3. The list box is used to select one of the codes for editing.  
When the dialog is first displayed, the first code is 
automatically selected for you.  Select a different code 
and note that the fields are refreshed for that code.  
Change one of the values for the code you have selected 
and then select another code.  The change you made is 
saved when you moved to the other code just like changes 
are saved on the primary data entry screens when you 
move between the screens. 

4. When there are multiple tabs of information, the list box 
is displayed on each tab so that you can see which code is 
being edited.  You can move between the tabs changing 
any of the information associated with the code.  The 
changes are saved when you change to another code or 
exit the table. 

5. With complex tables you cannot insert a row when you 
wish to create a new entry because there is no grid.  
Instead, there is a New Record button on the Tool Bar and 
a New Record option on the File Menu.  When the New 
Record feature is used, a blank record is added to the table 
and is given a temporary code such as NEW1, NEW2, 
etc.   

6. Add a new location code now by using the New Record 
button.  The location code NEW1 is added to the list box 
and is placed into the Location Code field.  Normally, you 
would continue adding the information for this location 
by changing the code to a valid name and by completing 
the remaining fields as necessary.  At this point, the new 
record has been added; you are actually editing a blank 
record. 

7. That’s how new records are added.  Now let’s learn how 
to delete one.  To delete a record, select the record to 
delete using the list box.  Then use the Delete Record 
button on the Tool Bar or the Delete Record option on the 
File Menu to delete the new record that we created.  Note 
that the next record in the list box is automatically 
selected.   

8. Some of the other complex tables are more complex in 
that they have more tabs and even sub-screens and 
buttons.  However, the operating conventions match those 
used elsewhere.  You need only apply the knowledge you 
have already acquired. 
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Lesson 6 
Working with Documents  

This lesson shows how to use the Document Explorer.  The 
Document Explorer organizes all of your documents into 
categories in the same way that the Windows Explorer 
organizes file into folders. 

Source Text 
People-Trak Basics – Chapter 8 

Tutorials 
Retrieve and Print a Document: shows two methods for 
retrieving and printing documents. 

Create a Document: demonstrates how to start the creation of 
a document using the Document Explorer.  The document is 
completed using the appropriate document editor. 

Delete a Document: shows how to delete any obsolete 
document. 

Copy a Document:  shows how to make a copy of a 
document. 

Working with Categories: shows how to change categories 
for a single document and for all documents. It also shows 
how to merge the documents from one category into another. 

Tutorial 6.1 
Retrieve and Print a Document 
People-Trak provides a large number of pre-defined reports 
that you can use.  In this tutorial, you will learn how to select 
and print a document. 

1. Start People-Trak, select the Personnel Module, and select 
the Document Explorer option on the Documents Menu.  
The Document Explorer dialog is displayed. 

2. The Document Explorer organizes all of your documents 
in much the same way that the Windows Explorer 
organizes files and folders.  Initially, all of the existing 
documents are organized by category.  Document 
categories are assigned when a document is created and 
can be changed if necessary.  We’ll use the categories to 
help us find a report. 

3. Select the Compensation category to display a list of the 
compensation documents.  Locate and highlight the 
Salary History document in that list.  At this point, you 
can open the document to run it or you can run it directly 
from the explorer.  As usual, we will try both. 

4. Use the Open Document button on the Tool Bar or the 
Open Document option on the File Menu to open the 
Salary History document.  The document will be opened 
and the Adhoc Report dialog is displayed.  This dialog is 
used to create, edit, and run documents.  We do not need 
to change the document, so run the document using the 

Run button on the Tool Bar.  The document will be 
displayed in the Document Viewer. 

5. Close the Document Viewer and close the Adhoc Report 
dialog.  Select the Compensation category again and 
highlight the Salary History document.  This time, run the 
document directly from the Document Explorer using the 
Run button on the Tool Bar.  The document will be sent 
to the Document Explorer as before.  Close the Document 
Viewer. 

6. Select the General category and run the Employee List by 
Department report.  As you can see, to run existing 
reports, you need only point and click. 

7. The Document Explorer can also present the reports by 
type rather than category.  Above the list of categories is a 
dropdown with the phrase “Select by Category” 
displayed.  Use the dropdown to change the phrase to 
“Select by Type”.  All of your documents are now 
organized by category within type rather than type within 
category. 

8. Select the Letter type and you will see a list of the letter 
documents that have been created.  Select the Physical 
Letter and run it.  A physical letter for each record in the 
company will be generated and sent to the Document 
Viewer.   

9. Close the Document Viewer and select the Standard 
Reports type.  Select the Workforce Distribution by 
Ethnicity Report and run it.  This report is a colorful 
graph that illustrates the number of employees within 
each ethnic category.  Close the Document Viewer. 

10. There are many, many documents that you can run.  Some 
may be helpful and some may not.  Using the navigation 
features you have learned, you can at least find these 
documents and test print them to see if they will be useful. 

11. Continue with the next tutorial. 

Tutorial 6.2 
Create a Document 
The Document Explorer is the starting point for creating new 
documents.  Fully creating new documents is the subject of 
multiple future lessons.  In this tutorial, we will show you how 
to get started. 

1. Start a new document using the New Document button on 
the Tool Bar or the New Document option on the File 
Menu.  The Select Document Type dialog is displayed.  
There is a unique editing dialog for each document type.  
This “select” dialog is used to determine which of the 
editing dialogs to use. 

2. Select the Letter document type. The Letter dialog is 
displayed.   

3. The Letter dialog is used to specify the document title, 
category, letter template, sort order, and query equations 
for the letter.  Completing all of these fields is outside the 
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scope of this lesson.  We will complete just enough fields 
to continue.   

4. Set the title of the letter to “My Letter”.  Set the category 
to “My Category”.  Use the popup to select the Physical 
Letter as the Letter Name.    

5. Run the letter to show that you have created a valid letter 
document.  Close the Letter dialog and save the letter. 

6. When the Document Explorer is displayed, there should 
be a new category “My Category”.  Select that category.  
There should be one document in that category, a letter 
named “My Letter”.  Run the letter document directly 
from the Document Explorer.  The letters will be 
generated as before.  Once created, a new letter document 
is just like any other document. 

7. Continue with the next tutorial. 

Tutorial 6.3 
Delete a Document 
This objective demonstrates a simple function that you 
probably won't need for some time. However, after an 
extended period of time when you have created dozens and 
dozens of documents, you may decide to delete some.  To 
show you how to do this, we are going to delete the letter 
document created in the last tutorial. 

1. Select the “My Category” category.   Select and highlight 
the “My Letter” document. 

2. Use the Delete Document button on the Tool Bar or the 
Delete Document option on the File Menu to delete the 
document.  The message shown below is displayed. 

Delete the Document: My Letter? 

3. Select the Yes button to delete the document.  Because 
there was just one document in the category, the category 
is also deleted.  This only happens when the last 
document in a category is deleted.   

4. Continue with the next tutorial. 

Tutorial 6.4 
Copy a Document 
There are times when it is useful to make a copy of an existing 
document.  For example, if you have a document that you 
wish to use as a model for a similar document, you can copy 
the document and then modify the copy.  In addition, if you 
wish to make a document common, but keep a copy of your 
own, you can copy the document and make the copy common.  
Use the following procedure to copy a document. 

1. Highlight the EEO-1 document in the EEO category. 

2. Use the Copy button on the Tool Bar or the Copy option 
on the Edit Menu to place a copy of the document in 
memory.  You will not see anything happen when you do 
this. 

3. Use the Paste button on the Tool Bar or the Paste option 
on the Edit Menu to place a copy of the document into the 
same category.  The new document will be named the 
following. 

Copy of EEO-1 

4. This copy of the EEO-1 document is completely distinct 
and can be modified or deleted without affecting the 
original document.  To prove this, delete this document 
using what you learned in the last tutorial. 

5. Continue with the next tutorial. 

Tutorial 6.5 
Working with Categories 
1. Categories are normally assigned when a document is 

created.  To change a category after a document has been 
created, select the document for editing, change the 
category field, and then save the document.  Try it now. 

2. Select the Home Phone List document from the General 
category.  Change the category to “Education”.  When 
you close the Adhoc Report dialog the Home Phone List 
document will have been moved from the General 
category to the Education category.   

3. You can change the category to an entirely new category 
if you wish.  Try that now.  Select the Home Phone List 
document from the Education category.  Change the 
category to “My Category”.  When you close the Adhoc 
Report dialog, the new category will be created and the 
Home Phone List will be placed in it. 

4. You can change the category for all documents in a 
category using the Document Explorer.  Here’s how.  
Position the cursor to the General category to select the 
category.  Then click on the category again and hold the 
mouse down for a second or two.  When you release the 
mouse button, the category will become editable.  Change 
the category to “New Category”.  The change will take 
place immediately and all related documents are 
permanently changed.  There is no General category any 
longer. 

5. You can merge one category with another category as 
well.  Try this technique.  Change the Headcount category 
to “New Category” using what you just learned.  Because 
the category already exists, the message shown below is 
displayed. 

This category has already been used.  Do you wish 
to combine categories? 

6. Normally, you would select the Yes button to merge the 
categories and the categories would be merged.  However, 
we need to use this category later.  Trust me, it works..   

7. This tutorial and this lesson are now complete.  Exit the 
Document Explorer and exit People-Trak. 



 

Basic Training Guide - 41 

Lesson 7 
Using the Document Viewer 

All documents produced with People-Trak are sent to the 
Document Viewer.  The Document Viewer is used to preview 
documents and to output documents not only to the printer, but 
also to a variety of other sources. 

Some of the features in the Document Viewer will only work 
if you have the appropriate product installed.  For example, 
columnar style reports can be exported directly into Microsoft 
Excel (or to a similar product associated with the XLS 
extension).  If you do not have Excel or an equivalent product 
installed, this feature will not work. 

Source Text 
People-Trak Basics – Chapter 9 

Tutorials 
Navigating a Document: shows how to use the navigation 
features to move through the pages of a document. 

Viewing, Zooming and Scrolling: demonstrates some 
obvious and some less than obvious techniques for changing 
the viewing attributes of a document. 

Output Options: shows how to output documents to 
destinations other than just the printer.   

Using Page Setup: demonstrates how to change formatting 
settings such as orientation and margins from within the 
Document Viewer. 

Tutorial 7.1 
Navigating a Document 
Most documents that you print will be more than one page in 
length.  When a document is longer than one page, you need 
to know how to navigate through the pages.  That’s the 
purpose of this tutorial. 

1. Start People-Trak, select the Personnel Module, and select 
the Document Explorer option on the Documents Menu.  
The Document Explorer dialog is displayed. 

2. Select the Physical Letter from the Default Reports 
category and run the letters.  Thirty letters should be 
generated within the Document Viewer, one for each 
employee.  This should be confirmed with the page 
counter on the Tool Bar. 

3. There are four navigation buttons on the Tool Bar.  The 
outside buttons are used to jump to the first and last pages 
respectively.  Try these now.  The page counter and the 
letter text should indicate which page you are on. 

4. The inside buttons are used to jump to the previous and 
next pages respectively.  Try these now.  The page 
counter will confirm that you are moving forward or 
backward through the pages.  The previous and next 

buttons do not wrap.  If you press the next button on the 
last page, the first page is not displayed.  Try it.  Use the 
Last Page button to display the last page.  Then use the 
Next Page button to attempt to move to the first page.  
Nothing will happen. 

5. The Page Up and Page Down keys can also be used to 
perform the Previous Page and Next Page functions.  
However, these keys also perform scrolling.  If the 
document is displayed in some type of “whole page” 
mode, the Page Up and Page Down keys will jump 
through the pages one page after another.  If the document 
is partially displayed in a “less than whole page” mode, 
the Page Up and Page Down keys will perform scrolling 
until the bottom or top of the page is displayed.  Then 
they will jump to the next page. 

6. Continue with the next tutorial. 

Tutorial 7.2 
Viewing, Zooming and Scrolling 
Documents in the Document Viewer can be viewed in a 
number of ways and the document image can be zoomed for 
optimal resolution.  Let’s learn how. 

1. When a document is first displayed, the document is 
displayed so that the width of the page fills the available 
space.  The length of the document can then be viewed 
using the scroll bar. 

2. There are five other view options.  These are listed in the 
View Dropdown on the Tool Bar.  We’ll try each one. 

3. Select the Percentage option to show the document in a 
percent of size of mode.  When this option is selected the 
Percent Dropdown is enabled.  You can use the Percent 
Dropdown to change the size of the document. Try each 
of the sizes to see which one you like best. 

4. Select the Thumbnail option.  This shows a number of 
pages in a very small size and is not a very useful option 
for viewing documents.   

5. Select the Two Pages option.  This shows two pages at a 
time.  It is very useful when you have a two-page letter 
and you wish to see both pages.   

6. Select the Whole Page option. This adjusts the size of the 
document so that a full page of the document is visible at 
once. Depending on the size of your monitor and the 
resolution, this may be a useful option.  

7. Select the Page Width option to return to the default view 
mode.  Now let’s take a look at the zooming options. 

8. Zooming in makes the document image larger and is 
performed with double-clicks of the left mouse button.  
Each double-click makes the image larger. Make the 
image larger now.  Zooming out makes the document 
image smaller and is performed with double-clicks of the 
right mouse button.  Make the image smaller now. 
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9. Whenever a document image is larger than the screen, 
scrolling is enabled.  You can scroll a document to show 
the hidden part using the scroll bars at the right and 
bottom portions of the screen.   

10. You can also use another technique to scroll the entire 
document image dynamically.  Enlarge the document 
image until there are both vertical and horizontal scroll 
bars.  Then click on the document to set the focus.  Now 
hold the left mouse button down and move the cursor 
around.  The document will scroll directly left and right, 
directly up and down, and diagonally by following the 
mouse. 

11. Close the Document Viewer and continue with the next 
tutorial. 

Tutorial 7.3 
Output Options 
One of the most powerful capabilities of the Document 
Viewer is the ability to output documents to destinations other 
than just a printer.  Let’s try these options now. 

Note: This tutorial assumes that you have the appropriate tools 
installed to utilize these features.  If you do not, the feature 
may not work as described. 

1. Select the Salary History by Employee document from the 
Compensation category and run the report.  This is the 
document we will use to demonstrate output options. 

2. The output options are listed as buttons on the Tool Bar 
and as options on the File Menu.  There are six options: to 
printer, to spreadsheet, to editor, to PDF, to browser, and 
to email.  The printer option is self-explanatory; we have 
all printed a document to a printer before.  Let’s start with 
the spreadsheet option. 

3. Use the Output to Spreadsheet button on the Tool Bar to 
output the document to a spreadsheet.  For most users, the 
spreadsheet will be Microsoft Excel.  After a brief delay, 
Microsoft Excel is started and the report is loaded, 
captions and all.  Once loaded, you can use your 
spreadsheet to take any desired action on the document.  
If you do make changes, you need to remember to either 
print or save the document since the changes are NOT 
written back to People-Trak.  The output feature is 
working on a copy of the data in People-Trak, not live 
data. 

4. Close the spreadsheet and then use the button again.  Note 
that the spreadsheet loads much more quickly.  This 
happens because Windows leaves parts of the spreadsheet 
program in memory.   

5. Close the spreadsheet.   
 
Notes: The Output to Spreadsheet option only works with 
documents that are formatted as rows and columns.  
Letter and label documents and many standard reports 
cannot use this option.  Microsoft Excel can save 
documents in a wide variety of formats.  When you need 

to create a file for another purpose in one of these 
formats, simply create a report that contains the data you 
need, output the report to Excel and then use Excel to 
save the document in the file format you need. 

6. Use the Output to Editor button on the Tool Bar to output 
the document to a word processor.  For most users, the 
word processor will be Microsoft Word.  After a brief 
delay, Microsoft Word is started and the report is loaded.  
Once loaded, you can use Microsoft Word to change the 
document just like you could with Excel.  If the document 
is a row and column document, the document is placed 
into a “table”.  If the document is a letter or labels, the 
document is presented as simple paragraphs. 

7. Close the word processor. 

8. Use the Output to Browser button on the Tool Bar to 
output the document to a browser or to the program on 
your computer that is associated with “.HTM” files.  For 
most users, this will be Microsoft Internet Explorer.  Your 
browser will be started and the report is loaded.  The 
browser does not usually have edit capabilities, but you 
can actually use the browser to save the document as a 
web page.  Now that you know how to put the document 
in your browser, you can consider the many options you 
have. 

9. Close the browser. 

10. Use the Output to PDF button on the Tool Bar to output 
the document to a PDF viewer.  For most users, this will 
be Adobe Acrobat.  Adobe Acrobat is not an editing tool.  
The usual reason for creating a PDF document is to send 
the document to someone else via email or another 
method.  Once loaded, you can save the document from 
within Adobe Acrobat. 

11. Close Adobe Acrobat. 

12. Use the Output to Email button on the Tool Bar to start 
the email process.  The Send Email dialog is displayed.  
When a document is sent to email, the document is 
automatically converted to a PDF file.  It is then listed as 
an attachment on the Send Email dialog.  You can see this 
on Send Email dialog now.  The title of the document is 
shown as an attachment.  If you send an email with this 
document, the document will be attached as a PDF.  The 
Send Email dialog is self-explanatory.   

13. Close the Send Email dialog. 

14. Any document that you create in People-Trak is always 
sent to the Document Viewer for visual inspection.  From 
the Document Viewer, you can decide if you need to print 
or output the document to another destination.  Many 
times you do not need to actually commit paper to the 
process.  When you do not, save the paper for another 
day. 

15. Continue with the next tutorial. 
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Tutorial 7.4 
Using Page Setup 
Sometimes a document will be created that looks good, but not 
quite right.  You may wish to change the orientation settings 
or the margin settings “on the fly”.  You can do that within the 
document viewer using the Page Setup feature.  Here’s how. 

1. Select the Page Setup option from the File Menu.  The 
Page Setup dialog is displayed. 

2. The values on the Page Setup dialog reflect the current 
settings for your document, but you can change them.  
Position the cursor to the Right Margin field and increase 
the right margin.   

3. Close the Page Setup dialog.  The document will be 
reformatted to reflect the change.  The same thing occurs 
with orientation.  If you have a document in the 
Document Viewer ready to print in portrait orientation, 
but you really want the document printed in landscape 
orientation, you can change the orientation and print it in 
landscape.  Try it now. 

4. Open the Page Setup dialog.  Change the orientation to 
landscape.  Close the dialog.  The document will be 
reformatted to landscape.  You can now print the 
document as it appears in the Document Viewer, in 
landscape. 

5. The changes that you make “on the fly” are not saved 
back into the document specification.  If you want a 
document feature to persist, you need to modify the 
document specification. 

6. This tutorial and this lesson are complete.  Close the 
Document Viewer and exit People-Trak.  
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Notes 
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Lesson 8 
Email 

This lesson describes how to use the email feature provided 
with People-Trak to send emails to individual records and to 
record groups.  It also demonstrates how to email documents 
from the Document Viewer to selected people or to an email 
distribution list associated with a document. 

Source Text 
People-Trak Basics – Chapter 10 

Tutorials 
Sending an Email to the Current Record: shows how to 
send an email the record currently being edited. 

Sending “Bulk” Email: shows how to send “bulk” email to 
the group of records currently selected. 

Emailing Documents: shows how to email documents from 
the Document Viewer.   

Tutorial 8.1 
Sending an Email to the Current 
Record 
There are two ways to send an email to the current record.  
We’ll show both. 

1. Start People-Trak and select the Personnel Module. 

2. Use the Open Employee feature to open the record for 
Donald Stern.  Now, here is the first method. 

3. Position the cursor to the Email field.  Note that the Email 
popup button is displayed.  Click the button to start the 
email process.  The Email Message dialog is displayed. 

4. When the Email Message dialog is displayed, the email 
address for Donald Stern is placed into the “To” field 
automatically.  Let’s complete this email using all of the 
available features. 

5. At the “CC” field, enter “carboncopy@copy.com”.   

6. At the “Subject” field, enter “The file you requested”. 

7. At the “Attachment” field, use the File popup to select 
any file. 

8. At the “Send to Notes” field, verify that the checkbox is 
checked.  This will ensure that a note is created for this 
email.  We’ll see how the note is created in just a minute. 

9. At the “Note Category” field, use the popup to select the 
“Status” category.  This is the category into which the 
note will be placed. 

10. At the large note text field, enter the following text: 
“Sample note that was emailed”. 

11. Send the email using the Send button. The Demo is set up 
to simulate the sending process. Here’s what happens. 

• The email is sent to Donald Stern. 

• The email is sent to “carboncopy@copy.com”.   

• Both email recipients receive the file that you attached as 
an attachment. 

• A note is created for Donald Stern.  The user ID is 
“DEMO”, the category is “Status”, and the note date is 
today’s date.  The note text is the following: 
 

Email Subject: “The file you requested”  
Sample note that was emailed 

• The file that was attached to the email is attached to the 
note. 

• The Email Message dialog is closed. 
 

12. Verify Donald’s Status notes, then close the notes dialog 
box. and we will demonstrate the other way to send an 
email to the current record. 

13. Select the Email option from the File Menu.  When the 
option button dialog is displayed, select the “Use Current 
Employee” option.  The Email Message dialog is then 
displayed with Donald Stern’s email address preset in the 
“To” field.  From this point, sending an email is the same 
as the prior example. 

14. Clear the Email Message dialog and close Donald Stern.  
Continue with the next tutorial. 

Tutorial 8.2 
Sending “Bulk” Email 
1. Use the Open Employee feature to start the Lookup 

process.  Create a record group that contains all of the 
employees and select Donald Stern. 

2. Select the Email option on the File Menu. When the 
option button dialog is displayed, select the “Use Current 
Group” option.  The Email Message dialog is then 
displayed with the email addresses for each record in the 
group. 

3. Position the cursor to the “To” field.  A popup button is 
displayed adjacent to this field.  This popup is not used to 
select any values, but is used to show you the list of email 
addresses for which email is to be sent.  Note that the list 
is not long.  This is because many of the records do not 
have email addresses, and thus the email addresses cannot 
be added to the list. 

4. Once the remaining fields of the Email Message dialog 
are completed, the emails will be sent to each address in 
the list.  If you have specified an attachment file, the file 
will be sent to each email address.  If you have indicated 
that a note is to be created, a note will be created for each 
record for which an email address exists. 

5. Close the Email Message dialog without sending the 
emails. 
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6. Use the Open Employee feature to start the Lookup 
process.  Create a record group that contains all of the 
employees who do have email addresses.  Can you do it?  
Here’s how.  On the Custom tab, enter “Email” as the 
field name and “<>” as the operator.  Perform the search.  
The same list of records shown on the Email Message 
dialog is displayed.  It is not necessary to pre-select only 
those records that have an email address before sending 
emails, but this is the method for determining the records 
that will receive an email prior to the email being sent.  
Close the group. 

7. Remember that you can modify the records in the group 
after the group has been created using the Edit Lookup 
option on the File Menu.   

8. Continue with the next tutorial. 

Tutorial 8.3 
Emailing Documents 
1. Select the Document Explorer option from the Documents 

menu.  Select the “Alphabetic Employee List” from the 
General category and run the report.  

2. In the Document Viewer, select the Email button on the 
Tool Bar.  When the button is pressed, the document is 
output to a temporary file in PDF format.  The Email 
Message dialog is then displayed.  The temporary PDF 
file is automatically set as the value of the Attachment 
field.  The subject is automatically set to the name of the 
report. 

3. This document can now be emailed to any email 
addresses that you enter in the “To” and “CC” fields.  The 
addresses need not be for records that are tracked within 
People-Trak; documents can be sent to any email address. 

4. If you check the “Send to Notes” field, the email 
addresses will be checked against the records in the 
current company.  If the email address matches the 
address for a record, a note will be created for that record.  

5. Clear the Email Message dialog without sending the 
email.  Close the Document Viewer. 

6. You can define an email distribution list for any 
document.  When you output this document to email, the 
email addresses from the distribution list will be 
automatically added to the “To” field when the Email 
Message dialog is displayed.  Let’s create a distribution 
list now. 

7. Highlight the “Alphabetic Employee List” in the General 
category, but do not select the document for editing or 
printing.  Instead, select  the Properties button on the Tool 
Bar.  The Document Properties dialog is displayed. 

8. The third tab on the Document Properties dialog is used to 
record the distribution list.  Two columns are provided: 
one for the name of the person, and one for the email 
address.  Enter three fictitious email addresses.  Close the 
dialog. 

9. Run the report again.  From the Document Viewer, select 
the Email option.  When the Email Message dialog is 
displayed, the three emails you added are automatically 
placed into the “To” field. 

10. This tutorial and this lesson are complete.  Close the 
Email Message dialog without sending the email.  Close 
the Document Viewer and the Document Explorer and 
exit People-Trak. 
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Lesson 9 
Batch Processing 1 

This lesson describes the techniques used to load and post 
batches.  It also shows how to postpone a batch that cannot be 
completed and to recall that batch at a later time. 

Source Text 
People-Trak Basics – Chapter 11 

Tutorials 
Loading a Batch: demonstrates how much faster batch 
processing can be than manually entering records.  Also shows 
how the operating conventions for batch processing dialogs 
are the same as those in other dialogs. 

Posting a Batch: shows how to post a batch and print the 
audit trail.  Also shows how to confirm that a batch entry has 
been posted. 

Postponing and Recalling a Batch: demonstrates how to 
postpone a batch in process and to recall that batch at a later 
time. 

Tutorial 9.1 
Loading a Batch 
1. Start People-Trak and select the Personnel Module. 

2. Select the record for Donald Stern and position to the 
Performance Reviews screen.  Use the Insert Row feature 
to insert a new row for Donald’s latest review.  Then key 
the review as shown below. 
 
Review Date: Today’s Date 
Review Type: Annual (from table - note that next 
type and next date are set) 
Rating:  Excellent (from table) 
Reviewer:  Julie Carrington (from table) 
Salary Change: Check the box. 

3. Close the record.  Now select two other records and 
record the same review.  This will demonstrate how 
performance reviews are keyed without batch processing.  
Close any open record and continue with the next step 
when complete. 

1. Select the Performance Batch option from the Processing 
menu.  The Performance Batch dialog is displayed.   

2. Enter a “1” in the “Employee #” column and press the 
ENTER key.  A list of those employees with employee 
numbers that start with “1” are displayed.  Select the 
record for Donald Stern.  The full employee number and 
the last name are returned to the first two columns. 

3. Use the Delete Row button on the Tool Bar to delete this 
entry.  Now, enter the complete employee number “1006” 
and press the ENTER key.  Because “1006” is a direct 

match for Donald Stern, the number and name are 
returned. 

4. Delete the row again and let’s try something else.  You 
can select employees by either number or name.  To 
select an employee by name, position the cursor to the 
Employee Name column and enter the letter “S”.  When 
you press ENTER, you will be presented with a list of all 
employees with a last name starting with “S”.  Select 
Donald Stern.  Again, the number and name are returned 
to the first columns. 

5. Finally, clear the row one last time.  Now select Donald 
Stern by keying a complete last name in the Employee 
Name column.  When the name and number are displayed 
for the fourth time, you will have demonstrated for 
yourself that you can select an employee for a batch using 
a full or partial name or number.  Now we can continue 
with the batch. 

6. Position the cursor to the Review Date field.  This field, 
as with all fields in batch processing, shares the same 
attributes as the corresponding field on the data entry 
screen.  Thus, you can enter the date using standard 
operating conventions.  These include keying the date by 
hand, using the calendar popup, or using the Date Stamp 
feature.  The Date Stamp feature is very useful in batch 
processing because you frequently key records with the 
same date.  Let’s use the Date Stamp feature by pressing 
the Date Stamp on the Tool Bar or Function Key 4. 

7. At the Review Type field, use the popup to select the 
“Annual” review.  Note that the Next Review Type and 
Next Review Date are automatically set based on the 
entries in the table.  

8. Complete the rest of the review just as you did earlier on 
the Performance Review screen.  

9.  Continue with the next tutorial. 

Tutorial 9.2 
Posting a Batch 
1. Complete two additional performance review entries for 

other employees in the batch from the prior tutorial.  Use 
whatever values you desire.  Note that you will find the 
Date Stamp feature quite handy here.  

2. When the three entries are complete, use the Post Batch 
button on the Tool Bar or the Post Batch option on the 
File Menu to post the batch.  The prompt shown below is 
displayed. 
 
Post this Batch? 

3. Select “Yes” to post the batch.  When the batch has been 
posted, an audit trail is created and displayed in the 
Document Viewer.  The audit trail is a history of the work 
you have just performed.  

4. When you create real batches, you may wish to print and 
file the batch or use it to compare against the original 
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source documents to confirm that all entries were entered 
and posted.  For now, just exit the Document Viewer. 

5. When you leave the Document Viewer, the Performance 
Batch dialog is displayed and all of the records that have 
been posted are cleared.  You can create another batch or 
you can exit the batch and perform another task. 

6. If records could not be posted for some reason, the 
records that could not be posted will not appear in the 
audit trail and will not be cleared from the dialog.  You 
can try to post the records again or you can postpone that 
portion of the batch for a later time.  Instructions for 
postponing a batch are provided in the next tutorial. 
 
The most common reason why a record will not post is 
that another user is currently editing that record.  People-
Trak prevents an open record from receiving an entry 
from a batch processing program. 

7. Exit the batch and look up the record for Donald Stern.  
Position to the Performance Reviews screen and note that 
the review that you “batch entered” is now the first record 
on the screen and that all other records have been pushed 
down.  This is the way that all batch processing programs 
work.  The new entries are always added at the top. 

8. Continue with the next tutorial. 

Tutorial 9.3 
Postponing and Recalling a 
Batch 
1. Select the Performance Batch option from the Processing 

menu.  When the dialog is displayed, open and review the 
File menu.  Note that both the Open Batch and Postpone 
Batch options are disabled (grayed out).  You can only 
open a batch if a prior batch has been postponed and you 
can only postpone a batch that has been started.  Let’s 
show how to use both of these features. 

2. Using what you have learned in this lesson, enter a three-
employee batch of performance reviews.   

3. When the batch is complete, open the File menu again 
and note that the Postpone Batch feature is now enabled.  
Select this option to postpone the batch that you have 
created.  The prompt shown below is displayed. 
 
Enter batch name: 

4. Enter a name for the postponed batch.  A good entry for 
the moment might be “my postponed batch”.  Then press 
OK to process your entry. 

5. The batch you created is cleared from the dialog because 
it has been postponed.  Now open the File menu and note 
that the Open Batch option is enabled.  Select the Open 
Bach option.  You will see a list of all open batches for 
this particular batch type.    Select the batch that you just 
postponed.  The batch dialog will be populated with the 
entries that were postponed.  

6. When a postponed batch has been loaded, you can treat 
the batch just as if you had just keyed the batch from 
scratch.  You can post the batch, you can delete or edit 
rows from the batch, or you can postpone the batch again. 
 
Note:  Postponed batches can be easily forgotten.  For 
this reason, postponed batches will show up in you inbox.  
You will learn about the inbox in a subsequent lesson. 

7. Go ahead and post the batch.  Then exit the Document 
Viewer when the audit trail is displayed. 

8. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 10 
Batch Processing 2 

This lesson shows how to use combo style batch processing 
dialogs and how to use the advanced lookup capabilities to 
rapidly populate batches. 

Source Text 
People-Trak Basics – Chapter 11 

Tutorials 
Using a Combo Style Dialog: demonstrates how a combo 
style batch dialog differs from a grid style batch dialog. 

Using Lookup to Load Batches: shows how to use the 
various features of the Lookup dialog to select records for use 
in batches. 

Tutorial 10.1 
Using a Combo Style Dialog 
1. Start People-Trak and select the Personnel Module. 

2. Select the Training Batch by Employee option from the 
Processing menu.  This batch option is used to record the 
courses taken by employees when each employee has 
taken a different course.  It is useful when course 
completion history has accumulated in your inbox and 
you wish to enter all the courses at once. 

3. Close the Training Batch by Employee dialog and select 
the Training Batch by Course option from the Processing 
menu.  This batch option is used when a group of 
employees have attended the same course at the same 
time.  For example, if a safety course or orientation course 
has been taught to a group of employees, you would use 
this option rather than the batch by employee option. 

4. In a Combo style dialog, you specify what happened once 
and then specify all of the employees for whom it 
happened.  In the case of a training course, what happened 
was the completion of a specific course. 

5. Position to the Completion Date field.  Enter today’s date 
using the Date Stamp feature.   

6. At the Course Code field, select the “CPR” course from 
the table.  Most of the remaining fields are completed 
from the table except the certification and the certification 
expiration date. 

7. Change the check box for “Certification” field from 
unchecked to checked.  Then set the expiration date 
forward one year from today. 

8. These entries complete the course record for all of the 
employees who attended the course.  Now we must enter 
those employees. 

9. Position the cursor to the first row of the grid on the right 
side of the dialog box.  This grid works just like the wider 
grids on the other batch processing programs.  You can 
enter full or partial names or employee numbers to select 
employees. 

10. Use this feature now to select three or four records.  When 
complete, continue with the next step. 

11. The batch is now ready to post.  Use the Post Batch 
button on the Tool Bar or the Post Batch option on the 
File menu to start the posting process. 

12. As with the grid style dialogs, an audit trail is generated 
when posting is complete.    In addition, if selected 
records cannot be posted, you will need to post the 
records before leaving the batch as there is no “postpone” 
feature for combo style dialogs. 

13. Close the Document Viewer and close the Training Batch 
by Course dialog.  Select one of the employees you 
posted the training course for and verify that the posting 
was made.  This same posting will have been made for 
each employee you selected. 

14. Close any open records and continue with the next 
tutorial. 

Tutorial 10.2 
Using Lookup to Load Batches 
You have now seen how to select records in both grid style 
and combo style batches.  It is fast and easy.  However, there 
are even more powerful methods of selecting employees.  
We’ll try this here. 

1. Select the Training Batch by Course option from the 
Processing menu.  Then select the Lookup option from 
the File menu. 

2. When the Lookup dialog is displayed, you can use any of 
the regular features associated with the Lookup dialog to 
select an entire group of employees for processing.  Let’s 
try a few options. 

3. Position to the Custom tab.  Now let’s assume that you 
wanted to record a training course that was completed for 
every employee in a specific department.  You could look 
up the employees individually, or you could enter a 
simple query and select them all at once.  Enter the simple 
query: “Department Code = 200”.  Then press the Search 
button to start the search. 

4. The employees working in department 200 are listed.  
Press the OK button to return this list to the grid.  Quickly 
review the grid.  If one or more of the employees was not 
present in the course that day, simply use the Delete Row 
button to delete that employee from the list.  Try it now.  
Delete “Ellis”.  Likewise, if another employee from 
another department was present, you can simply select the 
employee directly.  Try it now, move to the first blank 
row, and select and add Donald Stern. 
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5. When the list of employees reflects the actual attendees in 
the course, complete the course information on the left 
side of the dialog.  Then post the batch.  An entry for the 
course specified will be added to the training history for 
each employee listed.  You can verify this if you wish. 

6. As mentioned above, you can take advantage of all of the 
features of the Lookup dialog.  This includes any favorites 
you have created.  (We have not learned how to create 
favorites yet, but one has been created for you in the 
Demonstration data). 

7. To show how the Lookup dialog can be used with grid 
style batch dialogs, select the Performance Review Batch 
option from the Processing menu.  Then select the 
Lookup option from the File menu. 

8. Position to the Favorites tab.  Click on “My Favorite” to 
select the favorite created for you and perform the search.   
Then press the OK button to return the selection to the 
grid. 

9. Now you have a list of employees ready for performance 
review detail.  You can enter the review information and 
post the reviews in a fraction of the time required to 
record performance reviews individually.  However, there 
is no need to prove that point here.  Instead, we’ll 
demonstrate another way to use the Lookup feature. 

10. Use the New Batch option on the File menu to clear the 
list of records you selected.  When you are prompted to 
abandon the batch, abandon the batch. 

11. Use the Lookup dialog to select all active employees.  
When the list of employees is returned to the grid, you 
have an automated checklist of the employees who must 
have information recorded.  If the record is not complete, 
the batch is not complete.  If this takes a while to 
complete, you can use the postpone batch to complete it 
later. 

12. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 11 
Workflows  

This lesson shows how to use existing workflows to update 
existing records and to add new records. 

 

Source Text  
People-Trak Basics – Chapter 12  
 

Tutorials 
Modify an Existing Record: demonstrates how to modify an 
existing record using one of the supplied workflows. 

Add a New Record: shows how to add a new record using 
one of the supplied workflows. 

Tutorial 11.1 
Modify an Existing Record 
1. Start People-Trak and select the Personnel Module. 

2. Select the Address workflow from the Activities menu.  
The Address workflow is one of the supplied workflows. 
It will be used for demonstration purposes.  You can, of 
course, change this workflow in any way.  You’ll see how 
to do that in the next lesson.  At this point, we will be 
learning how to use workflows. 

3. Workflows are normally used to modify the information 
for an existing record.  Thus, the first step is to select an 
employee.  There are a number of ways to do this.  We 
will demonstrate them all. 

4. The simplest method used for looking up records is to 
simply click on the Lookup button.  This will provide a 
list of all the employees in the current company.  Try it 
now to select Donald Stern.  This is a helpful method 
unless you have many employees and scrolling through 
them takes time.  Click on the Clear button to clear 
Donald Stern’s record and we will try another method. 

5. Verify that the cursor is positioned to the Employee ID 
field.  At this field, enter the partial employee number “1” 
and press the ENTER key.  The lookup feature will search 
for all employees that have an employee number starting 
with “1” and will display all matches.  Try it now to select 
Donald Stern.  Clear Donald Stern and continue. 

6. If you enter a number that provides a unique, direct match 
for an employee, the employee will be directly displayed.  
Enter the number “1006” and see what happens.  Donald 
Stern is displayed because is his unique employee ID.  
Clear Donald Stern and try the next method. 

7. The Last Name field can be used just like the Employee 
ID field.  You can enter partial or full names to multiple 
or direct matches.  Enter “S” and press the ENTER key.  
Select Donald Stern and then clear him.  Enter “Stern” in 

the Last Name field and press the ENTER key.  This will 
cause Donald Stern to be displayed directly because he is 
the only employee with the last name “Stern”.  This time, 
leave Donald Stern displayed and continue. 

8. When an employee is selected, the existing information 
for that employee is displayed in the provided fields.  You 
can change this information and post it back to the 
employee’s record by simply overriding the information 
currently displayed. 

9. Before doing this, scroll the cursor through the fields on 
the workflow using the DOWN ARROW key.  Note that 
table popup buttons appear for the fields that are 
supported by tables on the Personal screen.  (In this 
workflow, each of the fields is taken from the Personal 
screen).  In fact, all of the attributes of the fields on the 
workflow are identical to the attributes on the Personal 
screen.  This includes table support, width, length, edit 
attributes, mandatory settings, etc.  Entering or changing 
information on the workflow is identical to entering or 
changing information on the Personal screen. 

10. Now let’s make a change and see how this thing works.  
Change Donald Stern’s address to the following. 
 
100 Main Street 
Apartment 22 
Bonsall, CA  92003 

11. When complete, click on the Save button to save the 
changes.  The workflow screen will be cleared so that you 
can select other records.  Close the workflow screen using 
the Close option on the File menu.   

12. Select Donald Stern using the regular lookup feature and 
verify the changes.  You will see that the changes have 
bee made just as if you entered them right on the screen 
that is currently displayed.  Close the record. 

13. Select the Name and Salutation workflow from the 
Activities menu.  This is another of the supplied 
workflows.  It is simply another collection of fields used 
for another purpose.  It works exactly the same way as the 
Address workflow.  Select Donald Stern and change his 
prefix to “Sir” and his suffix to “Esq”.  Save the change 
and close the workflow.  Use the Lookup dialog to select 
Donald Stern and confirm that we have made him a bit 
more important than he was before. 

14. Continue with the next tutorial. 
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Tutorial 11.2 
Add a New Record 
In the last tutorial, we saw that a workflow could be used to 
add or change information for an existing record.  In this 
tutorial we will demonstrate a workflow can be used to add a 
new record from scratch. 

1. Select the Name and Salutation workflow from the 
Activities menu. 

2. Select the New button to start a new record.  The cursor is 
positioned to the Employee ID field and the Lookup 
button is then disabled.  In addition, the lookup feature 
associated with the Employee ID and Last Name fields is 
disabled so that you can enter an ID and last name 
without interference.  

3. Enter the new employee as shown below. 
 
ID    99999 
Last Name   Jones 
First Name   Robert 
Middle Name  Joseph 
Salutation   Bob 
Other Name   
Prefix   Dr. 
Suffix   MD 

4. Click on the Save button to post the changes.  The dialog 
is cleared and the appropriate features are activated just as 
if the dialog had just been displayed.   

5. We can verify that Robert Jones has been added without 
leaving the workflow.  Simply enter “99999” as the 
employee ID and bring him up.  Since you may not 
believe that Bob is really in the database, close the 
workflow and use the regular Lookup dialog to select Bob 
and see for yourself that he has been added. 

6. Close the record and return to the Name and Salutation 
dialog.  Select the New button to start a new record.  At 
the Employee ID field, enter “1006” and press the 
ENTER key.  You will be greeted with an error message.  
This is because employee ID 1006 is already in use by 
Donald Stern.  Even though the lookup feature is disabled 
to allow you to record a new employee ID, it does not 
mean that validation is not working. 

7. You can add an employee from any workflow.  Try it 
now.  Use the Address workflow to add your own 
fictitious employee.  

8. In this lesson we learned how to use existing workflows. 
Workflows that you create operate in the exact same 
manner.  You’ll see how to create and change your own 
workflows in the next lesson. 

9. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 12 
Introduction to Reporting 

The adhoc report feature is used to create a large variety of 
user-defined reports and to select and run any of the hundreds 
of pre-defined custom reports provided with the product.  The 
reports can be customized as to which records are to be 
included and which fields from the database are to be printed. 

Source Text 
People-Trak Basics – Chapter 13 

Tutorials 
Create a Simple Report: demonstrates the techniques used to 
create a simple report. This includes selecting fields and using 
derived fields. 

Changing the Report Type: shows how to change the report 
type from columnar format to tabular format.  Also provides a 
description of the benefits of each report type. 

Basic Formatting Options: shows how to manipulate a report 
by changing the orientation, spacing, gridlines, and auto-
format features. 

Auto-format: demonstrates how the auto-format feature 
handles many of the formatting decisions for you so that you 
can focus on what the report is supposed to do for you, not 
what it is supposed to look like. 

Tutorial 12.1 
Create a Simple Report 
1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option.  Documents are 
broken down into categories.  For our purposes, click on 
the General category (Note: later, when we save our 
sample, it will be saved into the General category).  

3. To begin a new report, use the New Document button on 
the Tool Bar or the New Document option on the File 
Menu. A list of the different kinds of documents will 
appear.  Select Adhoc Report and click OK.  The Adhoc 
Report dialog box is displayed.  The cursor will be 
positioned to the Report Title field on the Specification 
tab. 

4. Change the title to “Test Report” and switch to the Report 
Definition tab.  The Report Definition tab uses a grid to 
collect the fields you wish to report on.  Each row in the 
grid defines a column in the report.  Let’s start defining 
columns now. 

5. The first thing we need to learn is how to select fields.  
There are two ways.  You can enter the name of the field 
if you know it, or you can select the field from the Fields 
popup.  In the beginning the Fields popup is much easier 
because you will not know the names of the fields from 

memory.  Later you may find that you do remember many 
of the field names and you will enter them from memory.  
Let’s select a field the easy way. 

6. Click on the popup button adjacent to the Field Name 
column.  The Fields popup is displayed.  The Fields 
popup provides two tabs for selecting fields.  The first tab 
lists the fields by screen and the second tab lists the fields 
in alphabetic order.  On the first tab, select the Personal 
screen and then scroll down to highlight the First Name 
field.  Double-click or press the ENTER key to select the 
field.   

7. When the Fields popup closes, the field name selected is 
returned.  In addition, the Print and Repeat columns are 
checked and the Sort column is set to “None”.  These 
settings are called defaults and can be overridden when 
necessary.  

8. It may seem strange, but this simple selection of a field 
constitutes a report.  Click on the Run button on the Tool 
Bar or use the Run option on the File Menu to start the 
report.  The report you have created will be shown in the 
Document Viewer.  The report will be a simple list of the 
first names for each employee in the DEMO company. 

9. Now let’s expand our report.  Use the Fields popup to add 
the Last Name field to the report and then run the report 
again.  Now we have a first and last name report for all 
employees in the company.   
 
Note: The reports that we are learning about in this lesson 
will always contain all of the employees because we are 
not entering query equations in the second tab.  In this 
lesson we are learning to determine what information will 
be shown in a report.  In the next lesson, we will learn 
how to determine which records will be included in the 
report. 

10. Add the following five fields to our ever-improving 
report: Address 1, Address 2, City, State, and Zip.  Now 
run the report.  We now have a name and address report 
for the employees in the DEMO company.  Note that the 
order in which the fields are entered from top to bottom in 
the grid is the order in which the fields are listed as 
columns across the top of the report. 

11. When you have used the Fields popup during this tutorial, 
you may have noticed that there is a category on the 
Screen Order tab that is not a screen.  It is the first 
category and it is named “Derived”.  Derived fields are 
fields that are created for you and that you do not enter 
directly.  For example, there is a Full Name field.  The 
Full Name field is not something you enter.  It is derived 
for you from the First Name, Middle Name, and Last 
Name fields. 

12. The derived fields can be used in reports just like any 
other field and they are very, very useful.  Let’s modify 
our name and address report to use these fields.   

13. Position the cursor to the Field Name column for the first 
row.  Change the first field from First Name to Full Name 
using the Fields popup.  Then use the Delete Row 
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function to delete the row containing the Last Name field.  
Then run the report.  Note that the combined full name 
makes this report easier to read.  There is another derived 
field that is even more useful in reporting.  This is the 
Name Full Backward field.  Change the Full Name field 
to this field using the Fields popup.  Run the report. 

14. The Name Full Backward field provides a combination of 
the First Name, Last Name, and Middle Initial fields in a 
format that is frequently used.  The last name comes first, 
followed by a comma and space, the first name followed 
by a space, and the first letter of the middle name 
followed by a period.  Our name and address report is 
getting better by the minute. 

15. To further simplify the report, delete the rows containing 
the City, State, and Zip fields and add the derived field 
that contains all three values.  Run this version of the 
report and you will see a very clean name and address 
report.  The derived field for the city/state/zip derived 
field is very, very useful when creating mail merge labels 
and letters.  It is also useful when creating address lists 
such as this.  For other reports, such as a carpool reports 
that needs to isolate these fields, you would use them 
separately. 

16. Thus far all of the fields in our report have been taken 
from either the derived fields or the Personal screen.  This 
is not a limitation.  You can select any combination of 
fields from any screen that you desire.  We’ll show this as 
the last step in this tutorial. 

17. On the first blank row in the grid, select the Employment 
Status field from the Status screen.  On the next row, 
select the Pay Rate field from the Compensation screen.  
Run the report.  All of the fields are listed just as before.  
There is a lot of “stuff” going on behind the scenes to 
make this easy, but you do not need to know about that.  
All you need to do is select the fields you wish to report 
on. 

18. This report is used in the next tutorial.  Simply continue 
with the next tutorial. 

Tutorial 12.2 
Changing the Report Type 
Because the last tutorial was so long, we will make this one 
short.  Here’s how to change the format of the report from 
columnar to tabular. 

1. Change to the Specification tab and position the cursor to 
the Document Type field.  The field should indicate 
“Columnar”.  When we created our test report, we did not 
directly specify this type of report.  It is a default because 
it is the type of report you will create the most often.  
There are other defaults as well, some of which you can 
change.  We will look at those in the next tutorial. 

2. The Document Type field is supported by a table, but 
there are only two document types: columnar that you 
have been working with and tabular.  Use the table to 
change the document type to tabular. 

3. Run the report in tabular format.  Note that all of the same 
fields are present, but that there is a sort of “mini-report” 
for each employee.  The fields are oriented vertically in a 
stack rather than horizontally in columns.  This is a 
tabular report.  You can switch documents between types 
whenever you want. 

4. Tabular reports work best when you have more fields than 
can stretch across the paper horizontally.  You can list a 
lot more fields vertically, but a report with a large number 
of employees will take a lot of paper.  The decision to use 
either report type is yours based on your needs. 

5. Change the report type back to columnar and run the 
report again.  Yes, the report is restored to its original 
glory. 

6. Continue with the next tutorial.   

Tutorial 12.3 
Basic Formatting Options 
There are other basic formatting options that you can set on 
the Specification tab.  We’ll take a look at these now. 

1. Position the cursor to the Orientation field.  The field 
should indicate “Portrait”.  As with the document type, 
the portrait orientation is a default.  In portrait orientation, 
the page is oriented vertically.  In landscape orientation, 
the page is oriented horizontally.  Orientation settings can 
be overridden by the Auto Format setting.  If the Auto 
Format feature is currently active, deactivate it now. 

2. Use the Orientation table to change the orientation of our 
report from portrait to landscape.  Run the report.  You 
may not see much of a difference, but there should be 
more white space to the right of the report.  Landscape 
orientation is useful when you have a lot of fields to print 
and you do not want to reduce the font size to something 
only an ant could read.  However, with landscape 
orientation, you get fewer lines per page and thus the 
report will be longer. 

3. Change the orientation back to portrait and then activate 
the Double-Space feature.  Run the report in this mode 
and you can see that there is a lot more space between the 
rows.  This is a popular feature when reports are 
submitted for review and editing.  Coupled with the 
landscape feature, you can produce reports with lots of 
white space for annotation.  Of course, if the rows take up 
twice as much space, the report will require twice as 
much paper. 

4. Deactivate the Double-Space feature and then activate the 
Show Gridlines feature.  This feature causes grid lines to 
be inserted between rows and between columns.  Try our 
report in this mode to see if you like it.  Many users grow 
accustomed to Excel and this feature causes People-Trak 
reports to emulate Excel style reports.  Our current report 
is a simple report and may or may not look better with 
grid lines.  With more complex reports that we will 
produce later, grid lines can be very, very helpful in 
making reports easier to read. 
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5. These formatting options can be combined in any 
variation.  Try the Double-Space option with the Show 
Gridlines option and run the report.  You can see that the 
white space is contained within the gridlines and can 
assist in the annotation process. 

6. Continue with the next tutorial. 

Tutorial 12.4 
Auto-format  
The auto-format feature allows you to create reports without 
regard to formatting and column sizing issues.  This is what 
happened when we created our test report.  We just selected 
fields and let auto-formatting take over.  To demonstrate how 
auto-formatting works, let’s make some changes to our test 
report and see what happens. 

1. On the Specification tab, activate the auto-format feature 
and deactivate double-space and grid lines.  Run the 
report and when it is displayed, note the width of the 
columns, particularly the Address 2 column. 

2. With the auto-formatting feature, columns are 
automatically sized to be just wider than the longest field 
coming into that column.  In general, the Address 2 field 
is short and thus, the column is narrow. 

3. Turn off auto-formatting and run the report again.  Note 
that suddenly the Address 2 column is very wide, much 
wider than the typical data item.  Without auto-
formatting, column widths are fixed to the length of field 
used on the data entry screens.  If the field is two inches 
wide on the screen, it will be two inches wide on the 
report. 

4. Let’s intentionally increase the width of the report and 
watch what happens.  Add the Address 1 field to the 
bottom of the report five times and run the report between 
each change.  Without auto-formatting, the report will 
quickly go off the page and you will be notified that data 
will be lost. Delete the rows you just added and then 
reactivate auto-formatting.   

5. Now repeat the process.  As the report grows, the font 
size will be reduced as auto-formatting tries to make the 
report fit in portrait orientation.  When the report cannot 
fit in portrait, auto-format with switch the document to 
landscape and then start the font sequence again.  Only 
after auto-format has done everything possible to fit the 
report will you be notified that the report data will be lost 
off the edge of the page. 

6. Because of the orientation switch, the orientation setting 
on the Specification Tab is irrelevant when auto-
formatting is active.  However, the other settings do work.  
You can use double-space and grid lines with auto-
format.  Select these and try them.  The report will work 
fine. 

7. There are other features that will allow you to control the 
formatting of a report, but that is the content of another 
lesson.  This tutorial and this lesson are now complete.  

Exit the test report that you have created and then exit 
People-Trak. 
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Lesson 13 
Introduction to Query 

This chapter introduces the concept of query equations that are 
used to select records for use in documents and lookups. 

Source Text 
People-Trak Basics – Chapter 14 

Tutorials 
Developing Simple Queries: demonstrates how to create and 
use simple query equations in the production of an adhoc 
report.  All equations use the basic “=” operator. 

Trying Other Operators: shows how to use all of the non-
compound operators. 

Compound Operators: shows how to create equations using 
the compound operators “Between” and “Outside”. 

Tutorial 13.1 
Developing Simple Queries 
1. Start People-Trak, select the Personnel Module, and then 

select the Document Explorer from the Documents Menu. 

2. Create a new adhoc document using what you have 
learned in prior lessons.  Give your new document the 
title “Test Query”.  Position to the Report Definition tab 
and select the following three fields in the order shown.   

Last Name 
Gender 
Age 

3. Position the cursor to the Query tab.  Now let’s run this 
simple report without any type of query.  When the report 
is displayed, you will see the last name, gender, and age 
for every employee.  Close the Document Viewer. 

4. Enter the following query equation. 

Gender =  Female 

5. “Gender” is a field name and should be entered in the 
Field Name column.  “=” is an operator and should be 
entered in the Operator column.  “Female” is the contents 
we are comparing and should be entered in the Contents 
column.  We will not be using the “(“, “)” or the Mod 
columns for this example.  Simply leave these blank. 

6. Run the report.  The list of employees you saw before has 
now been reduced.  Only those employees with the phrase 
“Female” in the Gender field are listed. You can validate 
this by looking at the Gender column on the report and by 
checking the number of records.  That is a simple query.  
You have effectively stated “list the last name, gender, 
and age for those employees with ‘Female” in the Gender 
field. 

7. Close the Document Viewer and change the query to look 
for males.  Run the report and note how the report has 
changed.  Only the males should be listed. 

8. Let’s try some other options based on the Last Name 
field.  Change the query to the following and run the 
report.  There are two employees named “Wilson” and 
thus there should be two employees listed. 

Last Name  =  Wilson 

9. Change the contents portion of the query to “Stern” and 
run the report.  There is only one employee named 
“Stern” and thus only one employee should be listed.  
Now change the contents to “Bogus” and run the report.  
There is no employee with the last name “Bogus” and 
thus the message shown below is displayed. 

No Information to Report 

10. There are plenty of employees in the company, but there 
are no employees with the last name “Bogus”.  Thus far, 
we have used query fields that are also included in the 
Report Definition, but that is not required.  We have 
chosen these fields because it is easier to validate the 
results of the query.  Let’s try a query that does not use 
one of the fields in the Report Definition.  Change the 
query to the following and run the report. 

First Name =  Donald 

11. The report indicates that there is only one employee that 
meets the criteria: Donald Stern.  You have seen Donald 
Stern many times, but are there no other employees with 
Donald as their first name?  You can either trust the query 
or you can add the First Name field to the Report 
Definition and confirm it yourself. 

12. In some queries, you may wish to look for fields that do 
not contain a value.  Clear the Contents field completely.  
Now run the report again.  The report should indicate that 
there are no records that have a blank first name.  There 
are a number of records, however, that have a blank Other 
ID field.  Change the query to the following and run the 
report. 

Other ID  =  

13. You should see a list of the employees who have nothing 
in the Other ID field. 

14. When you are entering the Contents portion of a query 
equation, the Contents field assumes the editing attributes 
of the field identified by the Field Name.  For example, if 
the field specified is the Hire Date field, the Contents 
field will assume that a date should be entered.  Try this 
now.   

15. Change the field name to “Hire Date”.  Then position the 
cursor to the Contents field.  Note that the Date popup is 
now adjacent to the field.  Try entering a character such as 
“A” or “B”.  Note that the characters are ignored just as 
they are at all date fields.  Enter an invalid date such as 
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“33-33-3333” and try to run the report.  The invalid date 
will be rejected. 

16. Now change the field name to “City” and then return to 
the Contents field.  Note that there is a table popup button 
adjacent to the field.  Click on the button to see a list of 
the cities in the City table.  You can use the corresponding 
tables to support data entry in a query. 

17. Numeric fields are also validated for length and format.  
Change the field name to “Pay Rate” and try to enter a 
character.  This will not be allowed.  Try a rate such as 
99.99999.  Since the Pay Rate field cannot accept five 
digits to the right of the decimal point, the value is 
adjusted. 

18. Even with all of these validation features, you can still 
create invalid queries.  The most popular method is to set 
the field, enter a valid formatted entry for the contents, 
and then change the field name.  In this way, you can 
create an equation such as “Hire Date = Donald”.  This 
invalid query will be trapped when you attempt to run the 
report.  Try it now.  Clear the field name.  Change the 
contents to “Donald”. Then return to the field name and 
set the field to “Hire Date”.  Now run the report.  The 
message shown below is displayed. 

Field and contents are not compatible. 

19. There are a number of features that trap invalid equations.  
If an invalid equation does get through the process, the 
result will usually be that no records qualify for the 
report.  In our example, if the query “Hire Date = Donald” 
was able to run, there would be no records that meet the 
criteria. 

20. Continue with the next tutorial. 

Tutorial 13.2 
Trying Other Operators 
All of the examples in the previous lesson have used the “=” 
operator.  There are actually a wide variety of operators that 
you can use in your query equations.  This lesson will explore 
many of these operators. 

1. The “Contains” operator is used to find records where the 
field specified contains the contents somewhere.  Try the 
equation shown below. 

Last Name  Contains  ils 

2. At first glance, this query seems odd, but it will return all 
the records that have the three characters “ils” somewhere 
in the last name.  This includes two “Wilsons” and one 
“Pilsner”.  For the inverse query, change the operator to 
“<>CN” which is used to list those records that do not 
contain “ils” in the last name. 

3. The “Starts” operator is used to find records where the 
field specified starts with the phrase specified in the 
contents.  Try the equation shown below. 

Last Name  Starts  S 

4. This equation will return every record that has a last name 
starting with “S”.  You are not limited to a single 
character.  You could enter the equation below to find 
employees with last name starting with the six-character 
phrase “Carring”.  There is one.  Try it and see.  The 
inverse operator is “<>ST”. This will find all of the 
records that do not start with this phrase. 

Last Name Starts  Carring 

5. The “Ends” operator is used to find records where the 
field specified ends with the phrase specified in the 
contents.  The equation below is an example you can try 
yourself. 

Last Name  Ends son 

6. The numeric operators are pretty obvious.  You can look 
for numbers less than, less than or equal to, greater than, 
or greater than or equal to the value specified.  Try the 
following equation.  It will list all employees with an age 
greater than 21. If you change the operator to “>=,”, you 
will also include those employees who are currently 21. 

Age  > 21 

7. The numeric operators can also be used on text fields.  
Try the equation shown below. 

Last Name >  Jones 

8. The report will list all employees with a last name that is 
greater than (alphabetically speaking) than “Jones”.  This 
would include “Stern” and “Wilson”, but not “Jamison”. 

9. If you switch the query to that shown below, the report 
would include “Adams” and “Healy”, but not “Stern”. 

Last Name <  Jones 

10. Continue with the next tutorial. 

Tutorial 13.3 
Compound Operators 
There are two remaining operators to demonstrate.  These are 
the compound operators that use two entries in the Contents 
field.  Here’s how they work. 

1. Change the field name to “Age” and set the operator to 
“Between”.  “Between” is a compound operator that 
compares the contents of the field to the range specified. 

2. Position the cursor to the Contents field.  Note that there 
is a popup button adjacent to the field.  This button is 
used to capture the range.  Select the button now to 
display the Set Between Values dialog. 

3. The Set Between Values dialog contains two fields.  
These fields are used to set the starting and ending values 
for the range.  Both fields take on the attributes of the 
appropriate field type.  In our example, we have used Age 
as the field.  Thus, the two fields on the dialog use the 
numeric attributes of the Age field. 
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4. Enter “30” in the first field and “40” in the second field.  
Then close the dialog and run the report.  Note that the 
ages listed for the employees are all between 30 and 40 
inclusive.  That means that employees aged 30 and 40 are 
also included. 

5. The Set Between Values dialog makes entering ranges 
quite easy, but you can actually enter them manually.  
Return the cursor to the Contents field and clear the entry 
that was generated by the dialog.  Now enter the phrase 
shown below and run the report.  The results will be the 
same as before. 

30 And 40 

6. The Between operator can be used for numeric fields, date 
fields, and text fields.  If you were looking for employees 
hired over a given period, you could use a query of the 
format shown below. 

Hire Date  Between 01-01-1990 And 12-31-
1995 

7. Change the field to Hire Date and use the Set Between 
Values dialog to create this equation.  Now run it.  Only 
employees hired during that time will be listed.  You can 
add the Hire Date field to the Report Definition to 
confirm this if you wish. 

8. The Between operator has an inverse operator named 
“Outside”.  It is used to find records that are outside of the 
stated range rather than within the range. Change the 
operator in equation listed above to “Outside”.  Now run 
the report.  The report will now include all of the 
employees that were not listed in the prior report and none 
of those who were. 

9. The range specified by the Outside operator is exclusive.  
Thus, in this example, employees hired since the 
beginning of time through 12-31-1989 and from 01-01-
1996 through the present are included. 

10. This tutorial and this lesson are now complete.  Save your 
report and exit People-Trak. 
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Lesson 14 
Sorting and Calculating 

This lesson introduces the sorting and calculation features in 
the adhoc report writer. 

Source Text 
People-Trak Basics – Chapter 13 

Tutorials 
Simple Sorting: shows how to perform simple sorting using 
one or more fields. 

Advanced Sorting: demonstrates the “break” and “eject” sort 
options. 

Using Calculations: shows how to use each of the calculation 
options provided while taking demonstrating the relationship 
between sorting and calculations. 

Tutorial 14.1 
Simple Sorting 
1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option from the Documents 
menu.  Start a new document using the New Document 
button on the Tool Bar.  When list of document types is 
displayed, select “Adhoc Report”. 

3. Select the Report Definition tab and enter the following 
three fields: Last Name, City, and Age.  Note that when 
fields are selected, the Sort column defaults to “None”.  
Run the report.  The records are listed in no particular 
order because no sort was supplied.  (In actuality, the 
records are listed in the order in which they were entered 
into the database). 

4. Set the Sort Type column on the Last Name field to 
“Sort”.  Note that the Sort Order column defaults to 
“Ascending”.  Ascending order means “A to Z” for text 
based fields and “1 to 999” for numeric fields.  Run the 
report and you will now see that the records are sorted 
alphabetically by last name in ascending order. 

5. Change the sort order from Ascending to Descending.  
Run the report.  The records should now be sorted 
alphabetically by last name in descending order.  Now 
let’s see how it works on numeric fields. 

6. Deactivate sorting on the Last Name field by setting the 
Sort column to “None”.  Activate sorting on the Age field 
by setting Sort column to “Sort”.  Run the report.  The 
records are listed in ascending order by Age.  Switch the 
sort order to descending and run the report again. 

7. That is simple sorting with a single field.  Now let’s try 
simple sorting with two fields.  Change the order of the 
fields in the Report Definition grid so that City comes 
before Last Name.  If you remember grid conventions, 

you can use the red Down Arrow to push the “Last 
Name” row down.  Now, we can double-sort. 

8. Set the Sort column on the City field to “Sort”.  Set the 
Sort column on the Last Name to “Sort”.  This report 
should now sort the records alphabetically by Last Name 
within City.  Try it.  You should see that the cities are 
sorted alphabetically in ascending order.  Within each 
unique city, the records are sorted in ascending order by 
last name.  This is double-sort or a compound sort.  The 
reason we needed to move “City” to the first row is that 
the order in which fields are sorted is determined by the 
order in which the fields appear on the Report Definition 
grid. 

9. Let’s make this report much easier to read.  Turn off the 
Repeat checkbox for the City column and run the report.  
Only the first occurrence of each city is printed and the 
report has a “pan-handle” format.  This format is much 
easier to read because it becomes very obvious when the 
sort order changes.  

10. When using compound sorts, it is not necessary to use the 
same sort order on each column.  Change the sort order on 
the Last Name field to “descending” and run the report 
again.  The sort order for the City field remains the same, 
but the sort order for Last Name within City is reversed.   

11. As a final step in this tutorial, reverse the sort order for 
the City column and run the report.  Now both columns 
are in descending order. 

12. Continue with the next tutorial. 

Tutorial 14.2 
Advanced Sorting 
1. The next level of sorting is called a “break”.  “Break” 

works just like “sort” and also inserts space (when grid 
lines is off) or inserts a line (when grid lines) is on each 
time the sort field changes.  Let’s try a break now. 

2. Switch to the Specification tab and verify that the Show 
Gridlines feature is disabled.  Change the Sort column on 
the City field to “Break” and run the report.  Note that it is 
even more obvious when the city name changes because 
of the additional space between city groups.  Reactivate 
the “Repeat” checkbox for the City field and run the 
report again.  Note that even when repeating is active, the 
break makes the report easier to read. 

3. Switch to the Specification tab and activate the Show 
Gridlines feature.  Run the report and note that a 
horizontal line is drawn between each city.  Turn the 
repeat feature off for the City field and try the report one 
more time.   Now the line is only drawn when the city 
names changes.  This is very, very readable.  Turn the 
grid-lines feature off. 

4. As with the basic sort, you can have compound breaks.  In 
the DEMO company, there are insufficient records to 
have a meaningful break by last name.  Instead, let’s 
insert a new field.  Use the Insert Row feature to insert a 
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blank row after the City field.  Add the field “Gender” to 
the report and set the Sort column to “Break”.  We are 
now breaking by Gender within City and sorting by Last 
Name within Gender.  Run the report and see how it 
looks.  That is a triple sort with a double break. 

5. There is a final level of sorting known as “Eject”.  “Eject” 
works just like “Break” except that rather than insert 
space or a line, “Eject” starts a completely new page.  To 
set up this example, delete the “Gender” row we added in 
the last step.  Then set the Sort column for the City field 
to “Eject”.  In theory, we have created a report that lists 
the employees in each city on a separate page.  Run the 
report and see what you get.  You will need to use the 
navigation features of the Document Viewer to jump 
through the pages, but they are there: one city of 
employees per page. 

6. As with “Sort” and “Break” you can have compound 
ejects, but it is not recommended because the report is 
difficult to understand.  It is usually preferable to have 
breaks and sorts within a single eject, much like our 
sample report. 

7. You can sort documents in many, many ways.  The very 
best way to learn more about sorting is to create the 
reports that you need and to try the sort features that make 
sense for your reports. 

8. Continue with the next tutorial. 

Tutorial 14.3 
Using Calculations 
1. The simplest type of calculation is a “count”.  A “count” 

is a count of the number of records within a break and 
does not reflect the contents of a field.  For example, if 
you count the salary for 30 employees, the count will be 
30, not the sum of the salary for each employee.  Let’s 
apply a “count” to our sample report. 

2. Our sample report should have three fields, City, Last 
Name, and Age.  There should be an “eject” on the City 
field and a “sort” on the Last Name field.  Add a count to 
the City field by putting the phrase “Count” into the 
Calculation column.  Now run the report.  You will see a 
sub-total added under the City column (on the report) that 
indicates the number of records in the sort.   

3. Sub-totals are provided as long as there is an “Eject” or a 
“Break” used in the report.  Change the “Eject” to 
“Break” and run the report again.  This time, you can see 
the counts for each city without needing to move between 
pages.  Before leaving the report, scroll down to the 
bottom of the report and note that a “grand total” is 
provided for all records in the report. 

4. Now change the “Break” to a “Sort” and run the report.  
This time there are no sub-totals because sub-totals are 
only included when you break or eject.  If you scroll to 
the bottom of the report, however, you will note that a 
grand total is provided.  Change the sort type on the City 
field back to “Break” and continue with the next step. 

5. Now that you have learned about counts, let’s learn about 
the other calculation types.  Without changing the 
calculation on the City field, add a “Minimum” 
calculation to the Age field.  The “minimum” calculation 
will determine the lowest value for the field within the 
break.  Try the report.  Note that the count for the records 
within the city remains while a minimum age calculation 
is provided.  Add the Age field to the report a second time 
at the bottom of the report and place a “maximum” 
calculation on this field.  We should now have a report 
that calculates the number employees in each city and 
shows the minimum and maximum ages for employees 
within that city.  You will also have learned that you can 
use the same field on a report more than once. 

6. The next calculation to learn about is “average”.  Add 
another row to the report using the Age field again.  This 
time put an “average” calculation on the Age field.  Run 
the report and you will see that we now know the average 
age of the employees in each city. 

7. You can see that calculations can be used to provide some 
very interesting statistics.  Our report, however, is getting 
redundant.  If we really want to see this degree of 
statistics, we probably do not need to see the level of 
detail shown.  Let’s make this statistics report into a 
“totals-only” report.  Turn the “Print” column to off for 
each field in the report.  This will eliminate the detail for 
the city name, last name, and each of the ages.  Now run 
the report.  You can see why this report is called a “totals-
only” report; the only thing you can see are the totals.   

8. We have one more calculation type to learn about: “total”.  
The “total” calculation is used to sum the contents of 
numeric fields.  To demonstrate it, we need to modify our 
sample report.  Delete all three Age fields.  Delete the 
Last Name field.  Reactivate printing for the City field.  
Finally, add the Pay Rate field and include a “total” 
calculation.  This report can best be described as a “Salary 
Total by City” report.  Run it and have a look.  Each pay 
rate for each employee is shown, but the employee name 
is not shown for confidentiality purposes.  For each city, 
the total salary amount has been calculated and is shown. 

9. Let’s change this report to something you will need.  
Change the field on the first row from City to Department 
Name.  Note that when you select a field, the default 
settings for Print, Repeat, Sort, Sort Order, and 
Calculation are inserted.  Place a “break” on the 
Department Name field and set a “count”.  Add Pay Rate 
to the bottom of the report so that it appears twice and set 
an “average” calculation.  Finally, change the report to a 
“totals-only” report by setting the Print column off for all 
three fields.  This report is a “Salary Statistics by 
Department” report.  It lists the total salary burden and 
average salary for each department in the company.  Very 
powerful stuff. 

10. One final example will demonstrate the power of sorts 
and calculations.  Please be aware that this report has 
been known to create trouble in organizations.  However, 
we are not responsible for this trouble; we merely report 
the facts. 
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11. Change the field on the first row to “Gender”.  Be sure to 
reset the “break”, deactivate printing, and set a “count”.  
Now delete the Pay Rate row that contains the total, but 
leave the Pay Rate row that contains the average.  This 
report is now the dreaded “Average Salary by Gender” 
report and in an instant it will indicate “potential” pay 
equity issues in an organization.  Run the report.  The data 
in the DEMO company indicates relative parity among 
gender. 

12. If you think this last sample through, you will notice that 
the report does not take into account the job performed by 
the different genders.  This report could be modified to 
break by gender within job code and to average the pay 
rate for different genders performing the same job.  With 
that report, you would have a true indication of salary 
parity.  Unfortunately, our time is up.   

13. This tutorial and this lesson are now complete.  Exit the 
Adhoc Report dialog and exit People-Trak. 
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Lesson 15 
Report Field Modifiers 

This lesson demonstrates the report field modifiers that add a 
tremendous amount of flexibility to your reports.   

Source Text 
People-Trak Basics – Chapter 13 

Tutorials 
Date Field Modifiers: shows how to use the date field 
modifiers to print the individual parts of date whenever 
desired. 

Reporting on Specific Rows: shows how to create reports 
that list individual rows from a grid. 

Creating History Reports: shows how to use the “*” 
wildcard modifier to create reports that show all rows from a 
grid. 

Using Query and Report Modifiers: demonstrates how to 
use query and report modifiers at the same time. 

Tutorial 15.1 
Using Date Field Modifiers 
1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option from the Documents 
menu.  Start a new document using the New Document 
button on the Tool Bar.  When list of document types is 
displayed, select “Adhoc Report”. 

3. Select the Report Definition tab and enter the following 
three fields: Full Name and Hire Date twice.  Run the 
report for reference purposes.  Now, let’s demonstrate the 
modifiers. 

4. Set the modifier for the first Hire Date to “M” and run the 
report.  The report will now list the month from each hire 
date. 

5. Set the modifier for the first Hire Date to “D” and run the 
report.  The report will now list the day from each hire 
date. 

6. Set the modifier for the first Hire Date to “Y” and run the 
report.  The report will now list the year from each hire 
date. 

7. That’s how the modifiers work separately.  Now let’s 
show them together.  Add the Hire Date field to the report 
two more times.  Set modifiers for the first three Hire 
Date fields to “M”, “D” and “Y”.  Run the report.  You 
will see each part of the date, followed by the full date. 

8. The date field modifiers can be used with any date.  A 
typical use of the date modifiers applies to the Birth Date 
field.  You can use the date modifiers to show a persons 

birthday without showing the year.  Try it.  Delete the 
Hire Date rows and replace them with two Birth Date 
rows.  Set the first modifier to “M” and the second 
modifier to “D”.  Set the sort field on both Birth Dates 
fields to “Sort”.  Now run the report and you will have 
nicely formatted and legally correct “Birthday Report”. 

9. Continue with the next tutorial 

Tutorial 15.2 
Reporting on Specific Rows 
This tutorial shows how to create reports that list specific 
rows. 

1. Modify the sample report by deleting the Birth Date rows 
added in the prior tutorial.  Add four Salary Date fields.  
Run the report for reference purposes.  All of the dates 
should be the same.  Because the Modifier column is 
blank, the first salary date is shown four times. 

2. Change the modifier on the second Salary Date row to “1” 
and run the report.  The report remains the same which 
proves that a blank modifier is the same as the “1” 
modifier. 

3. Change the modifier on the second Salary Date row to “2” 
and the modifier on the third Salary Date row to “3”.  Run 
this report.  It lets you see that you can place dates in 
ascending order horizontally across the page.  The 
modifiers need not be consecutive and they need be in any 
order.  You can list any row that you want in any order 
that you want. 

4. Change the modifier on the third Salary Date row to “+” 
and run the report.  The “+” modifier lists the last salary 
date for each employee.   

5. You can report on different fields and from fields from 
different screens.  Let’s try the simple version first by 
creating a report to show the Salary Date and Pay Rate for 
the second and third rows. 

6. This report is essentially a “Recent Salary History” and 
might be useful.  The only thing that would be nice to 
change is the column headings.  The report would be 
more meaningful if the headings reflected the row 
number.  There is a way to modify these headings, but 
that is the subject of another lesson.  Now change the 
report to include recent review history.  There are both 
salary and performance review dates in People-Trak.  You 
might want to see both.  Make your report rows look like 
this:  
 
Full Name 
Salary Date   1 
Change Reason  1 
Salary Date   2 
Change Reason  2 
Review Date   1 
Review Rating  1 
Review Date   2 
Review Rating  2 
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7. Run the report and you will see the two most recent salary 
reviews adjacent to the two most recent performance 
reviews.  Again the report would be more useful if the 
headings could be changed, but we’ll see about that later. 

8. The type of history report produced in this tutorial works 
when you want to list one or two items.  It does not work 
when you have a lot of items or a lot history.  More 
comprehensive history reports can be produced using the 
“*” modifier.  This modifier is demonstrated in the next 
tutorial. 

9. Continue with the next tutorial. 

Tutorial 15.3 
Creating History Reports 
1. Modify the sample report to include the following fields: 

Full Name, Salary Date, Pay Rate, Change Amount, 
Change Percent, and Change Reason.  Place a “break” on 
the Full Name field, turn off repeating for the Full Name 
field, and verify that all modifiers are blank. 

2. Run the report.  The report should list the salary detail for 
the most current salary record.  The records should be 
separated with a blank line due to the “break” that was 
inserted. 

3. Now, change the modifier for each of the salary fields 
(everything but Full Name) to “*”.  The “*” modifier is a 
wildcard and it indicates that all records should be listed.  
Place a “sort” on the Salary Date field and set the sort 
order to “Descending”.  Run the report.  Note that you 
have a nicely formatted Salary History Report.  If you 
want each employee’s salary history to be placed on a 
separate page, change the “break” on the Full Name field 
to “eject”.  Try it now.  This is a report that WILL get 
used.  Change the “eject” back to “break”. 

4. Let’s create another history report using data from the 
Performance Review screen.  Delete the salary fields and 
add the following fields: Review Date, Review Type, 
Review Rating, Next Review Date, and Next Review 
Type.  Set the modifiers for these fields to “*” and set a 
“sort” on the Review Date field.  Run the report.  Once 
again, we have created a nicely formatted Performance 
Review History report. 
 
Note: If you inadvertently do not set all of the modifiers 
to “*” on a history report, the value from the first row will 
be repeated for each line in the report. 

5. Continue with the next tutorial. 

Tutorial 15.4 
Using Query and Report 
Modifiers 
When the “*” field modifier is used in a query, one additional 
field modifier, “=”, can be used in the report definition.  This 
modifier will show only those rows that actually matched the 
query.  Let’s build the report.  

1. Modify the sample report into a simple salary history.  
Delete all rows after the Full Name field and insert the 
Salary Date, and Pay Rate fields.  Set the modifiers to “*” 
and set a descending “sort” on the Salary Date field.  You 
can run the report for verification. 

2. Switch to the Query tab and insert the equation shown 
below. 

Pay Rate * >  3000.0000 

3. The query equation will include all employees with at 
least one pay rate greater than $3,000.  The report 
definition will list all of the salary records for the 
employees who meet the minimum salary requirement.  
Run the report.  Some employees have been excluded, but 
for those employees included all of their salary records 
are shown. 

4. Change the modifiers for the salary fields on the Report 
Definition screen to “=”.  This modifier will cause the 
individual salary records (not the employee records) that 
meet the minimum salary requirement to be shown.  Run 
the report and study it. 

5. The “=” modifier triggers special processing that checks 
each record for each employee and causes each record 
that meets the query to be included.  Thus, this report is 
no longer a full history for each employee, but rather a list 
of those pay rates greater than $3,000 for each employee 
with at least one pay rate greater than $3,000. 

6. The “=” modifier is very, very powerful.  There are many 
reports that can take advantage of this feature.  Here’s 
another.  Consider a report that shows those performance 
reviews for each employee that were performed by a 
specific reviewer or that had a specific rating.  Just use the 
formula outlined above. 

7. This tutorial and this lesson are complete.  Exit the Adhoc 
Report dialog and exit People-Trak. 
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Lesson 16 
Design Mode 

This lesson shows how to make changes to a report format 
using the Design Mode dialog. 

Source Text 
People-Trak Basics – Chapter 13 

Tutorials 
Changing Column Headings: shows how to change column 
headings from the defaults provided by the data entry screen 
to any desired value. 

Changing Column Widths: shows how to change column 
widths from the defaults provided by the data entry screen. 

Changing Font Attributes: shows how to change the default 
font attributes.  Font size, font name, bold, italic, underscore, 
alignment, and color attributes can be changed. 

Tutorial 16.1 
Changing Column Headings 
In an earlier lesson we found that some reports were not as 
meaningful with the default report headings.  This tutorial 
shows how to change the column headings. 

1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option from the Documents 
menu.  Start a new document using the New Document 
button on the Tool Bar.  When list of document types is 
displayed, select “Adhoc Report”. 

3. On the Specification tab, confirm that auto-format has 
been disabled. 

4. Select the Report Definition tab and enter the following 
four fields: Full Name and Pay Rate three times.  Set the 
modifiers to “1”, “2”, and “+”.  Run the report and you 
will see a mini salary history report.  The problem is that 
the three headings for the Pay Rate fields are all the same.  
A person reading this report will not understand what the 
report is.  Let’s fix that. 

5. Select the Design Mode button on the Tool Bar.  The 
Design Mode dialog is displayed.  You should see your 
four fields spread across the grid. 

6. To change a column heading, double-click on the heading 
itself.  This will activate editing in that cell of the grid.  
Try it now and change the first Pay Rate heading to 
“Current Pay”.  Change the second Pay Rate heading to 
“Prior Pay”.  Change the third Pay Rate heading to 
“Starting Pay”.  

7. Close the Design Mode dialog using the Exit option on 
the File Menu.  Then run the report.  Now the report is 
very meaningful and useful.   

8. The headings that have been modified will remain 
modified until you change them; they are part of the 
report.  Change the heading of the last Pay Rate field to 
“Initial Pay” and run the report again.  That’s all there is 
to it. 

9. If you wish to create two-row heading, you can separate 
the words in the heading with a backslash “\” character.   
If you wish to change a two-row heading to a single-row 
heading, replace the backslash with a space.  You can try 
this if you wish. 

10. Continue with the next tutorial. 

Tutorial 16.2 
Changing Column Widths 
1. Change the sample report as follows.  Delete the three 

Pay Rate fields and add Address 1, Address 2, City, State, 
and Zip.  Run the report.  Note that without auto-
formatting, the width of the fields often exceed the 
maximum amount required.  Address 2 in particular has a 
lot of “white space”.  Let’s use Design Mode to solve the 
problem. 

2. Select Design Mode using the Design Mode button on the 
Tool Bar.  The default column widths are based on the 
widths of the field used on the data entry screens.  To 
change a column width, move the cursor over the vertical 
grid line on the heading row of the grid.  A special cursor 
is displayed.  When the cursor is displayed, you can hold 
the mouse button down and drag the heading border in the 
desired direction.   

3. Position the cursor on the line between Address 2 and 
City.  Hold the mouse button down and reduce the width 
of Address 2 by dragging to border to the left.  Release 
the mouse.  Close the Design Mode dialog and run the 
report.  If you have removed too much space, use Design 
Mode to increase it slightly.  If you have not removed 
enough space, use Design Mode to decrease it slightly. 

4. The process of changing column widths can require some 
trial and error.  If you shrink a column too much, nothing 
terrible happens.  The text uses word wrapping and opens 
the line up vertically to allow for the additional lines.  In 
some cases, where a very small percentage of fields are 
wide and the rest are thin, this can be acceptable.  Use 
Design Mode to cut the width of Address 1 in half.  Run 
the report and note how lines are wrapped when they do 
not fit the space allowed.  Set the width of Address 1 back 
to a more reasonable width. 

5. If you use auto-formatting, column widths set in Design 
Mode are completely ignored. Column widths are set 
automatically by auto-format. 

6. Continue with the next tutorial. 



 

Basic Training Guide - 70 

Tutorial 16.3 
Changing Font Attributes 
Font attributes can be changed for both the headings and the 
body of the text.  This tutorial shows how. 

1. Font attributes can be changed using word-processor like 
features in Design Mode.  Start Design Mode and click on 
the heading for Full Name.  Click on the Bold button on 
the Tool Bar to change the heading to bold text.  Click on 
the body for the Full Name field and use the text color 
button on the Tool Bar to change the body color to Red.  
Close the Design Mode dialog and run the report.  The 
changes will be shown as made. 

2. Return to Design Mode and make these settings.  Change 
the alignment of the City body text to right justified.  
Make the Zip field underlined.  Center the heading for 
Address 1.  Change the font size for State to 12.  Change 
the font name for Full Name to anything other than what 
it is.  Now, this is a ransom note.  Run it. 

3. Besides being perfectly awful, the report demonstrates 
what can be done with font attributes.  In most cases, font 
attributes should be changed with discretion. 

4. Fortunately, should a document ever reach “ransom note” 
status, you can restore the report to defaults quite easily.  
Start Design Mode and then select the Restore Defaults 
option on the File Menu. All of the settings will be 
instantly restored both on the Design Mode dialog and 
within the report itself. 

5. If you use auto-formatting, all of the font attributes are 
honored except for the font size.  Font sizes are 
automatically determined by auto-formatting and all font 
sizes are set to the same size. 

6. This tutorial and this lesson are complete.  Exit the Adhoc 
Report dialog and exit People-Trak. 
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Lesson 17 
Query Operators and 
Modifiers 

This lesson introduces the advanced operators used for 
reporting on the individual parts of telephone, date, and time 
fields.  In addition, you will learn about modifiers that allow 
you to query against specific lines in grids. 

Source Text 
People-Trak Basics – Chapter 14 

Tutorials 
Using Telephone Operators: shows how to use the telephone 
operators to select records based on the area code, prefix, and 
suffix. 

Using Date Operators: shows how to use the date operators 
to select records based on the month, day, and year parts of a 
date.  

Using Modifiers: shows how to use modifiers to identify the 
specific lines within a grid for comparison purposes. 

Tutorial 17.1 
Using Telephone Operators 
Three operators have been provided for querying against the 
three parts of a telephone number.  Here’s how to use them. 

1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option from the Documents 
menu.  Start a new document using the New Document 
button on the Tool Bar.  When list of document types is 
displayed, select “Adhoc Report”. 

3. Select the Report Definition tab and enter the following 
three fields: Last Name, First Name, and Home 
Telephone.  Place a “sort” and a “count” on the Last 
Name field.  Run the report.  All records should be 
included.  Note the number of records in the grand total at 
the bottom of the report.  Now, let’s use the operators. 

4. Select the Query tab and select the Home Telephone field 
for the first query row.  For the operator, use “AreaCode” 
and for the contents, use “619”.  Run the report.  Note that 
the number of records is less and that all of the telephone 
numbers start with “619”. Change the Contents column to 
“858” and try the report again.  There should be just one 
record with an area code of “858” 

5. Now let’s try the “Prefix” operator.  Change the operator 
to “Prefix” and change the  Contents to “744”.  Run the 
report.  Again, you should only see those records that 
have a prefix “744”.  If there were records with different 
area codes, but the same prefix, these records would be 
included.  If you needed to restrict the report to those 
records with a specific area code and a specific prefix, 

you would need to use two query equations.  Be patient, 
that’s the subject of another lesson. 

6. The final telephone operator, “suffix”, is used to find 
those records that have a particular four-digit suffix.  This 
operator will be rarely used.  However, to demonstrate it, 
change the operator to “Suffix” and the contents to 
“2557”.  There is just one record with this suffix.  Run the 
report and you’ll see which one. 

7. Continue with the next tutorial. 

Tutorial 17.2 
Using Date Operators 
Date operators work very much like telephone operators in 
that they are used to compare parts of the date to specific 
values.  Telephone operators, however, always assume that the 
field must “equal” the contents.  Date operators provide a 
much wider range of comparisons.  You’ll see below. 

1. Update the sample report by changing the Home 
Telephone field on the Report Definition tab to Hire Date.  
Then change the Home Telephone field on the Query tab 
to Hire Date.  Now let’s get started with the operators. 

2. Change the operator to “MO=”.  This operator compares 
the month of the date to the numeric month value entered 
into the Contents column. The two must be equal. 
Position the cursor to the Contents field.  When the 
special date operators are used, the edit attributes for the 
Contents field are switched from the date attributes to a 
numeric attribute of either two digits (for the month and 
day) or four digits (for the year).  Set the contents to “9” 
and run the report.  Note that all of the dates listed are in 
the month of September. 

3. Change the operator to “MO<>”.  This operator compares 
the month of the date to the numeric month value entered 
into the Contents column. The two must not be equal. Run 
the report.  Note that all of the dates listed are not in the 
month of September; records from all other applicable 
months are listed. 

4. Change the operator to “MO>”.  This operator checks for 
records where the month in the date is greater than the 
value in the Contents field.  Run the report.  Dates listed 
in October, November, and December are show.  Change 
the operator to “MO>=” to include September as well.  
Try it now. 

5. Now try the “MO<” and MO<=” operators to find those 
dates with months less than September and less than or 
equal to September. 

6. The six operator types: equal, not equal, greater than, 
greater than or equal, less than, and less than or equal are 
also available for the day of the month and the year.  Let’s 
try one of each. 

7. Set the operator to “YR>” and the contents to “1994”.  
This will list those employees hired during and since the 
year 1994.  Run the report to see for yourself.  Now 
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change the operator to “DY=” and the contents to “20” to 
list those employees hired on the 20th of any month. 

8. There are very few time fields in People-Trak, but there is 
a set of time operators for both the hours and minutes of a 
time field.  These work identically to the date operators. 

9. Continue with the next tutorial. 

Tutorial 17.3 
Using Modifiers 
Field modifiers apply to the grid-style data entry screens for 
People-Trak.  On these screens, you can have multiple lines of 
information for each employee, applicant, etc.  For example, 
you could have multiple salary records for a given employee.  
Therefore, there would be multiple Salary Dates, multiple Pay 
Rates, multiple Pay Frequencies, and so on.  Thus, when you 
use fields from these grid-type screens in a query, you must 
tell People-Trak which line of the given screen contains the 
field for the query using modifiers.  Here’s how to do it. 

1. Update the sample report by changing the Hire Date field 
on the Report Definition grid to “Pay Rate”.  Delete any 
rows in the Query grid. 

2. Add the “Pay Rate” field to the Query grid and set the 
operator to “>”.  Set the Contents field to “3000.0000”.  
In this form, the query will return the last name, first 
name and pay rate for each employee with a pay rate 
greater than $3,000.  Run it and see.   

3. All of the employees in the DEMO company have one or 
more salary history records.  How do you know which of 
these records is being used in the comparison; you did not 
specify a modifier?  If you do not use a modifier, it is 
assumed that the modifier is “1” for the first salary history 
record for each employee.  Change the modifier to “1” 
and try it.  You will see the same report you saw the last 
time because the query is identical. 

4. Change the operator to “<” and run the report again.  This 
time, the report will show all employees with a first pay 
rate record less than $3,000.  Now, let’s look at another 
scenario.  What if you wanted to check for employees 
where ANY pay rate record is less than $3,000?  You can 
do this by changing the modifier to “*”.  The asterisk 
character is a wildcard.  It means that the comparison 
process should check each and every salary history record 
for a pay rate less than $3,000.  Because older pay rates 
are typically less, we should see more records than the 
last time.  Try it and you will see more records.   
 
Note: the Pay Rate being printed is the pay rate for the 
first record (as determined by the Modifier column in the 
Report Definition grid) and thus may not correspond to 
the query.  This is because the value for the first record 
may not be the value that actually qualified the employee 
to be included in the report. 

5. Sometimes you need to check the last record only which 
is actually the first record that was entered (when records 
in the grid are sorted descending – as recommended).  

The “+” modifier is provided for this purpose.  Change 
the modifier in the sample report to “+”.  This report will 
now list the current (topmost) pay rate for those 
employees who were initially hired with a pay rate under 
$3,000.  Run the report to confirm this. 

6. Finally, there are times when you wish to compare a 
specific row.  When you need to do this, enter the row 
number directly into the Modifier column.  Use “2” now.  
This will change the meaning of our sample report as 
follows: show the first pay rate for each employee who 
has a second most recent pay rate less under $3,000.  Try 
the report. 

7. Query modifiers are not limited to pay rates.  They can be 
used with any of the records that are tracked in grids.  
Let’s try another scenario.  Change the Report Definition 
to include the “Next Review Date” field from the 
Performance Review screen.  You can delete the Pay Rate 
field if you wish. 

8. Change the query for this report to search all performance 
review records for a next review date sometime greater 
than January 1, 2000.  The equation should look like the 
following: 

Next Review Date     *  > 01-01-2000 

9. Once you have the equation entered, try the report.  This 
report will list the top most next review date for every 
employee who has any next review date greater than the 
first day of January 2000. 

10. Assuming that performance reviews have been entered in 
descending order, what operator should you use to check 
the current next review date?  The first record can be 
searched identified by leaving the Modifier blank or by 
using “1”.  If the performance reviews were entered in 
ascending order (newest at the bottom), what modifier 
would you use then?  Try it and see if it works. 

11. This tutorial and this lesson are now complete.  Exit the 
Adhoc Report dialog and exit People-Trak. 
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Lesson 18 
Linking Query Equations 

This lesson demonstrates how to develop multi-line queries by 
linking query equations.  Special instructions are provided for 
creating standard “point-in-time” queries. 

Source Text 
People-Trak Basics – Chapter 14 

Tutorials 
Creating Multi-line Queries: shows how to refine your 
queries by using more than one equation. 

Mixing Link Types: show how to use parenthesis to clarify 
equations that mix link types. 

Point in Time Queries: demonstrates the standard formulate 
for isolating records that are active a specific point in time. 

Tutorial 18.1 
Creating Simple Multi-line 
Queries 
1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option from the Documents 
menu.  Start a new document using the New Document 
button on the Tool Bar.  When list of document types is 
displayed, select “Adhoc Report”. 

3. Select the Report Definition tab and enter the following 
three fields: Full Name, Gender, and Age.   

4. Select the Query tab and enter the equation shown below. 

Gender  = Female 

5. This is an obvious query that will list those employees 
with the phrase “Female” in the Gender field.  Run the 
report for reference.  Now add an “And” link to the first 
line and the second equation shown below. 

Age > 50 

6. These two equations are linked with an “And”.  This 
means that both equations must be met and thus the only 
records listed should be those who are female and aged 
greater than 50.  Run the report and see. 

7. Now change the link to “Or” and run the report.  What do 
you see?  The “Or” indicates that if either equation is met, 
the employee will be listed.  This means that females of 
any age will be listed and that all males and females over 
50 will be listed.  This is what the report demonstrates. 

8. Change the query to the two-line example shown below 
and run the report 

Age >= 30 And 
Age <= 50 

9. The results should list those employees with an age 
between 30 and 50.  Nothing else matters.  Switch the 
“And” to an “Or” and run the report again.  What happens 
this time?  Everybody shows up.  Why?  Because every 
age is either less than 50 or greater than 30. 

10. From these simple examples, you can see that the “And” 
link tightens the filtering and the “Or” link loosens the 
filter.  Let’s try more equations. 

11. Enter the equation set below. 

Gender =  Female  And 
Age >  50  And 
Last Name Starts  B 

12. Run the report and see what you get.  There is just one 
record that meets all of these criteria.  If we entered 
another equation, it would likely eliminate even this 
record.  Conversely, if we switched all of the “And” 
operators to “Or” operators, the number of records would 
increase. 

13. When used separately, multiple “And” links narrows the 
search while multiple “Or” links widens the search. 

14. Continue with the next tutorial. 

Tutorial 18.2 
Mixing Link Types 
In the prior tutorial, we used the two link types exclusively.  
That is certainly not a requirement.  The link types can be 
mixed in any way.  Here are a few working examples. 

1. Modify the sample report by adding the Pay Rate field to 
the bottom of the Report Definition. 

2. Enter the equation set below into the Query tab. 

Gender = Male  And  
Age > 30  Or  
Pay Rate > 3000.0000 

3. This set combines the link types.  Let’s see what we get.  
Run the report.  This set of equations could mean: include 
all men older than 30 or all men with pay rates greater 
than $3000.  It could also mean: include men older than 
30 or anyone with a pay rate greater than $3000.  In 
complex equation sets, the interpretations can be endless. 

4. When And and Or operators are mixed in a set of 
equations, the equation processor evaluates the And 
equations from top to bottom and then the OR equations 
from top to bottom.  In the equations above, the employee 
would have to be either male And older than 30, Or be 
any gender of any age as long as the pay rate is greater 
than $3000.  The interpretation that forces the employee 
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to be male is ruled out because the gender and age are 
And'ed and are evaluated before the Or statement. 

5. Mixing And's and Or's can be somewhat confusing.  If 
filters of such complexity are required, they can be 
achieved.  To simplify the reading of combined And/Or 
equations, the equation processor allows the use of 
parenthesis.  Parenthesis can be used to determine the 
order in which the equations are to be evaluated.  They 
are useful when And's and Or's are used together to make 
the equation set more explicit. 

(Gender = Male  And  
Age > 30 ) Or  
Pay Rate >  3000.0000 

6. The simple addition of the parenthesis to the equations 
used earlier makes the equations much easier to read 
(although they do not actually change the result).  Try it 
and see. 

7. Parenthesis can also be used to override the default order 
in which the individual equations are to be evaluated.  For 
example, in our sample equations, the default order may 
not be what is desired.  If only males who are greater than 
30 or who have salaries greater than $3000 are to be 
included, the equations would be entered this way. 

Gender = Male  And  
(Age  > 30   Or  
Pay Rate > 3000.0000) 

8. By changing the parenthesis, the Gender = Male equation 
is actually And'ed against the result of the age and salary 
“Or” comparison.  Try this change and run the report. 

9. Continue with the next tutorial. 

Tutorial 18.3 
Point in Time Queries 
Many times it is necessary to determine which records were 
active at a given point in time.  It takes four equations to 
isolate a point in time.  Here they are in plain English. 

• Active prior to ‘date in time’  AND 

• Still active    OR 

• Active prior to ‘date in time’   AND 

• No longer active  
 

Let’s translate these equations into something we can use in 
People-Trak.  We will assume that we wish to know all of the 
employees active on January 1, 1995. 

1. Update the sample report to show the Full Name, Hire 
Date, and Active fields.  Clear all current equations in the 
Query tab. 

2. Enter the equation shown below. 

Hire Date <= 01-01-1995   

3. This equation provides a list of those employees hired 
before January 1, 1995.  Run the report.  The report 

should indicate that we are on right track. Now to limit 
the employees to those who are still active, add the 
equation show below.  Do not forget to add an “And” on 
the first equation. 

Active = Yes 

4. Run the report.  This report now includes only those 
employees who were hired before January 1, 1995, but it 
has excluded those were hired prior to that date and 
terminated at some point prior to today.  Thus, we need to 
expand the criteria to include those who are no longer 
active.  It takes the following two equations. 

Hire Date  <= 01-01-1995  And  
Termination Date >= 01-01-1995 

5. Add these equations and include an “Or” on line two.  We 
now have two pairs of equations linked by an “Or” as 
shown below. 

Hire Date  <= 01-01-1995 And 
Active  = Yes  Or 
Hire Date  <= 01-01-1995 And  
Termination Date >= 01-01-1995 

6. Run the report.  It should look good.  However, to ensure 
the results, combine the first two equations with open and 
close parenthesis and combine the third and fourth 
equations within parenthesis.  This is shown below. 

(Hire Date  <= 01-01-1995 And 
Active  = Yes)  Or 
(Hire Date  <= 01-01-1995 And  
Termination Date >= 01-01-1995) 

7. Run this report and you will obtain the results desired.  
The point in time formula can be used over and over 
again.  You can change the actual date to any date or a 
date range.  To set a date range simply move the terminate 
date forward in time to expand the period during which an 
employee can be active. 

8. This tutorial and this lesson are complete.  Exit the Adhoc 
Report dialog and exit People-Trak. 
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Lesson 19 
Date Variable Substitution 

This lesson describes how to use date variables to make 
reports more versatile and more flexible. 

Source Text 
People-Trak Basics – Chapter 14 

Tutorials 
Entering Date Variables: shows how to use the Date 
Variable popup to select date variables for use in the Contents 
column of the Query grid. 

Performance Reviews Due Example: demonstrates a “real-
world” example of how to use the date substitution variables. 

Tutorial 19.1 
Entering Date Variables 
Date variables cannot be keyed directly into the Contents 
column.  They must be selected from the Date Variable table.  
Here is how to do it. 

1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option from the Documents 
menu.  Start a new document using the New Document 
button on the Tool Bar.  When list of document types is 
displayed, select “Adhoc Report”. 

3. Select the Report Definition tab and enter the following 
fields: Full Name and Hire Date. 

4. Select the Query tab and enter “Hire Date” as the first 
field.  Set the operator to “>”.  At the Contents column, 
click on the popup button. 

5. A dialog box with three buttons is displayed.  The first 
button is used to select a fixed date from a calendar.  The 
second button is used to select a date variable from a list 
of variables.  The third button is used to cancel the 
process.  Select the second button.  The list of date 
variables is displayed. 

6. Select the variable “START-OF-PRIOR-YEAR”.  The 
equation will now select those employees with a hire date 
since the start of last year.  Run the report.  If there are 
any employees with hire dates since the start of last year, 
they will be listed. 

7. Set the “And” link on the first row.  Then add “Hire Date” 
on the second row.  Set the operator to “<”.  Use the Date 
Variable table to select the variable “END-OF-PRIOR-
YEAR”.  This sample report will now list those 
employees with a hire date between the start of last year 
and the end of last year.   

8. If this report is run at 11:59 PM on December 31, 2002, 
the report will include those employees hired during 

2001.  If this report is run just two minutes later at 12:01 
AM on January 1, 2003, it will include those employees 
hired during 2002. 

9. Exit the Adhoc Reports dialog and continue with the next 
tutorial. 

Tutorial 19.2 
Performance Reviews Due 
Example 
This tutorial guides you through the creation of a “real world” 
report: a performance review due report.  The report will be 
demonstrated for various date periods. 

1. Look up three records and modify the topmost Next 
Review Date field for each record to a date five days from 
now. 

2. Create a new adhoc report and use the title” “Performance 
Reviews Due”.  Enter the following three fields in the 
Report Definition: Department Name, Full Name, and 
Next Review Date.  Set an “Eject” sort on the Department 
field.  Set a “sort on Full Name.  Set a “sort” on the Next 
Review Date, but use descending order.  Set the “*” 
modifier on the Next Review Date. 

3. Test the report.  The report should list all next reviews for 
each employee sorted by next review date.  Each time the 
Department Name field changes, a new page will start.  
This report is designed for distribution to each manager 
with a list of the employees who are due for reviews over 
a specified period.  At this point, the report includes all 
employees and all reviews.  Let’s correct that with a 
query. 

4. One typical version of this report is run at the end of each 
week and is designed to list the performance reviews due 
the following week.  It would use the equations listed 
below. 

Next Review Date   *   >=  START-OF-NEXT- WEEK  And
Next Review Date   *  <= END-OF-NEXT-WEEK 

5. Enter the equations and try the report.  If the next review 
dates you set are next week, they will show up in this 
report.  If they do not show up, change the equations to 
use “START-OF-WEEK” and “END-OF-WEEK”.  Then 
they will show up.  This report has an error.  It shows all 
next reviews for any employee who has a review due next 
week.  Change the modifier for the Next Review Date 
field on the Report Defintion to “=”.  Now the report will 
work fine. 

6. This basic report can be modified to produce reports that 
look ahead over any of the available periods.  The most 
useful for performance reviews are the next month, and 
the next 30 days.  The appropriate equations are shown 
below. 

Next Review Date   *   >= START-OF-NEXT- MONTH And 
Next Review Date   *  <= END-OF-NEXT-MONTH 
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Next Review Date   *   >= TODAY   And 
Next Review Date   *  <= THIRTY-DAYS-FORWARD 

7. Note that the second pair of equations make use of the 
TODAY variable to start the 30 day period from today 
through a day 30 days from now.   

8. Another useful variation of this report is a version that 
looks backward for a topmost next review that is prior to 
today.  This would represent reviews that were scheduled 
and not performed.  To create this report, you would 
change the query modifier to blank or “1” and then set the 
date variables to START/END-OF-PRIOR-WEEK or 
START/END-OF-PRIOR-MONTH. 

9. This tutorial and this lesson are complete.  Exit the Adhoc 
Report dialog and exit  
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Lesson 20 
Advanced Lookup and 
Favorites 

This lesson shows you how to use the advanced features of the 
Lookup dialog.  In an earlier lesson, you learned about basic 
lookup.  This lesson demonstrates the rest of the dialog. 

Source Text 
People-Trak Basics – Chapter 14 

Tutorials 
Creating Custom Queries: shows how to use the Custom tab 
on the Lookup dialog to perform lookups using single-line 
query equations. 

Creating a Favorite: shows how to create a favorite in the 
Document Explorer for use in the Lookup dialog. 

Using Favorites: shows how to use the favorite that was 
created in the prior tutorial.. Also demonstrates how to use the 
query equations from the favorite for an advanced lookup. 

Tutorial 20.1 
Creating Custom Queries 
The Custom tab on the Lookup dialog is used to lookup 
records using a simple single-line equation.   

1. Start People-Trak and select the Personnel Module. 

2. Select the Open Employee option from the Tool Bar to 
start a Lookup.  Select the Custom tab.  The custom tab 
contains three fields: Field Name, Operator, and Contents.  
These three fields are used to perform single line queries 
for record lookups. 

3. Position the cursor to the Field Name field.  This field is 
supported by the Fields popup.  You can enter a field if 
you know it by name or you can select the field from the 
popup.  Enter “City”. 

4. The cursor is positioned to the Operator field.  This field 
is supported by the Operators table in the same way that 
the Query grid is.  The valid operators are determined by 
the field type.  Enter the “=” operator. 

5. The cursor is positioned to the Contents field.  This field 
takes on the edit attributes of the field specified.  For the 
“City” field, this means that the Contents field is 
supported by the City table.  Select any city from the 
table. 

6. Click on the Search button to start the search.  The list 
box shows all of the records that match your query.  You 
can select any record from the list or you can start another 
query.  Instead of selecting a record, use the Clear button 
to clear the query. 

7. Return to the Custom tab.  Enter the following query.  
“Hire Date > 01-01-2000”.  Note that the Contents 
column takes on the edit characteristics of a date field.  
Perform the lookup and then cancel the lookup. 

8. Continue with the next tutorial. 

Tutorial 20.2 
Creating a Favorite 
Favorites are queries that you create and save.  A favorite is 
essentially a named query that you can recall when performing 
a lookup.  This tutorial shows how to create a favorite. 

1. Select the Document Explorer from the Documents menu.   

2. Select the New Document option from the Tool Bar of the 
Document Explorer.  Select “Lookup” as the document 
type.  The Lookup dialog (the dialog used for creating 
lookup documents) is displayed. 

3. Enter “My Favorite” in the Specification Name field. 

4. On the Query tab, enter the following set of equations. 

Gender = Male   And  
(Age  > 30    Or  
Pay Rate > 3000.0000 ) 

5. You will recall that this set was used in an earlier lesson.  
Test the query using the Run button on the Tool Bar.  The 
test is a report that uses the standard lookup fields. 

6. Exit the Lookup dialog and save the favorite.  Close 
Document Explorer. 

7. Continue with the next tutorial. 

Tutorial 20.3 
Using Favorites 
This tutorial shows how to use favorites.  As an example, we 
will use the favorite created in the prior tutorial. 

1. Select the Open Employee button on the Tool Bar to start 
the lookup process.  When the Lookup dialog is 
displayed, select the Favorites tab. 

2. The listbox on the Favorites tab shows all of the favorites 
that you have created.  At the present time, the only 
favorite will be the favorite named “My Favorite” that we 
just created in the previous lesson. 

3. Click on “My Favorite” to select the favorite.  Then click 
on the Search button to perform the query associated with 
the favorite.  The list of records presented should match 
the test report run when the favorite was created.  In the 
future, additional records may be present as records 
change and then match the criteria of the query.  The 
query associated with a favorite is dynamic.  The query 
equations are executed when the favorite is processed. 



 

Basic Training Guide - 78 

4. The results of a favorite are the same as the results of any 
lookup.  You can select any record and return the entire 
group for editing. 

5. The query associated with a favorite can be modified “on 
the fly” if desired. When a favorite is executed, the query 
equations from the Lookup document are moved into the 
grid on the Advanced tab.  (You do not normally see these 
because you are positioned to the Favorites tab.)  If you 
wish to make an adhoc change to the query and to select 
records again, you can do so.  

6. Position to the Advanced tab and you will see the query 
equations that you entered when you created the favorite.  
Modify the first line to look for “Female” instead of 
“Male”.  Click on the Search button to perform the 
lookup.  The list of records will change to reflect the new 
query. 

7. The query equations associated with the favorite are not 
changed.  We are merely taking advantage of the fact that 
the equations are loaded into the grid on the Advanced tab 
just as if they had been keyed by hand. 

8. This tutorial and this lesson are complete.  Exit the 
Lookup dialog  and exit People-Trak. 
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Lesson 21 
Letter and Label Templates 

This lesson shows how to use the Template Manager to create 
and modify templates.  It also shows how to create documents 
from a template and a query. 

Source Text 
People-Trak Basics – Chapter 15 

Tutorials 
Select and Modify and Existing Template: shows how to 
select an existing template and how to modify it. 

Create a Label Template: shows how to create a new label 
template from scratch. 

Create and Print a Label Document: shows how to create a 
document from a label template and a query.  Also 
demonstrates how to make a copy of a document. 

Tutorial 21.1 
Select and Modify an Existing 
Template 
1. Start People-Trak and select the Personnel Module. 

2. Select the Template Manager from the Documents menu.  
The sample templates are all listed in the “blank” 
category.  Locate the “Address Label – Avery 5160” 
template and select it for editing. 

3. Change the category to “Address Labels”. 

4. Start the text editor using the Edit Template button on the 
Tool Bar.  When the text editor is displayed, note that the 
edit area has been sized to match Avery 5160 label.   

5. This label contains no literal text.  It contains only fields.  
The fields are indicated by the ~F~ placeholders.   Move 
the mouse cursor over one of the placeholders.  The 
cursor icon will switch to an up arrow whenever you 
hover over a placeholder.  You can use this feature to 
identify (and to optionally change) an existing field in a 
template.  Try it now.  Hover the cursor over the first 
placeholder and then double-click.  The Field Information 
dialog is displayed.  It shows the name of the field and 
any applicable modifier.  Close the dialog and try another 
field. 

6. You can also show all of the fields at once.  Use the Show 
Fields option on the Fields menu to display the field 
names.  From the field names, it is clear that this is an 
address label.  Use the Show Fields option to change the 
field names back to placeholders.  Now, let’s add the 
Country field to the label template. 

7. Position the cursor to the first line after the last 
placeholder.  (If you get stuck inside of a field, use the 

Arrow Key to position to the first character outside of the 
field).  Use the Insert Field option on the Fields menu to 
display the Field Information dialog. 

8. Use the popup button next to the Field Name to display 
the Fields popup.  Select the Country field and close the 
dialog.  The national address label has now been switched 
to an international address label. 

9. Close the text editor and close the Label Template dialog.  
We changed the category of the label and you will note 
that the Template Manager now reflects the change.  
There is a new category and the template listed in that 
category is the template we just modified.  Now, let’s take 
a quick look at a more complex template.   

10. Locate the “Attendance Balances with History” template 
and select the template using the Open Template button.  
Then select the Edit Template button (a red exclamation 
point) to show the template in the text editor.  This 
template is a full-page template that uses tables and 
hundreds of individual fields.  It is just a sample of what 
can be created. 

11. Close the text editor and the template.  Leave the 
Template Manager dialog displayed. 

12. Continue with the next tutorial. 

Tutorial 21.2 
Create a Label Template 
In the last tutorial, you learned how to view and modify an 
existing template.  In this lesson, you’ll create a template from 
scratch.  Let’s get started. 

1. Select the New Template button on the Tool Bar.  When 
the Select Template dialog is displayed, select “Label”. 
The Label Template dialog is displayed. 

2. At the Template Name field, enter “My Big Label 
Template”. 

3. At the Category field, enter “Address Labels”. 

4. The Label Type field is used to select an Avery label type 
to be used with the template.  The field is supported by a 
table listing the types.  Select the “Avery 5164”.  This is a 
somewhat larger label. 

5. Use the Edit Template button to start the Text Editor.  
When the Text Editor is displayed, editable area is sized 
to reflect the actual size of the label. 

6. Because this is a large label, change the font size to 14. 

7. Use the ENTER key to move the cursor down two lines.  
Now let’s insert a field.  Use the Insert Field button on the 
Tool Bar or the Insert Field button on the Fields menu to 
start the process.  When the Field Information dialog is 
displayed, select the “Full Name” field. 

8. On the next line, insert the “Address 1” field. 

9. On the third line, insert the “Address 2” field. 
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10. On the fourth line, insert the “City, State, Zip” derived 
field. 

11. To customize our large label, change the font attributes on 
the “Address 1” to Bold, Italic, and Underline.  You can 
do this by selecting the field and then setting the attribute. 

12. Finally, to show that a template can contain text other 
than fields, add a line at the bottom of the label that says 
“bottom of the label”. 

13. Close the editor and close the Label Template dialog.  
Note that there are now two labels in the Address Labels 
category.  Close the Template Manager. 

14. Continue with the next tutorial.  

Tutorial 21.3 
Create and Print a Label 
Now that we have created a template, it is time to create a 
document that uses that template. 

1. Select the Document Explorer from the Documents menu.   

2. Select the New Document button from the Tool Bar to 
start a new document.  Select the “Label” type from the 
Select Document Type dialog when it is displayed.  The 
Label dialog is displayed. 

3. Set the Document Title field to “Document using Big 
Label Template” 

4. Select any desired category.   

5. Now at the Template Name field, use the popup to locate 
and select the template we just created.  Leave the Sort 
fields blank for the moment. 

6. Now run the “Big” label.  You should have multiple 
pages with four labels per page.  Move through the pages 
and enjoy your big label.  It is truly something “big”. 

7. Close the Document Viewer and add a sort field.  Use 
“Last Name”.  Now run the labels again. 

8. Your big labels are now listed in order by last name.  
That’s even a bigger accomplishment. 

9. Now, let’s add a query.  Add an equation that will list 
those employees who have really big pay rates.  Try the 
following: 

Pay Rate  > 5000.0000 

10. Run the report.  The number of big labels is now smaller 
because there are fewer employees with pay rates greater 
than $5000. 

11. Close the Label dialog and return to the Document 
Explorer.  Find your “big” document highlight it.  Use the 
Copy button on the Tool Bar to copy your document and 
then use the Paste button to put that copy into the 
Document Explorer.  There will now be an identical copy 
of the document with the phrase “Copy of” in front of it. 

12. Select the copy and change the Document Title field to 
“Document 2 using Big Label Template”.  Then, change 
the query to look for employees who have pay rates less 
than $5000.  Run the document to test it and then save it 
and return to the Document Explorer. 

13. You now know how two separate documents that use the 
same template.  Because a document is composed of a 
template and query, these are not the same document 
because they have a different query.  You can create other 
documents that use your “big” template as well.  Each 
document will be unique. 

14. This tutorial and this lesson are now complete.  Close the 
Document Explorer and close People-Trak. 
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Lesson 22 
Advanced Editing  

This lesson shows how to use the advanced features of the 
Text Editor.  This includes images, headers and footers, and 
tables. 

Source Text 
People-Trak Basics – Chapter 16 

Tutorials 
Create a Letter Template: shows how to create a basic letter 
template.  This includes setting page margins. 

Add a Header and Footer: shows how to add a header and 
footer to a letter template. 

Insert an Image: shows how to insert one or more images 
into a letter template. 

Add a Table: shows how to add a table to a letter template 
and how to add merge fields to the columns in the table. 

Tutorial 22.1 
Create a Letter Template 
1. Start People-Trak and select the Personnel Module. 

2. Select the Template Manager from the Documents menu.  
Select the New Template button on the Tool Bar.  When 
the Select Template dialog is displayed, select “Letter”. 
The Letter Template dialog is displayed. 

3. At the Template Name field, enter “My Special Letter”. 

4. At the Category field, enter “Special Letters”. 

5. Use the Edit Template button to start the Text Editor.  
When the Text Editor is displayed, editable area is sized 
like a word processor for full-page documents.   

6. The default page margins are one-half inch on all four 
sides.  This is generally too small for most letters.  Select 
the Page Setup option from the File Menu.  The Page 
Setup dialog is then displayed.  Change left, right, top, 
and bottom margins to one inch.  When you close the 
dialog, note that the ruler bar is updated to reflect the new 
settings. 

7. When you first enter a new letter, the default font is Arial 
and default font size is 11.  Use the appropriate 
dropdowns on the Tool Bar to change the font to Times 
Roman and the font size to 12. 

8. Type in the following paragraph. 
 
This is my sample letter.  In this letter, I will learn how to 
set margins, add a header and footer, insert images, and 
add tables.  I am very excited to learn about these things. 

9. Continue with the next tutorial.  

Tutorial 22.2 
Add a Header and Footer 
Headers and footers can only be viewed and edited when you 
are in Page Layout or Centered Page Layout mode.  You can 
insert a header or footer while in Normal mode, but you 
cannot see or change the header or footer.  Thus, it is good 
practice to switch to Page Layout mode when you wish to 
work with headers and footers. 

1. Use the View Menu to place the editor in Page Layout or 
Centered Page Layout mode. 

2. Use the Header option on the Insert Menu to create a 
header.  Note that the text of the header simply states 
“Header”.  This is a placeholder and you will need to 
change the header text to the desired phrase.  Use the 
mouse to click on the phrase “Header”.  The cursor will 
be positioned into the header editing area and you can 
now edit the header. 

3. Change the phrase from “Header” to “Sample Letter”.   
Whenever you are positioned to either the header or 
footer editing areas, the various editing and formatting 
options on the Tool Bars apply to the text in that area and 
not to the main editing area.  Thus, if you wished to right 
justify the header (it is currently left justified), you can do 
so using the Right Justify button on the Tool Bar.  Try it 
now.  Click the Right Justify button to cause the phrase 
“Sample Letter” to be right justified within your header. 

4. Change the font attributes of the “Sample Letter” phrase 
to Bold and Underline using the appropriate buttons on 
the Tool Bar.  (You will need to highlight the text first). 

5. Return to the main editing area by clicking outside the 
header area.  Any actions now performed using the Tool 
Bar buttons will apply to the main editing area.  Now let’s 
insert a footer. 

6. Scroll the editing area so that bottom portion of the page 
is visible.  Use the Footer option on the Insert Menu to 
create a footer.  Note that the text of the footer simply 
states “Footer”.  As with the header, this is a placeholder 
that you can change to any desired phrase.  Change the 
phrase to “Page: “.  Now we’ll see how to add page 
numbers to this footer (and thus to any header or footer 
you create). 

7. Verify that the cursor is just to the right of the “Page: “ 
phrase.  Use the Page Number option on the Insert Menu 
to insert a page number at that location.  You will see the 
number “1” displayed.  The number “1” is not a literal; it 
is a variable.  The “1” is showing because you are on the 
first page of your letter.  The number will automatically 
increment with each page of the letter.   Now let’s format 
the page number. 

8. Use the Font and Font Size dropdowns to change the Font 
to Arial and the size to 10.  Then, highlight the page 
number portion of the phrase and make it Bold. 

9. Click on the main editing area to exit the Footer area. 
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10. Continue with the next tutorial.  

Tutorial 22.3 
Insert an Image 
1. Position the cursor to a line just below the paragraph that 

you typed. 

2. Use the Insert Picture option on the Insert Menu to 
activate the Select File dialog.  This dialog is used to 
select image files. 

3. Use the Select File dialog to locate the folder in which 
People-Trak is installed.  Locate the Help folder beneath 
the People-Trak folder and then locate the UG_Files 
folder beneath the Help Folder. 

4. Select the IMAGE002.JPG file.  The picture contained in 
this file will be displayed in  your letter. 

5. Once an image has been inserted into your letter, you can 
move the image around just as if it were a large character.  
For example, if you wish to move the image down, you 
can do so by inserting lines above the image.  Try it now.  
Position the cursor on the line above the image and press 
the ENTER key a few times.  Note that the image moves 
down.  Now delete some of the blank lines and the image 
will move back up. 

6. The image can also be aligned just like text.  Select the 
image by clicking on it.  Then use the Right Justify button 
to align the image with the right margin.  Then try the 
Center button to align the image between the margins.  
Finally, use the Left Justify button to align the image with 
the left margin. 

7. The image can also be moved around with tabs.  Position 
the cursor on the line immediately above the image.  Then 
use the DOWN ARROW key to position the cursor to the 
image without actually selecting the image.  Now use the 
TAB key to push the image to the right.  The image will 
align with the next tab stop shown on the Ruler Bar. 

8. Now let’s see how to delete the image.  Select the image 
by clicking on the image with the mouse.  Then, press the 
Delete key and the image will be deleted.  That’s all there 
is to deleting an image. 

9. Now, use the techniques used above to select the image 
again. 

10. Continue with the next tutorial.  

Tutorial 22.4 
Add a Table 
A table can be inserted at any point within a document, except 
within an existing table.   

1. Position the cursor to a blank line below the image that 
you have inserted in the prior tutorial. 

2. Select the Insert option from the Tables menu and then 
specify “Table” to insert a new table.  The Table 
Attributes dialog is displayed.  This dialog is used to 
specify the number of rows and columns.  Specify ten 
rows and four columns. 

3. When you have specified, the rows and columns, the table 
will be inserted into the letter.  Note that an additional 
caption row was added and that captions were inserted for 
you.  This feature speeds the process of adding caption 
rows considerably. 

4. We are going to create Skills Inventory table on this 
letter.  Change the captions to the following phrases: 
Skill, Skill Date, Skill Level, and Skill Comment.  In 
addition, change the alignment of the caption phrases 
from Left Justified to Centered.  You can do this one 
caption at a time or you can select the entire caption row 
and do it all at once. 

5. Now we need to insert the merge fields.  This looks like a 
daunting task as there are 40 separate fields to insert, but 
there is a very nice feature in People-Trak that will make 
this task quite easy.   

6. Position the cursor to the first column on the first blank 
row.  Use the Insert Field option on the Fields Menu or 
the Insert Field button on the Tool Bar to display the Field 
Information dialog.  Use the Field Popup to select the 
“Skill Description” field from the Skills screen.   The 
cursor is then positioned to the Modifier field 

7. At this point, you would normally wish to specify a 
modifier to indicate the first skill because this is the first 
row.  However, you can take advantage of the “Autoset” 
feature within People-Trak by leaving the Modifier field 
blank.  Use the “OK” button to close the dialog.  People-
Trak automatically detects that you are inserting fields 
into a table and provides the following prompt. 
 
Autoset the Column? 

8. Select “Yes” and see what happens.  The entire column is 
populated with the “Skill Description” field and the 
modifiers are automatically sequenced from one to the 
highest numbered row in the table.  You can check this by 
double-clicking on any of the fields.  When the Field 
Information dialog is displayed, you can see that the both 
the field name and the appropriate modifier have been 
supplied. 

9. Repeat this process for the second column using the “Skill 
Date” field.  Then complete column three using “Skill 
Level” and column four using “Skill Comment”. 
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10. Now let’s see how this letter works.  Close the editor 
using the Exit option on the File Menu.  Then close the 
Letter Template dialog and the Template Manager. 

11. Select Donald Stern for editing.  Use the Letters option on 
the File Menu to display the list of letters.  Select the 
letter we just create “My Special Letter” and run it for the 
current record (Donald Stern) only.  You should see your 
header and footer, the image you inserted, and the Skills 
Inventory table you added.  This letter, as you have 
created it, is not entirely useful unto itself, but you now 
know how to use many of the powerful features of the 
Letter/Label editor. 

12. This tutorial and this lesson are now complete.  Close the 
current record and exit People-Trak. 
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Notes 
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4 
Advanced Features  
Lesson 23 – Using Other Document Types 
Tutorial 23.1 – Export an Address List 
Tutorial 23.2 – Export a Birthday List 
Tutorial 23.3 – Export Compensation History 
Tutorial 23.4 – Standard Reports 

Lesson 24 – Workflows  
Tutorial 24.1 – Modify a Workflow 
Tutorial 24.2 – Create a New Workflow 
Tutorial 24.3 – Deactivate a Workflow 

Lesson 25 – Customization 1 
Tutorial 25.1 – Changing the Screen Caption 
Tutorial 25.2 – Changing the Field Name 
Tutorial 25.3 – Changing Edit Attributes 

Lesson 26 – Customization 2 
Tutorial 26.1 – Changing a Support Table 
Tutorial 26.2 – Activating the ‘Not Used’ Feature 
Tutorial 26.3 – Using ‘Mandatory’ Fields 

Lesson 27 – Scheduler 1 
Tutorial 27.1 – Create a Scheduled Item 
Tutorial 27.2 – Modify a Scheduled Item 
Tutorial 27.3 – Delete a Scheduled Item 

Lesson 28 – Scheduler 2 
Tutorial 28.1 – Schedule a Document 
Tutorial 28.2 – Running an Item ‘At Login’ 
Tutorial 28.3 – Schedule with Document Explorer 

Lesson 29 – Alerts 
Tutorial 29.1 – Create and Test a New Alert 
Tutorial 29.2 – Modify a Existing Alert 
Tutorial 29.3 – Delete a Existing Alert 

Lesson 30 – Inbox 
Tutorial 30.1 – Using Inbox Features 
Tutorial 30.2 – Running Scheduled Items and Alerts 
Tutorial 30.3 – Reactivating a Postponed Batch 

Lesson 31 – User Preferences 
Tutorial 31.1 – Setting Data Entry Preferences 
Tutorial 31.2 – Changing Screen Order 
Tutorial 31.3 – Changing Report Preferences 

Lesson 32 – Contact Manager 
Tutorial 32.1 – Add a Contact 
Tutorial 32.2 – Delete a Contact 
Tutorial 32.3 – Using Ticklers 
Tutorial 32.4 – Making a Contact Common 

 
 
Lesson 33 – Inter-Module Communication 
Tutorial 33.1 – Applicant to Personnel 
Tutorial 33.2 – Personnel to Applicants, Safety, COBRA 
Tutorial 33.3 – Position Control to Personnel, Applicants 
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Lesson 23 
Other Document Types 

This lesson demonstrates how to use the export feature to 
export data for use in other products and application tools.  It 
also includes instructions for importing files into People-Trak 
that have been created from other applications. 

Source Text 
People-Trak Basics – Chapter 17 

Tutorials 
Export an Address List: demonstrates how to export a list of 
names and addresses for use in creating address labels with 
another product. 

Export a Birthday List: shows how to export portions of 
months using the month and day modifiers. 

Export Compensation History: shows how to export 
multiple records per employee. 

Tutorial 23.1 
Export an Address List 
Many products can import tab-delimited files.  In this tutorial, 
we will create a tab-delimited file containing the name and 
address for each employee.  Such a file might be used with a 
fancy label creation program.  We will use Microsoft Excel to 
verity the results of the files we create. 

1. Start People-Trak and select the Personnel Module. 

2. Select the Document Explorer option.  To begin a new 
export, use the New Document button on the Tool Bar or 
the New Document option on the File Menu. A list of the 
different kinds of documents will appear.  Select Export 
and click OK.  The Export dialog box is displayed.  The 
cursor will be positioned to the Document Title field on 
the Specification tab. 

3. Complete the fields on the Specification Tab as shown 
below. 
 
Document Title: Test Export 
Category:  AAA 
Delimiter:  Tab 
Export Path: C:\PEOPLETRAK\ 
Export File:  TEST.TXT 
Sort By:  Last Name 
Include Header: Yes 

4. Switch to the Fields tab.  Enter the following fields in the 
order shown. 
 
Full Name 
Address 1 
Address 2 
City 

State 
Zip 

5. When the fields have been entered, use the Run button on 
the Toolbar or the Run option on the File Menu to create 
the export file.  When the document is complete, a 
message is shown in the Document Viewer.  Close the 
Document Viewer. 

6. Without closing People-Trak, start Microsoft Excel and 
open the file you have just created.  The file will be 
named TEST.TXT and will be stored in the 
“C:\PEOPLETRAK” folder. 

7. When you open the file, Excel will determine that the file 
is not a standard Excel file and will prompt for additional 
information using the Text Import Wizard.  Accept the 
defaults that Excel presents until the file is displayed in 
Excel.  The name and address records are listed 
alphabetically by last name.  The columns are ordered in 
the order in which the fields were listed on the Fields tab.  
The field names have been included as the first line in the 
Excel spreadsheet. 

8. Close the Excel file and do not bother to save it.  Now 
change the “Include Header” checkbox to indicate that 
header fields should not be included.  Run the export 
again.  When complete, open the file in Excel and note 
that the header is no longer included. 

9. Close the Excel file.  This time, change the sort field from 
“Last Name” to “City”.  Run the export and open the file 
in Excel.  This time the records are listed by city not last 
name. 

10. Close the Excel file.  Change the “Include Header” 
checkbox to indicate that the header fields should again 
be included.  Add the “Employee ID” field to the bottom 
of the list of fields and run the Export again.  When you 
open the file in Excel, you will see that the Employee ID 
field has been added as the last column. 

11. Find the row for Donald Stern and change his employee 
ID to “9999”.  Find the record for Jonathan Strauss and 
change his address to “XXX”.  Save the file in the 
C:\PEOPLETRAK folder as “TEST2.TXT” because we 
are going to use this file in a later tutorial.   

12. Close Excel and change the sort field back to “Last 
Name”.  Continue with the next tutorial. 

Tutorial 23.2 
Export a Birthday List 
Export works very much like Adhoc Reports.  You can use 
modifiers to specify which information you would like to 
export.  In this example, we will export the parts of the birth 
date. 

1. On the Fields tab, delete each of the fields except the first 
field.  Then add the Birth Date field four times. 

2. For the first Birth Date field, set the modifier to “M” for 
month.  For the second Birth Date field, set the modifier 
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to “D” for day.  For the third Birth Date field, set the 
modifier to “Y” for year.  Leave the modifier for the 
fourth Birth Date field blank. 

3. Run the Export and then open the export file in Excel.  
Note that the month of the birth date is shown for the first 
Birth Date field, the day of the birth date is shown for the 
second Birth Date field, and the year of the birth date is 
shown for the third Birth Date field. The fourth Birth Date 
field is shown completely so that you can see that the 
month, day, and year have been extracted correctly.  
Close the Excel file. 

4. When you export a file, the query feature works just as it 
does elsewhere in People-Trak.  Let’s demonstrate this.  
Move to the Query tab.  Enter the query equation shown 
below. 
 
Birth Date  MO>  6 

5. This equation will list all records that have birth date in 
the months July through December.  Run the export.  
When complete, open the file in Excel.  You will see that 
that only those records with birth months greater than 6 
are included.   

6. Close the Excel file.  Delete the query equation you just 
entered.  Continue with the next tutorial. 

Tutorial 23.3 
Export Compensation History 
1. On the Fields tab, delete each of the Birth Date fields.  

Then, add the fields shown below.  Note that the asterisk 
has been added as a modifier for each of these fields. 
 
Salary Date   * 
Pay Rate   * 
Annual Pay   * 
Change Amount  * 
Change Percent  * 

2. Run the Export and then open the export file in Excel.  
Note that the salary detail for each of the salary records 
for each employee has been exported.  You can use the 
“*” modifier to export detail whenever desired.  Close the 
Excel file. 

3. Export can also use the query option to limit those lines 
that are to be exported for each employee.  Let’s 
demonstrate this feature.  Move to the Query tab.  Enter 
the query equation shown below. 
 
Pay Rate   * > 5000 

4. Then change the “*” modifiers for the fields on the Fields 
tab to “=”. 

5. Run the Export and then open the export file in Excel.  
Only those records for each employee that have a pay rate 
greater than 5000 are included. 

6. The examples above export detail vertically with multiple 
records per employee.  If you wish to export 
compensation history horizontally, change the fields on 
the Fields tab as shown below. 
 
Full Name Backward 
Salary Date   1 
Pay Rate   1 
Salary Date   2 
Pay Rate   2 
Salary Date   3 
Pay Rate   3 

7. Run the Export and then open the export file in Excel.  
The first three compensation dates and amounts are 
shown left to right.  There is a single compensation record 
per employee.  Close the Excel file. 

8. Close the Export dialog and continue with the next 
tutorial. 

Tutorial 23.4 
Standard Reports 
Standard Reports are those reports that have a pre-defined 
format.  You can determine what records are to be included in 
the report, but you cannot change what the report looks like.  
Let show how to create a standard report. 

1. From the Document Explorer, start a new document using 
either the New button on the Toolbar or the New 
Document option on the File Menu. 

2. When the list of document types is displayed, select 
“Standard Report”.  On the Standard Report dialog, name 
the report “My Gender Graph” and put it into the “AAA” 
category.  Leave the Comment field blank. 

3. A standard report document is composed of a standard 
report template and a query (which could be blank.).  
Thus, we must select report template at the Standard 
Report field. 

4. Use the popup button to display a list of the existing 
report templates.  Select the “Workforce Distribution by 
Gender” template.  Now, let’s complete the document by 
adding a query. 

5. Position to the Query tab and enter the simple equation 
shown below. 
 
Active = Y 

6. This query will limit the employees in the report to those 
that are currently active.  Now run the report.  The report 
is a pie chart that graphically indicates the gender makeup 
of the workforce.   

7. Close the Document Viewer and close the Standard 
Report dialog.  Your new report should now be listed in 
the Document Explorer in the “AAA” category.   

8. This tutorial and this lesson are complete.  Exit People-
Trak. 
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Lesson 24 
Workflows   

This lesson shows how to modify one of the supplied 
workflows and how to create a new workflow from scratch. 

Source Text 
People-Trak Basics – Chapter 18 

Tutorials 
Modify a Workflow: demonstrates the techniques used to 
modify one of the supplied workflows. 

Create a New Workflow: shows how to create a new 
workflow from scratch. 

Deactivate a Workflow: demonstrates how to deactivate an 
existing workflow so that it can be removed from the 
Activities menu. 

Tutorial 24.1 
Modify a Workflow 
1. Start People-Trak and select the Personnel Module. 

2. Select the Build Workflow option from the Tools menu.  
The Build Workflow dialog is displayed.  This dialog is 
used to maintain the six separate workflows that are 
available in each module.  The grid on the left is used to 
name and activate the workflows.  The list box on the 
right is used to specify the fields that will be used in the 
currently selected workflow.  Now let’s change a 
workflow. 

3. Verify that the Address workflow is highlighted.  Let’s 
assume that your organization is purely domestic and does 
not require the “Country” field in this workflow.  Position 
the cursor to the “Country” field in the list box.  Then 
press the Delete button to delete the field.  This change 
will take effect immediately.  We’ll prove it. 

4. Close and save the change using the Exit option on the 
File menu.  Select the Address workflow from the 
Activities menu.  Note that the “Country” field is gone.  
Close the workflow and return to the Build Workflow 
dialog. 

5. It is just as easy to add fields to a workflow as it is to 
delete them.  On the Address workflow, position to the 
first blank row in the list box and click on the Add button.  
Use the field lookup feature to select the “Company 
Code” field from the Personal screen.  Close and save the 
change and then confirm that the field is now on the 
actual workflow dialog.  It should be the last field 
displayed.  Close the workflow and return to the Build 
Workflow dialog. 

6. Let’s now assume that we wish to change the order of the 
fields on the Address workflow.  In particular, we would 

like the “Company Code” field to be the first field, not the 
last field.  Position the cursor to the “Company Code” 
field and use the UP button to bump the field up until it is 
the first field.  Again, close and save the change and then 
confirm the change on the Address workflow dialog.  It 
should now be the first field (after the Employee ID and 
Last Name).  Close the workflow and return to the Build 
Workflow dialog. 

7. Thus far, the fields on the Address workflow have all 
been taken from the Personal screen.  This is not a 
requirement; you can select fields from any screen.  The 
following changes do make a coherent workflow, but they 
will demonstrate the capabilities of workflows.  Add the 
following fields to the bottom of the workflow. 
 
Active  (Status Screen) 
Pay Rate  (Compensation Screen) 
Next Review Date (Performance Reviews Screen) 

8. When complete, close and save the changes.  Select the 
Address workflow from the Activities menu and select a 
record.  Note that the values collected from four separate 
screens are displayed in one location.  Change the fields 
and then save the changes.  Then use the Lookup dialog to 
select the record and confirm that the changes have 
indeed been made across these screens.  Close the record. 

9. When using fields from a grid (such as Pay Rate and Next 
Review Date), you have the option of specifying any row 
in the grid.  For example, if you wanted to see the pay rate 
from the second row, or the next review date from the 
third row, you can do so.  Here’s how. 

10. Return to the Build Workflow dialog and select the “Pay 
Rate” field on the Address workflow.  Click on the Add 
button to start editing the field.  Skip over the field name 
and position the cursor to the “Modifier” field.  Enter a 
“2” and close the Field Information dialog.  Likewise, 
select the “Next Review Date” field and change the 
modifier to “3”.  Close and save the changes to the 
workflow. 

11. Open the Address workflow on the Activities menu.  Note 
that there is a number in parenthesis adjacent to the screen 
caption for the “Pay Rate” and “Next Review Date” 
fields.  This number indicates the respective row number 
from which the data will be retrieved and optionally 
restored if you make a change.  Select a record and make 
a change to the Pay Rate and the Next Review Date.  
Then save the changes and confirm them by selecting the 
record and checking the respective screens. 

12. Continue with the next tutorial. 
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Tutorial 24.2 
Create a New Workflow 
In the last tutorial we saw how to modify an existing workflow 
by deleting fields, changing field order, and adding fields.  In 
this tutorial, we will create a workflow from scratch.  Let’s get 
started. 

1. Select the Build Workflow option from the Tools menu. 

2. Position the cursor to the third workflow in the grid.  The 
name is “Workflow 3”.  Change the name from to “My 
Status Workflow”.  Then activate the workflow by 
checking the “Enabled” column.  Now let’s add some 
fields. 

3. Add the following fields to the workflow in the order 
shown (they are all from the Status screen). 
 
Active   
Status 
Status Date 
Secondary Status 
Status Comment 
On LOA 
Hire Date 
Seniority Date 

4. When complete, close and save the changes. 

5. Open the Activities menu.  Note that your workflow is 
now listed in the menu because it has been enabled.  
Select your new workflow and try it out by selecting an 
employee.  This workflow becomes a convenient way of 
reviewing and/or changing status information in one 
location without concern for the other fields on the Status 
screen.  This is just pure status information. 

6. Change the status information for the employee you have 
selected and save the changes.  Then, for the final time, 
confirm that the changes you have made in a workflow 
have been committed to the database and are visible on 
the Status screen.  When complete, close the record. 

7. Continue with the next tutorial. 

Tutorial 24.3 
Deactivate a Workflow 
A workflow can be deactivated at any time.  You might wish 
to do this when the workflow is undergoing changes or when 
the workflow is no longer needed.  You do not need to delete 
all of the fields in the workflow; you simply need to deactivate 
it.  Here’s how. 

1. Select the Build Workflow option from the Tools menu.  
Highlight the third workflow, the one you just created. 

2. Disable the workflow using the Enabled checkbox.  The 
workflow is disabled when the checkbox is not checked.  
Close and save the change. 

3. Open the Activities menu.  Now that the workflow has 
been disabled, it is no longer visible, even though nothing 
else was done to the workflow. 

4. Return to the Build Workflow dialog and enable the 
workflow again.  Close the Build Workflow dialog. 

5. This tutorial and this lesson are complete.  Exit People-
Trak. 
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Lesson 25 
Customization 1  

This lesson demonstrates some of the customization features 
in People-Trak including screen captions, field names, and 
edit attributes. 

Source Text 
People-Trak Basics – Chapter 19 

Tutorials 
Changing the Screen Caption: demonstrates how to change 
a screen caption on a data entry dialog.  Examples are 
provided for text boxes, check boxes, and grid headings. 

Changing the Field Name: shows how to change the name 
by which the field is identified in documents and templates. 

Changing Edit Attributes: demonstrates how modify field 
attributes such as length, case, and decimal places. 

Tutorial 25.1 
Changing the Screen Caption 
1. Start People-Trak and select the Personnel Module. 

2. Select the Field Customization option from the Tools 
menu.  The Field Customization dialog contains a combo 
box with a list of the screens in the Personnel module, a 
list box that contains the fields on the screen shown in the 
combo box and a collection of text boxes and checkboxes 
for viewing and recording information about the current 
field. 

3. Before we actually modify a field, let’s demonstrate some 
of the navigation features of the dialog.  First, change the 
screen name in the combo box from Personal to Status.  
Note that the list of fields displayed in the list box 
changes from those on the Personal screen to those on the 
Status screen.  Also note that the fields are listed in 
alphabetic order and not the order in which the fields 
actually appear on the dialog. 

4. Now open the combo box again.  Note that the screens are 
listed in the same order that they are listed in the Screens 
dropdown.  The sub-screens are listed after the primary 
screen name. 

5. Select the Personal screen again and close the combo box.  
Note that the first field in the list box is selected and that 
the field information for that field is displayed.  Select a 
different field and the field information is changed to 
reflect that field.  That is how you navigate between 
screens and fields.  Now’s let customize. 

6. Select the “Address 1” field on the Personal screen.  Then 
position to the Screen Caption field on the dialog.  Start 
by changing the screen caption to “Addr 1”.  Then use the 

Exit option on the File menu to close and save your 
changes. 

7. Open any record and display the Personal screen.  Find 
the field formally labeled as “Address 1” and note that it 
is now labeled “Addr 1”.  That is all it takes to customize 
a screen caption.  However, there are few more things to 
learn. 

8. Close the record   People-Trak is an integrated solution.  
Customization changes made to fields are reflected 
throughout People-Trak including workflows and batch 
processing programs.  Select the Address workflow from 
the Activities menu.  Note that the screen caption for the 
address field has been changed to reflect your recent 
customization.  If the address field were used in a batch 
processing program, the same result would occur.   

9. Close the workflow and return to the Field Customization 
dialog.  Select the Address 1 (or “Addr 1”) field and 
position the cursor to the Screen Caption field on the 
dialog.  Now, change the phrase “Addr 1” to “This is the 
field named Address 1” and attempt to leave the field.  
The message shown below is displayed 
 
The new caption is wider than the space allowed 

10. This message indicates that the caption you have specified 
will not fit in the space allowed.  If you look at the Field 
Customization dialog, which is similar to all other 
dialogs, you will note that there is specific amount of 
space between the left most edge of the text box itself and 
the edge of the frame or other component that is to the left 
of the text box.  If you specify a caption that will not fit in 
this space, the message shown above is displayed and 
your entry will be rejected. 

11. At this point, set the field back to the original value of 
“Address 1” and continue. 

12. Select the Status screen and then select the “Active” field.  
The “Active” field is a checkbox.  Let’s customize a 
checkbox.  Change the screen caption from “Active” to 
“Still Working”.  Then close and exit the dialog box.  
Select a record and position to the Status screen.  Note 
that the caption on a check box changes exactly like the 
caption on a text box.  The space limitations that apply to 
text boxes also apply to check boxes as well. 

13. Close the record and return to the Field Customization 
dialog.  Select the Status History screen and position the 
cursor to the Screen Caption field on the dialog for the 
“History Status Date” field.   

14. The Status History screen is a grid.  When you are 
changing the screen caption on a grid you are actually 
changing the column heading for that field on the grid.  
Let’s try it.  Change the screen caption from “Date” to 
“Status Date”.  Close and exit the dialog box.  Select a 
record and position to the Status History dialog (it is a 
subscreen on the Status screen).  Note that caption for the 
“Date” column has been changed to “Status Date”. 
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15. You have now seen how to change the screen caption for 
text boxes, checkboxes, and grid columns.  Now you’ll 
see how the screen caption you have learned to change 
interacts with the adhoc reports. 

16. When you select a field for use in an adhoc report, the 
caption that will be used for the report is the current value 
of the screen caption.  Let’s demonstrate this. 

17. Create an adhoc report containing two fields: “Full 
Name” and “Address 1”.  Give the report a name and 
category so you can find the report.  Do not add a query.  
Test the report and note that the caption for the “Address 
1” field is indeed “Address 1”. 

18. Using what you have just learned, change the screen 
caption for the “Address 1” field to something else.  Then 
return to the report you have just created run it again.  
There will be no difference; the screen caption when the 
report was created was “Address 1”.  That caption will 
remain with the report unless you change the caption 
using the Design Mode feature. 

19. Create a new report that uses the “Address 1” field.  Run 
the report and the screen caption will now be the new 
value.  This new caption will remain a part of this report 
unless you change it in Design Mode even if you do 
change the caption back to “Address 1” with the Field 
Customization dialog. 

20. Continue with the next tutorial. 

Tutorial 25.2 
Changing the Field Name 
The “Field Name” for a field is what you use when you 
reference the field in various places throughout People-Trak.  
For example, when you search for a field to use in an adhoc 
report, you look for the field, not the screen caption you 
learned about in the last tutorial. 

The field name can be changed when desired.  This is 
typically necessary when you change the use of a field (often 
including the screen caption) and need to look for the field by 
a name that reflects its use.  For example, if you change the 
“Payroll Number” field on the Personal screen to be used as 
the “Department Name”, you would change both the screen 
caption and the field name.  You would not want to select 
“Payroll Number” when you meant to use “Department 
Name”.  Let’s change a field name now. 

1. Select the Field Customization option on the Tools menu.  
Position to the Personal screen and select the “Payroll 
Number” field.  Change the field name and the screen 
caption from “Payroll Number” to “Dept. Name”.  Close 
the dialog and save the changes.  Then verify that the 
change has been made on the Personal screen.  Finally, 
return to the Field Customization dialog. 

2. Look for the “Payroll Number” field in the list of fields 
on the Personal Screen.  You will not find the field, 
because it’s name has been changed.  The field will now 
be listed as “Dept. Name” in appropriate alphabetic order 

on the screen.  This same thing will be true when you 
attempt to select fields for query or reporting.  

3. Close the Field Customization dialog and select the 
Lookup dialog.  Position to the Custom tab.  At “Field 
Name” use the popup to display the list of fields.  Scroll 
down the list of fields for the Personal screen.  The 
“Payroll Number” field will no longer be there; it has 
been changed to “Dept. Name” 

4. Close the Lookup dialog.  We will now see how these 
changes are reflected in adhoc reports. 

5. Open the report that you created in the prior lesson.  Add 
the Department Name field from the Personal screen to 
the report.  Test the report.  Note that the screen caption 
reflects the change.  Save the report and then return to the 
report.  Note that the field name is “Department Name”.  
Close the report. 

6. Use the Field Customization feature to change the field 
name and the screen caption back to “Payroll Number” 
and then return to this report.  What has happened to the 
field name?  It has been changed back to “Payroll 
Number”.  Reports and other documents actually save the 
field ID.  At the time the report is opened, the field ID is 
used to retrieve the current field name.  If you add a field 
to the report, the field name is displayed, but when the 
report is saved, the field ID is actually stored.  This 
feature enables you to change fields without concern for 
reports that have already been created. 

7. Run the report.  The screen caption is not changed 
because as we have demonstrated above, the screen 
caption does not change dynamically.  You must use 
Design Mode to change a caption once the field has been 
selected. 

8. Close the report and continue with the next tutorial. 

Tutorial 25.3 
Changing Edit Attributes 
Fields have a number of attributes such as length, edit criteria, 
and format.  In this tutorial, we will show how to change 
these. 

1. The most obvious attribute for fields is length.  The length 
for most fields can be either decreased or increased as 
desired.  Here’s how to do it. 

2. Select the “Address 1” field on the Personal screen for 
customization.  Change the field length from 25 to 30.  
Close and save the change.  Open a record and change the 
address to 30 X’s.  Close and save the record.  Return to 
the Field Customization dialog and change the field 
length back to 25.  Close and save the changes. 

3. The field that you entered at a length of 30 characters is 
not actually changed.  The 30 characters are still stored in 
the database just as you entered them.  However, if you 
select the record for editing, you will only see the first 25.  
To prove that the 30 characters are still there, change the 
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length of the “Address 1” field back to 30 and then open 
and verify the record.  You will note that your 30 X’s are 
still there even though the field length has been changed 
back and forth between 25 and 30. 

4. All fields have a maximum length.  You can change the 
length to a value greater than this maximum.  For 
example, the maximum length of the “Address 1” field is 
50.  If you try to set the length for this field to 51, you 
will receive an error and the new length will be rejected.  
You can take my word for it, or you can try it yourself. 

5. Another attribute that you can set is the case attribute.  
Text fields can have three different case attributes: none, 
proper case, and upper case.  By default, the “Address 1” 
field is set to “Proper Case”.  This means that the first 
character of each word is capitalized.  This is a typical 
setting for name and address fields.  However, let’s 
assume that you prefer to have this field set to “Upper 
Case”. 

6. Use the Field Customization dialog to change the Edit 
Attribute for the “Address 1” field from the “Proper 
Case” to “Upper Case”.  When complete, close and save 
the change.  Now, try it.  Select a record and position the 
cursor to the “Address 1”.  Enter any combination of 
upper and lower case letters.  Then press the ENTER key.  
Note that the entire text is converted to upper case.   

7. Close the record and return to the Field Customization 
dialog.  Change the case setting for the “Address 1” field 
to “None”.  Close and save the change and then try the 
feature in an employee record.  You will see that with the 
“None” attribute, the text is left just as you enter it.   

8. Close the record and return to the Field Customization 
dialog.  Select the Compensation screen and the “Change 
Amount”.  We’ll now learn about the formatting. 

9. Numeric fields have a format attribute that determines 
how the numeric data is displayed or printed.  The format 
is determined by a combination of the length of the field 
and the number of decimal places.  You can see the 
format for the “Change Amount” field in the “Format” 
field on the dialog. 

10. When you selected the “Change Amount” field, you may 
have noticed that the field labeled “Edit Attributes” was 
changed to ”Decimal Places”.  This change will always 
occur with numeric fields because numeric fields cannot 
have edit attributes, but they do have decimal places.  
Change the number of decimal places from 2 to 4.  Note 
that the format for the field switches from 9.2 to 7.4.  
Because you have not increased the length of the field, 
but you have increased the number of decimal places, the 
number of places to the left of the decimal are decreased.  
If you really need 9 places to the left of the decimal, you 
could increase the length of the field by 2.  Try it now if 
you like. 

11. Close and save your changes.  Select a record and 
position to the Compensation screen.  Note that the data 
in the “Change Amount” column is now displayed with 
four, rather than two, decimal places.  Close the record. 

12. As with all customization, these changes can be changed 
back or modified at any time.  In general, however, most 
customization is performed when People-Trak is initially 
implemented. 

13. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Notes 
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Lesson 26 
Customization 2  

This lesson demonstrates additional customization features 
such as changing table support, setting fields to “not used”, 
and setting fields to “mandatory”. 

Source Text 
People-Trak Basics – Chapter 19 

Tutorials 
Changing a Support Table: demonstrates how to change the 
support table that is used to assist data entry in a particular 
field.  Includes instructions for adding a user defined table to 
any field that does not yet have a table. 

Activating the ‘Not used’ Feature: shows how to make 
certain fields “not used”.  When a field is not used, it is 
complete removed from the data entry screen. 

Using ‘Mandatory’ Fields: demonstrates how to make 
certain fields “mandatory”.  When fields are mandatory, you 
cannot leave the field without keying a value.  In addition, you 
cannot leave the screen if the field has not yet been entered. 

Tutorial 26.1 
Changing a Support Table 
1. Start People-Trak and select the Personnel Module. 

2. Select the Field Customization option from the Tools 
menu.  Select the “Address 1” field on the Personal 
screen.  We will now see how to add a support table to a 
field that is not currently supported by a table. 

3. Position the cursor to the “Support Table” field on the 
dialog.  You will note that the field is blank because the 
“Address 1” field is not currently supported by a table.  
We will change that.  Use the popup button to display a 
list of tables.  Scroll the list and select “User Table 1”.  
Close and save the change. 

4. Select the Table Edit option from the Tables menu.  When 
the list of tables is displayed, select User Table 1 for 
editing.  Add the three lines shown below to User Table 1. 
 
100 Main Street 
1001 Maple Street 
202 Elm Street 

5. When complete, close and save the changes. 

6. Select a record and position to the “Address 1” field.  
Note that the field now has a table popup button because 
the field is supported by a table.  Open the table by 
clicking on the button.  You should see the three entries 
that you made.  Select one of the entries to complete the 
field. 

7. This example is an exaggeration; you cannot successfully 
support the “Address 1” field with a table.  However, it 
does demonstrate that any text field can be supported by a 
table, even if it does not make sense.  It also demonstrates 
the reason why there are user-defined tables.  You can use 
these extra tables to provide support where it was not 
originally designed.   Close the record. 

8. As we have discussed before, People-Trak is an integrated 
product.  Thus changes that are made to a field are valid 
in that field throughout People-Trak.  The table support 
that we added to the “Address 1” field is thus available in 
any workflow that uses “Address 1”.  Let’s demonstrate.   

9. Select the Address workflow option from the Activities 
menu.  Select a record using the techniques you have 
recently learned.  Then position to the “Address 1” field.  
Note that the field is supported by the user table in exactly 
the same way it is on the Personal screen.  This is 
powerful stuff. 

10. Clear and close the workflow. 

11. Use the Field Customization dialog to remove table 
support from the “Address 1” field.  When complete, 
select the “City” field.  By default, the “City” field is 
supported by the City table.  For demonstration purposes, 
let’s clear the support table for the “City” field and see 
what happens.  Close and save the change.  Open a record 
and position to the “City” field.  You will note that the 
field is no longer supported by a table at all.  Now return 
to the Field Customization dialog and make another 
change to the table support for the “City” field.  Change 
the supporting table to the Country table and then confirm 
that the feature works by selecting a record and trying it 
out. 

12. As you can see, you can support any text field with any of 
the available tables.  Or you can drop table support from 
any table by clearing the table for that field.  Before 
continuing with the next lesson, change the supporting 
table for the City field back to the City table. 

13. Continue with the next tutorial. 

Tutorial 26.2 
Activating the ‘Not Used’ Feature 
People-Trak provides a powerful feature that allows you to 
disable fields completely.  There are times when the 
organization will decide that certain fields will not be used at 
all.  Rather than leaving the fields on the data entry screens 
and skipping (or tripping over them), you can cause them to 
disappear.  Here’s how. 

1. Select the Field Customization option from the Tools 
menu.  Select the “User Text 1” field on the User Fields 
screen.  Position the cursor to the “Not Used” field on the 
dialog.  Click on the checkbox so that the box is checked.  
Now, repeat this step for the “User Text 3”, “User Date 
5”, and “User Dollar 7” fields.  Close and save the 
changes. 
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2. Select a record and position to the User Fields screen.  
You will note that the fields you set to “not used” are 
gone from the screen just as if they do not exist.  These 
fields are not only gone from the screen, they are gone 
everywhere else.  I’ll show you. 

3. Close the record and select the Lookup dialog.  Position 
to the Custom tab.  At the “Field Name” field use the 
popup button to display the list of fields from which you 
can select.  Select the User Fields screen.  Look for the 
fields that you disabled.  Do you see them?  No.  They are 
gone.   

4. Abandon the Lookup and create a new adhoc report.  Try 
to select one of these fields for a report.  You cannot, 
because they are gone. 

5. If there is data stored in a field that you disable, the data is 
not lost.  The underlying data structure in the database is 
unchanged; you have merely caused the field to be 
invisible.  Let’s demonstrate this fact. 

6. Select a record and enter a value into the “User Text 2” 
field for that record.  Close the record and use the Field 
Customization dialog to set that field to “Not Used”.  
Close and save the customization.  Now open the record 
again and position to the User Fields screen.  The field is 
gone, but is the data?  Use the Field Customization dialog 
to reactivate “User Text 2”.  Then return to the employee 
record and see what appears.  The field and the data are 
both back.  Close the record and continue. 

7. We demonstrated this feature using the somewhat obscure 
“user” fields for a reason.  The reason is that you cannot 
set a field to “not used” if that field has been used in a 
document, workflow, or other type of specification.  In 
essence, you cannot stop using a field that you are indeed 
using.  I’ll show you what I mean. 

8. Return to the Field Customization dialog and attempt to 
disable the “Address 1” field.  You will receive a message 
that indicates that the field is used in a number of 
documents and templates.  If you wish to disable this 
field, you need to remove it from those documents and 
templates first.  (We won’t bother to demonstrate that.) 

9. Continue with the next tutorial. 

Tutorial 26.3 
Using ‘Mandatory’ Fields 
People-Trak provides another powerful feature that allows you 
to cause specific fields to be “mandatory”.  When a field is 
made “mandatory”, you cannot leave the field without 
providing a value and you cannot leave a screen that uses that 
field without providing a value.  Here’s how it works. 

1. Select the Field Customization option from the Tools 
menu.  Select the “Address 1” field on the Personal 
screen.  Position the cursor to the “Mandatory” field on 
the dialog.  Click on the checkbox so that the box is 
checked.  Close and save the change. 

2. Select an employee and position to the “Address 1” field.  
Clear the field and then press the ENTER key.  What 
happens?  The message shown below is displayed. 
 
This is a mandatory field that must be entered. 

3. Mandatory fields are mandatory.  You must supply a 
value or you cannot leave the field.  You may be thinking 
that you can fool People-Trak.  You are thinking that you 
will just click on the Close button and close the record 
and bypass the feature.  Try it.  Then go ahead and try to 
select another record or another screen or a popup.  By 
now you understand, mandatory fields are … mandatory. 

4. Now before you decide to reboot the computer to get past 
this annoying feature, simply enter “XXX” into the field 
and continue.  There are more things to learn.  Close the 
record so that we can see what happens with new records. 

5. Start a new record by selecting the New button on the 
Tool bar.  Enter an employee ID and a few other fields, 
but DO NOT position to the “Address 1” field.  Now, try 
to save the record.  Do you think you can sneak by that 
mandatory field lurking below?  The answer is NO.  The 
message shown below is displayed. 
 
The following field is mandatory, but has not been 
completed: 
Address 1 

6. When you click on the OK button to acknowledge the 
message, the cursor is placed right into the “Address 1” 
field.  You know what happens now.  You do not get out 
of this field, you do not pass GO, and you do not collect 
200 dollars unless you provide a value.  Enter “XXX” and 
close the record. 

7. As you might have guessed, the mandatory attribute will 
apply when the field is used within a Workflow.  Let’s try 
this… for fun. 

8. Select the Address workflow from the Activities menu.  
Select a record.  Now, clear the “Address 1” field and 
attempt to move to the next field.  You will see the same 
message and be caught in the same dilemma.  Enter 
“XXX” and close the workflow.  You get the point. 

9. Mandatory fields work exactly as advertised and should 
be used with discretion.  To save yourself further grief, 
use the Field Customization dialog to change the 
“Address 1” field back to non-mandatory. 

10. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 27 
Scheduler 1 

This lesson shows how create, run, modify, and delete 
scheduled items. 

Source Text 
People-Trak Basics – Chapter 20 

Tutorials 
Create a Scheduled Item: demonstrates how to create and 
then activate a scheduled item. 

Modify a Scheduled Item: shows how to select a sub-screen 
from a primary data entry screen and to subsequently exit the 
screen either saving or abandoning any changes made on the 
sub-screen. 

Delete a Scheduled Item: demonstrates how the data 
validation features work to prevent invalid data from being 
saved to the underlying People-Trak database. 

Tutorial 27.1 
Create a Scheduled Item 
1. Start People-Trak and select the Personnel Module. 

2. Select the Scheduler option from the Tools menu or use 
the Scheduler button on the Tool Bar.  The Task 
Scheduler dialog is displayed.  This dialog is used to 
create and manage items that you have scheduled.  Items 
are initially scheduled with the “new item” wizard.  Let’s 
try it. 

3. Click on the New button on the Tool Bar or use the New 
Task option on the File menu.  The first panel in the New 
Task wizard is displayed.  This panel is purely 
informational.  Click on the Next button to move to the 
next panel. 

4. This panel is used to specify the type of task that is to be 
scheduled.  There are three options: programs (menu 
options), documents, and reminders.  For this first item, 
click on the Reminder radio button and press the Next 
button. 

5. The panel that is displayed when you click on the Next 
button from the “type of item” panel differs depending on 
the type of task.  For a reminder, the panel provides fields 
to record the name and text of the reminder.   

6. Enter the reminder name “My reminder”.  Then enter the 
reminder text: “this is my reminder”.  Then press the Next 
button to move to the next panel. 

7. This panel is used to specify the frequency with which 
this task is to be performed.  There are a variety of 
options that have been explained in the narrative.  For 
demonstration purposes, select “Daily” and then record 

today’s date in the “Start Date” field.  Click on the Next 
button to move to the next panel. 

8. This panel is used to specify how you want this item to 
run.  There are two ways.  You can run the item from the 
inbox whenever you want, or you can be reminded to run 
the item when you login to the module.  Accept the 
default entry “on demand” and press the Finish button to 
complete the creation of the item. 

9. When the item is complete, the entry will now appear in 
the Task Scheduler dialog.  This entry is NOT the actual 
reminder.  This is the template that determines when the 
reminder should be issued and what the reminder is 
supposed to say. 

10. Scheduled items appear in the Inbox on the day they are 
scheduled.  If an item is scheduled daily, it will appear 
daily.  We scheduled a reminder to be shown daily.  Let’s 
check the Inbox and see if it appears. 

11. Use the Inbox icon on the Tool bar or the Inbox option on 
the Tools menu to activate the Inbox.  When the Inbox 
dialog is displayed, the reminder we just created is listed.  
We’ll learn about the Inbox in a later lesson.  For now, 
highlight the reminder and click on the Run button.  The 
reminder will be displayed.  Close the reminder and note 
that the reminder has now been labeled “Completed”. 

12. Close the Inbox and then reopen it.  Note that the 
reminder we created is no longer listed because it has 
already been run today.  The reminder will appear again 
tomorrow and the day after because it was scheduled to 
run daily. 

13. Another type of task to schedule is a program (or menu 
option).  Start the Task Scheduler and start the New Task 
wizard.  Skip over the first panel.  On the second panel, 
select “Program” and continue to the next panel.  On this 
panel, you will see a list of the menu options that are 
available for scheduling.   

14. Select the Address workflow that we have used in prior 
lessons.  Move to the next panel and schedule the 
workflow to be run monthly starting today.  Finally move 
to the last panel, schedule the workflow to run “on 
demand” and press the Finish button to complete the task.  
When complete, the program will appear in the Task 
Scheduler dialog. 

15. Close the Task Scheduler and check the Inbox again.  
Because this workflow was scheduled monthly starting 
today, it will show up today.  

16. Now close the Inbox without running the task and 
continue with the next tutorial. 
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Tutorial 27.2 
Modify a Scheduled Item 
Scheduled tasks are not permanent; you can change them if 
needed.  In this tutorial we will show you how. 

17. Select the Scheduler option from the Tools menu or use 
the Scheduler button on the Tool bar.  When the Task 
Scheduler dialog is displayed, highlight the reminder that 
we created and ran in the last tutorial.   

18. Use the Open button on the Tool Bar or the Open Task 
option on the File menu to display the Task Properties 
dialog.  This dialog can be used to change schedule 
properties.  The first tab is informational and merely 
identifies that you have chosen the right task.  Select the 
second tab. 

19. The second tab shows the current schedule information 
including the frequency and start date.  At this point, the 
start date does not actually show the date when you first 
scheduled the item; it shows the date when the item is 
scheduled next.   You can change this date to reset the 
date when the item will run again.  Let’s try it.   

20. Change the start date to today. Close and save the changes 
and then close the Task Scheduler. 

21. Open the Inbox and the reminder will be shown again 
because the date has been reset for today.  Run the 
reminder and then close the Inbox.  Open the Inbox again 
and the reminder will be gone. 

22. Return to the Task Scheduler and reset the date back to 
today.  Return to the Inbox and the reminder will be back 
again.  Close the Inbox. 

23. You can modify more than the next start date using the 
Task Properties dialog.  You can actually change the 
entire schedule.  Let’s do that now. 

24. Start the Task Scheduler and select the reminder for 
editing.  On the second tab, change the frequency from 
“Daily” to “Monthly”.  Set the starting date to any future 
date and change the task from “on demand” to “at login”.  
Close and save the changes.  We have completely 
modified the task. 

25. You cannot change the text of the reminder.  If you need a 
different reminder, you can delete the current one and 
create a new one. 

26. Continue with the next tutorial 

Tutorial 27.3 
Delete a Scheduled Item 
In the last two tutorials, we have seen how to create and 
modify scheduled tasks.  Our task scheduler is now littered 
with unneeded tasks.  Let’s delete them. 

1. Start the Task Scheduler and highlight the reminder task 
that we created in the first tutorial.  Use the Delete button 
on the Tool Bar or the Delete Task option on the File 
menu to delete the task. 

2. If those instructions were not explicit enough, repeat them 
again for each of the tasks that you created.  When the 
tasks are all deleted, close the Task Scheduler dialog. 

3. Scheduled tasks are added to the Inbox dynamically when 
the Inbox is displayed.  If you open the Inbox in the 
morning and see a scheduled document, but do not run it, 
that document will not appear if task template is deleted 
before you do run the document. 

4. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 28 
Scheduler 2 

This lesson shows how create, run, modify, and deleted 
scheduled items. 

Source Text 
People-Trak Basics – Chapter 20 

Tutorials 
Schedule a Document: shows how to schedule and run a 
document. 

Running an Item ‘At-Login’: demonstrates how the “at 
login” feature is used with scheduled items. 

Schedule with Document Explorer: shows how to schedule 
a document using the Document Explorer. 

Tutorial 28.1 
Schedule a Document 
In the last lesson, we scheduled both a reminder and a 
program.  Now, let’s schedule a document.   

1. Use the New button to start the new task wizard.  Skip 
over the first panel.  On the second panel, select 
“Document” and continue to the next panel.  On this 
panel, you will see a list of documents.  The documents 
are listed alphabetically within category.  

2. Find a meaningful report and select it.  Then, move to the 
next panel and schedule the document to be run weekly 
starting today.  Finally, move to the last panel, accept the 
default “on demand” and press the Finish button to 
complete the task.  When complete, the document will 
appear in the Task Scheduler dialog. 

3. Close the Task Scheduler and check the Inbox.  Because 
this document was scheduled weekly starting today, it 
will show up today.  If we run it today, it will not show up 
again for a week.  If we do not run it, it will show up each 
day until it is run.   

4. Run the document.  The document is created and 
displayed in the Document Viewer just as if it were run 
from either the Document Explorer or the Adhoc Reports 
dialog. 

5. Close the Document Viewer and note that the Inbox entry 
is now labeled “Completed”. 

6. Close the Inbox.  Select the Scheduler and delete the 
document item we just scheduled.  Close the Scheduler. 

7. Close the Inbox and continue with the next tutorial. 

Tutorial 28.2 
Running an Item ‘At Login’ 
In the prior tutorials, we have been running scheduled  items 
on demand from the Inbox.  Scheduled items can also be 
scheduled to run when you login.  We’ll demonstrate that 
now. 

1. Use the Scheduler to create and schedule a reminder.  Set 
the reminder to run daily and have it start today. 

2. On the final tab, check the box marked “at-login” to cause 
this reminder to be available at the time you login. 

3. Close the Task Scheduler and check the Inbox again.  
Because this workflow was scheduled daily starting 
today, it will show up today.  Now close the Inbox 
without running the task and we’ll demonstrate how “at 
login” tasks work. 

4. Use the Exit Module option on the File menu to close the 
Personnel module.  From the Select Module dialog, select 
the Personnel module again.  Because we have a pending 
“at login” item, a message similar to the one shown below 
is displayed. 
 
Task “Address’ has been scheduled to execute at 
login.  Execute task now? 

5. Click on the No button to skip the task for now.  A 
message indicating that the task was not executed will be 
displayed. 

6. Open the Inbox and check for the reminder.  It is there 
juat as before because it has not been executed for today. 

7. Close the Inbox and exit the Personnel module. 

8. From the Select Module dialog, select the Personnel 
module.  When the task message is displayed this time, 
press the Yes button to execute the tasks.  The reminder 
you created will be displayed.  If there other “at login” 
tasks, these too would be presented for execution one 
after another until all tasks are either completed or 
skipped. 

9. Open the Inbox and look for the reminder.  It does not 
appear because the task has already been executed today.   

10. Close the Inbox and continue with the next tutorial. 
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Tutorial 28.3 
Schedule with Document 
Explorer 
Documents can also be scheduled for automated execution 
using the Document Explorer.  This is how to do it. 

1. Start the Document Explorer from the Documents Menu. 

2. Highlight a document to be scheduled. 

3. Press the Properties button or the Document Properties 
option on the File Menu to display the Document 
Properties dialog.  

4. Select the Schedule tab. 

5. Select the daily frequency and set the start date to today’s 
date. 

6. Leave the “at-login” box unchecked. 

7. Close and save the document properties.  Close the 
Document Explorer. 

8. Open the Scheduler.  Note that the document you 
scheduled is listed just as if it had been recorded with the 
Scheduler.  The schedule can be changed or the item 
deleted. 

9. Close the scheduler and open the Inbox.  Because the 
document was scheduled daily starting today, the item is 
listed in Inbox.  Go ahead and run the report.  Again, the 
scheduled document runs just as before.   

10. Close the Document Viewer.  Then close the Inbox.  
Open the Scheduler and delete the scheduled document. 

11. Close the Scheduler and start the Document Explorer.  
Locate the document for which the schedule was just 
deleted.  (The document was not deleted, only the 
schedule for that document).   

12. Open the Document Properties for that document.  Note 
that the schedule is gone.  It was deleted when the item 
was deleted from the Scheduler. 

13. Close the Document Properites dialog.  Close the 
Document Explorer. 

11. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 29 
Alerts  

This lesson demonstrates the techniques used to create and test 
new alerts and to modify and delete existing alerts. 

Source Text 
People-Trak Basics – Chapter 21 

Tutorials 
Create and Test a New Alert: demonstrates how to create a 
new alert and how to view the alerts when they are triggered. 

Modify an Alert: shows how to modify an existing alert.  

Delete an Alert: shows how to delete an alert when it is no 
longer needed. 

Tutorial 29.1 
Create and Test a New Alert 
1. Start People-Trak and select the Personnel Module. 

2. Select the Set Alerts option from the Tools menu or use 
the Alerts button on the Tool Bar.  The Alerts Builder 
dialog is displayed.  This dialog is used to create and 
manage alerts.  Alerts are with the “new alert” wizard.  
Let’s try it. 

3. Click on the New button on the Tool Bar or use the New 
Alert option on the File menu.  The first panel in the New 
Alert wizard is displayed.  This panel is purely 
informational.  Click on the Next button to move to the 
next panel. 

4. This panel is used to specify the name of the Alert and the 
message that will be displayed when the Alert is 
triggered.  For the alert name, enter “Birthday Alert”.  For 
the alert message, enter: “Happy Birthday”.  When the 
entries are complete use the Next button to move to the 
next panel. 

5. This panel is used to specify the date upon which the alert 
will be based.  Locate and highlight the Birth Date field.  
Then click on the Next button to move to the next panel. 

6. This panel is used to specify the type of alert.  Different 
types of alerts are used for different dates.  Because the 
birth date happens just once, but it has an anniversary 
each year, select the “Anniversary Of” type.  Click on the 
Next button to move to the next panel. 

7. This panel is used to indicate how many days in advance 
of the actual date you wish to be notified.  For our initial 
test, leave the field blank and move to the next panel.  

8. This panel is used to indicate if emails are to be sent.  
There are three options.  You can send email to yourself 
(the user), you can send email to the employee, and you 
can send email to the employee’s supervisor.  For our test, 

select the employee and the supervisor.  In this way, the 
employee will receive a “Happy Birthday” email and the 
supervisor will notified that there is a birthday in his or 
her department.  Press the Finish button to complete the 
creation of the alert. 

9. When an alert is complete, the entry will now appear in 
the Alert Builder dialog.  This entry is NOT the actual 
alert.  This is the template that is used when creating the 
alerts when the alerts are triggered. 

10. Alerts appear in the Inbox on the day they are triggered.  
Emails, if specified, are also sent when the alert is 
triggered.  Unlike scheduled items, alerts are not triggered 
when the Inbox is opened.  They are triggered when you 
start People-Trak.  Queries are executed to determine if 
there are any alerts.  If an alert is triggered, an alert 
message is added to the Inbox.  Let’s show how this 
works. 

11. Close the Alert Builder dialog.  Select an employee such 
as Donald Stern and change the birth date to a year in the 
past that has the same month and day as today.  This will 
cause the alert to be triggered today.  Close the record. 

12. Close the Personnel module and exit People-Trak.  Now 
start People-Trak again.  During startup, the People-Trak 
will check to see if any birthdays have anniversary dates 
today (according to the alert we just created).  In the 
future, when you have created other alerts, these will be 
checked according to their specific criteria.  When the 
alerts have been checked and triggered, the Select Module 
dialog will be displayed as usual.  If alerts or scheduled 
items have been detected, there will be a scheduler icon 
added to the module.  There should be one there now. 

13. Select the Personnel module and open the Inbox.  There 
should be an alert present for Donald Stern because today 
is the anniversary of the birth date you entered.  Highlight 
the alert and press the Run button to display the alert.  
The alert will include the name and ID of the employee, 
the alert name, and the alert message. 

14. When this alert was triggered during startup, emails were 
automatically generated for the employee and for the 
employee’s supervisor.  The emails are not sent when the 
Inbox is opened and the alert displayed.   
 
Note: The email feature can only work if email addresses 
have been entered for the employee and for the 
employee’s supervisor.  In addition, the employee’s 
supervisor must be specified in the Supervisor ID field on 
the Job Detail screen.  Otherwise, the manager’s email 
cannot be derived. 

15. Close the Inbox and open it again.  The alert is no longer 
present.  A birthday alert for this employee will not 
appear again for another year.  If you exit People-Trak 
and return, this alert will not run again because the alert 
template stores the fact that the alert has been run today 
already.   

16. You can create a wide variety of alerts.  Let’s demonstrate 
one more type.  Return to the Alert Builder dialog and 
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start the “new alert” wizard.  Name the alert 
“Performance Review Due”.  Set the text of the alert 
message to: “A performance review is due shortly for this 
employee”. 

17. Move to the next panel and base the alert on the Next 
Review Date field.  Move to the next panel and set the 
alert type to “Days Before”.  Then set the number of days 
to “7”.  

18. Move to the next panel and leave the advance notification 
blank.  Move to the next panel and cause an email to be 
sent to the manager only.  Click on the Finish button to 
complete the alert. 

19. This alert can now be used to notify HR of a pending 
performance review and to generate an email to the 
supervisor that a review is due.  Note that there is no 
communication generated for the employee; in this alert, 
it is not required. 

20. The next time you start People-Trak, this alert will check 
for performance reviews that meet the criteria.  If an 
employee has an alert seven days away, an email and alert 
will be generated.  There is no time to demonstrate this.  
Just take my word for it. 

21. Continue with the next tutorial. 

Tutorial 29.2 
Modify an Alert 
Alerts are not permanent; you can change them if needed.  In 
this tutorial we will show you how. 

1. Select the Alerts option from the Tools menu or use the 
Alerts button on the Tool bar.  When the Build Alerts 
dialog is displayed, highlight the birth date alert we 
created in the last tutorial.   

2. Use the Open button on the Tool Bar or the Open Task 
option on the File menu to display the Alert Properties 
dialog.  This dialog can be used to change anything about 
the alert. 

3. For example, if you want to receive an email as a user of 
People-Trak when the birth date alert is triggered (in 
addition to the Inbox notification), you could check the 
box for “Email User”.  Or, you could change the message 
to make it more meaningful for the email recipients. 

4. Let’s change the alert message.  Position to the field and 
move the cursor to the end of the line.  Add three 
exclamation points to the message to highlight our 
excitement about the employee’s birthday.  Close the 
Alert Properties dialog.  The changes are permanently 
saved with the alert template. 

5. These changes take effect the next time an alert is 
generated.  If  there are alerts already residing in the 
Inbox, they will not be modified. 

6. Continue with the next tutorial 

Tutorial 29.3 
Delete an Alert 
In the last two tutorials, we have seen how to create and 
modify alerts.  Our alert builder contains alerts that we do not 
want.  Let’s delete them. 

1. Start the Alert Builder and highlight the birth date alert 
that we created in the first tutorial.  Use the Delete button 
on the Tool Bar or the Delete Alert option on the File 
menu to delete the alert. 

2. If those instructions were not explicit enough, repeat them 
again for the other alert we created.  When the alerts are 
all deleted, close the Alert Builder dialog. 

3. If alerts have been added to the Inbox and you then delete 
the alert template, the alerts that have been generated are 
not deleted.  Alerts that have already been generated will 
be removed from the Inbox after they have been viewed. 

4. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 30 
Inbox  

This lesson demonstrates how to use the inbox to display 
items, postpone items, and to show tasks for the current user 
or for all users.  It also shows how to run scheduled items, 
view alerts, and reactivate postponed batches. 

Source Text 
People-Trak Basics – Chapter 22 

Tutorials 
Using Inbox Features: demonstrates how to use Inbox 
features such as showing daily or weekly items, postponing an 
item, and showing all tasks or only those tasks assigned to 
yourself. 

Run Scheduled Items: shows how to run a scheduled items 
and alerts that appear in the Inbox. 

Reactivating a Postponed Batch: shows how to reactivate a 
batch that has been postponed and is now listed in the Inbox. 

Tutorial 30.1 
Using Inbox Features 
1. Start People-Trak and select the Personnel Module. 

2. Start a Performance Review batch and then postpone it.  
Give the batch a meaningful name. 

3. Create a new Birth Date alert to replace the one we 
deleted.   

4. Schedule any document to be run daily starting today. 

5. Schedule another document to run tomorrow. 

6. Now that we have plenty of items for demonstrating the 
Inbox, open the Inbox.  By default, in the Demo version 
of People-Trak, the caption for the dialog box will 
indicate “Department Inbox for Today’.  This means that 
Inbox items are being shown for all users in the HR 
department.   

7. Click on the button labeled “My Tasks”.  The following 
will occur.  The button caption will change to “All 
Tasks”, the dialog caption will change to “My Inbox for 
Today”, the “User” column will be removed, and the list 
of items in the Inbox will include only your items.  Click 
the button again (it is now labeled “All Tasks”) and the 
changes will be reversed.  This feature allows senior HR 
staff members to make certain that all scheduled tasks and 
other Inbox items are being performed. 

8. The ability to show items for all users is a security 
feature.  It can be enabled or disabled for the desired 
users.  It is enabled for the DEMO user and thus you can 
see items for the entire department.  Let’s disable the 
feature now. 

9. Close the Inbox and select the Security Setup option from 
the Administration Menu.  On the General tab for the 
DEMO user, deactivate the “Show All Users in the 
Inbox” feature.  Close and save this change.   

10. Open the Inbox again and you will see that you are now 
limited to seeing your Inbox items only.  The “My 
Tasks/All Tasks” button has been removed.  Close the 
Inbox and reset the “all users” feature.  Then open the 
Inbox again. 

11. There are two ways to activate Inbox items.  You can 
highlight the item and click on the Run button (this was 
demonstrated in earlier lessons), or you can just double-
click the item.  Run the document that you scheduled for 
today by double-clicking.  Close the Document Viewer 
when you have finished viewing the document.  Note that 
the item is now labeled as “Completed”. 

12. Close the Inbox and then reopen it.  The completed item 
is gone. 

13. The Inbox can be used to view items for today or for the 
entire week.  Click on the “This Week” button.  The list 
of items will be updated to include those that are 
scheduled later in the week.  Because we scheduled a 
document for tomorrow, that document should show up 
now.  In addition, the document scheduled to run daily 
that was already run today should show up for tomorrow.  
Finally, the button name will be changed to “Today”. 
 
Note: Remember that Alerts are generated when you start 
People-Trak.  Setting the Inbox to look forward will NOT 
show alerts that would be scheduled later in the week.  

14. Click on the button again (now named “Today”) to restore 
the list to the items listed for today.  The “This 
Week/Today” button is available to all users at all times. 

15. To demonstrate another feature, show the items for the 
entire week again.  This time, highlight (but do not run) 
the document that was originally scheduled to run 
tomorrow.  Click on the Postpone button and reschedule 
the document to run today.  Now close the Inbox and 
reopen it.  The document now shows up for today.  Show 
the items for the whole week and you will see that it is no 
longer scheduled for tomorrow. 

16. Any item can be postponed at any time.  You can 
postpone forward or backward.  If you postpone 
backward prior to today, the item will show up for today 
because the Inbox will simply assume that the date was 
missed.   

17. Close the Inbox and continue with the next tutorial. 
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Tutorial 30.2 
Run Scheduled Items 
In prior lessons, you have seen how to run scheduled items 
and how to view alerts.  In this tutorial, we will demonstrate 
this feature one more time. 

1. Open the Inbox and select one of the scheduled 
documents.  Double-click on the document to run it.  The 
report is run just as if it were selected from the Document 
Explorer.  Once the Document Viewer is displayed, you 
can treat the document just as if it were run from the 
Document Viewer.  This means that you can export the 
document to any of the output options or you can email 
the document to whomever you wish. 

2. When you close Document Viewer, the Inbox is 
redisplayed and the scheduled item is set to “Completed”. 

3. Now double-click on the alert that was generated for 
Donald Stern.  The alert message dialog is displayed.  
View the alert and be happy for Donald.  Then close the 
dialog and return to the Inbox.  Again, the alert is set to 
“Completed”.   

4. Close the Inbox and then return.  Note that all completed 
items have been removed from the Inbox. 

Tutorial 30.3 
Reactivating a Postponed Batch 
In the first lesson on Batch Processing, you were shown that 
you could postpone a batch for later processing.  (You were 
asked to do this at the start of this lesson.).  Knowing that 
postponed batches could be easily forgotten, we have chosen 
to add them to your Inbox.  Postponed batches show up in 
your Inbox just as soon as you postpone them.  There is not 
“alert date” or “scheduled date”.  The batch that you 
postponed earlier should have already appeared.  Let’s find 
out. 

5. Open the Inbox.  You should see the batch you postponed.  
Reactivate the batch by double-clicking on the Inbox 
item.   

6. The Performance Batch processing program is displayed 
just as if you selected it from the Processing menu. The 
batch itself is displayed just as if you had keyed. 

7. Now that the batch has been displayed, you can post it.  
Post the batch now and review the audit trail.  Close the 
Document Viewer.  When the Inbox is displayed, the item 
will be set to “Completed”.  That is all there is to it. 

8. If you reactivate a batch and attempt to leave the batch 
without posting it, it will be assumed that you wish to 
abandon the batch.  If you abandon the batch, it will be 
deleted even though you postponed it earlier.  If you enter 
a postponed batch and wish to keep the entries without 
posting, you need to postpone the batch again.  If you do 
this, there will be only one postponed batch in your Inbox, 
the new one. 

9. This tutorial and this lesson are now complete.  Exit 
People-Trak. 
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Lesson 31 
User Preferences  

This lesson describes the techniques used to create and 
maintain the user records for the users who access People-
Trak. 

Source Text 
People-Trak Basics – Chapter 23 

Tutorials 
Setting Data Entry Preferences: shows how to set data entry 
preferences. 

Changing Screen Order: shows how to change the screen 
order. 

Changing Report Preferences: demonstrates how to set and 
use the report default preferences. 

Tutorial 31.1 
Setting Data Entry Preferences 
People-Trak provides a number of data entry preferences that 
can be defined for each user.  These preferences include 
colors, sounds, and user interface features.  Here’s how you 
can change them. 

1. Select the User Preferences option on the Tools Menu.  
You should be editing the record for the DEMO user that 
you used to initially logon. 

2. Position the cursor to the Normal Color field.  Use the 
popup to change this color to green.  Likewise, change 
Modified Color to magenta and the Mask Color to gray.  
Close the User Setup dialog to save the changes. 

3. Start User Preferences dialog again and note that the 
settings have taken effect.  While these settings may seem 
“odd” to you, remember that each user has their own 
preferences and one person’s “odd” is another person’s 
“wonderful”. 

4. Before screaming, set the colors back to Blue, Red, and 
Yellow (or your personal preferences) and exit the User 
Setup dialog to save the changes. 

5. Start the User Setup dialog again and position to the 
“Enable Sound” field.  For PC’s with sound, this field is 
used to activate or deactivate the beep that emanates from 
People-Trak when data entry errors are found or when 
messages are displayed.  Many people do not like the 
beep, some do.  You can check the box accordingly. 

6. Position the cursor to the Classic Interface field.  This 
field determines if text boxes (stand alone and in grids) 
are to be treated in the Windows way or in the People-
Trak Classic Interface way.  At this point, the box should 
be checked.  As you move the cursor around, you will 

note that with the classic interface, the background color 
is set and the entry in the field is not pre-selected. 

7. Change the interface to the Windows standard by setting 
the check box.  Close the User Setup dialog to save the 
change. 

8. Return to the User Preferences dialog and you can see 
how the Windows interface works.  As you move the 
cursor from field to field, there is no background color 
and the contents of the field are pre-selected.  If you touch 
a key when the contents are pre-selected, the contents are 
replaced with the key you pressed.  This scares people 
and this is why the classic interface was developed.  It is a 
better way to meet the heavy data entry requirements of a 
personnel management product. 

9. Reset the classic interface to the People-Trak way and 
close the User Preferences dialog. 

10. Continue with the next tutorial. 

Tutorial 31.2 
Changing Screen Order 
In an earlier lesson, you learned how to set the screens that 
would be available to all users within the current module.  
From that list, any user can determine the screens they wish to 
see and the order in which they will be listed and displayed.  
This is how it works. 

1. Use the Open Employee feature to open the record for 
Donald Stern.  Review the Screens drop-down and note 
the number of screens present and the order.  The number 
of screens should reflect those screens made available 
with the Module Setup dialog and the order should be the 
order in which the screens appeared in the Module Setup 
dialog.  Close the record for Donald Stern. 

2. Select the User Preferences option on the Tools Menu.  
You should be editing the record for the DEMO user that 
you used to initially logon.  Position the cursor to the 
Screens tab.   

3. The first thing we will learn about is turning screens off.  
Use the checkbox feature to disable four or five screens.  
Then close the User Preferences dialog. 

4. Select Donald Stern for editing and review the Screens 
dropdown.  The list of screens has been reduced to reflect 
the changes you made.  Close the record for Donald Stern. 

5. Select the User Preferences option and position to the 
Screens tab.  Reactivate the screens that you just disabled.  
In addition, change the order of the screens using the Up 
and Down buttons.  When you have completely 
scrambled the order of the screens, close the User Setup 
dialog. 

6. Select Donald Stern for editing and review the Screens 
dropdown. The list of the screens and the order should 
reflect the changes you just made.  This feature is very 
useful for those users who do not need to start with a 
specific screen or who do not need to see certain 
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information (by their personal discretion).  For example, a 
benefits coordinator may wish to start with the Benefits 
screen, or a training coordinator may wish to start with 
the training screen.  Close the record for Donald Stern. 

7. Select the User Preferences option and position to the 
Setup tab.  Correct the mess you made of the Screens 
using the Defaults button.  The list of screens will be reset 
to that defined by the Default user.   

8. Close the User Preferences dialog and continue with the 
next tutorial. 

Tutorial 31.3 
Changing Report Preferences 
Report preferences are used to set the defaults when adhoc 
reports are first created.  When the defaults are set as desired, 
the process of creating an adhoc report as desired is greatly 
simplified. 

1. Select the Document Explorer option from the Documents 
menu.   

2. Start a new document using the New Document option on 
the File Menu or the New Document button on the 
Toolbar.  You will be shown a list of document types.  
Select the Adhoc Report type.  The Adhoc Report dialog 
is displayed.  This dialog will be reviewed in detail in 
subsequent lessons.  The purpose of this visit to the dialog 
is to merely review the default settings. 

3. There are default settings for the last four fields on the 
Specification tab.  These defaults are set with the User 
Setup program.  The other defaults pertain to fonts and 
font colors. 

4. Position to the Report Definition tab.  Use the button to 
select a field for the report.  Use the Full Name field from 
the Derived category. 

5. Use the Run option on the File Menu or the Run button on 
the Toolbar to run the report.  Note that the fonts and font 
colors match the defaults set with the User Setup 
program.  Also the defaults for orientation (portrait), 
double-space (off), grid lines (off) and auto-format (on) 
can be seen.  Close the Document Viewer.  Close the 
Adhoc Report dialog.  Close the Document Explorer. 

6. Select the User Preferences option on the Tools Menu.  
You should be editing the record for the DEMO user that 
you used to initially logon.  Position the cursor to the 
Report Format tab. 

7. Change the color of the heading font from blue to red.  
Change the color of the body font from blank to green.  
Finally, change the settings for double-space and grid 
lines from “Off” to “On”.  Close the User Preferences 
dialog. 

8. Select the Document Explorer option from the Documents 
menu.   

9. Start a new document using the New Document option on 
the File Menu or the New Document button on the 
Toolbar.  You will be shown a list of document types.  
Select the Adhoc Report type.  The Adhoc Report dialog 
is displayed. This time, the defaults are different. 

10. Position to the Report Definition tab.  Use the button to 
select a field for the report.  Use the Full Name field from 
the Derived category. 

11. Use the Run option on the File Menu or the Run button on 
the Toolbar to run the report.  Note that the fonts, double-
space, and grid lines settings now reflect the new defaults 
that you have set.  All reports created from this point 
forward will have these settings.  Close the Document 
Viewer.  Close the Adhoc Report dialog.  Close the 
Document Explorer. 

12. Select the User Preferences option on the Tools Menu.  
Use the Defaults button to restore your defaults back to 
those that match the Default user. 

13. This tutorial and this lesson are complete.  Close any open 
dialogs and exit People-Trak. 
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Lesson 32 
Contact Manager  

This lesson describes how to use the Contact Manager to track 
personal and professional contacts. 

Source Text 
People-Trak Basics – Chapter 24 

Tutorials 
Add a Contact: shows how to add a new contact to the list of 
contacts.  
 

Delete a Contact: demonstrates the techniques used to delete 
an existing contact. 
  
Using Ticklers: shows how to create and view date sensitive 
ticklers associated with contacts. 
 
Make a Contact Common: shows how to make one of your 
contacts common to all users. 
 

Tutorial 32.1 
Add a Contact 
1. Start the Contact Manager using the Contacts option on 

the Tools Menu or the Contact Manager icon on the 
Toolbar.  The Contact Manager dialog is displayed. 

2. The Contact Manager uses the same operating 
conventions as modules within People-Trak.  Let’s use 
these conventions to add a contact now. 

3. Use the New Contact option on the File Menu or the New 
Contact button to start a new contact.  A new contact is 
started and the phrase “New Contact” is added as the 
company name.  The new contact is also added to the 
contact dropdown on the Toolbar. 

4. Complete the contact by adding a few fields.   When 
complete, exit the Contact Manager.  The new contact 
will be automatically saved. 

5. Start the Contact Manager again.  This time, note that a 
list of all active contacts (your new contact) is displayed 
in the contact dropdown.  The first contact in the list (your 
new contact) is active. 

6. Start a second new contact and add a few fields.  When 
complete, use the Next Contact button to move to the next 
contact.  This will automatically save the contact being 
added and display the next contact, which is actually the 
first contact we added. 

7. Close the Contact Manager.  

Tutorial 32.2 
Delete a Contact 
1. Start the Contact Manager. 

2. Select one of the contacts that you have added. 

3. When the desired contact is displayed, use the Delete 
Contact option on the File Menu or the Delete Contact 
button on the Toolbar to delete the contact.  Note that the 
record is removed from the contact dropdown and that the 
list of available contacts is reduced by one.  The contact 
that is currently displayed switches from the contact being 
deleted to the next contact in the list. 

4. Close the Contact Manager and continue with the next 
tutorial. 

Tutorial 32.3 
Using Ticklers 
Tickers are like Alerts except that they are unique to the 
Contact Manager.  You can set a tickler with a message and a 
date and when the date arrives, you will be notified. 

1. Start the Contact Manager. 

2. Select a contact. 

3. Position to the Tickler field and enter a brief message or 
reminder. 

4. Position to the Tickler Date field and enter today’s date.  
This will be the date when the tickler will become active.  
Normally, you would enter a future date, but for 
demonstation purposes, we need to enter the current date. 

5. Close the Contact Manager. 

6. Now, let’s assume that it is the start of a future day and 
we wish to check the Inbox for alerts, scheduled items, 
and ticklers. 

7. Check the Inbox now.  Note that your tickler is listed 
along with any other inbox transactions. 

8. Close the Inbox.  You can have one tickler per contact.  
Once a tickler expires, you can set another tickler by 
changing the date and the message as necessary. 
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Tutorial 32.4 
Make a Contact Common  
When you add a contact to your contact list, that contact is in 
your list only.  This makes sense for your personal contacts.  
However, some business contacts can be common to all users. 

1.  Start the Contact Manager. 

2. Select the contact you wish to make common. 

3. Use the Make Contact Common option on the File Menu 
to make the contact common. 

4. This contact will now show up for all users. 

5. Close the Contact Manager. 

6. This tutorial and this lesson are complete.  Close any open 
dialogs and exit People-Trak. 
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Lesson 33 
Inter-Module Communication  

This lesson describes how information can be shared between 
the various People-Trak modules so that redundant data entry 
is entirely avoided. 

Source Text 
People-Trak Basics – Chapter 24 

Tutorials 
Applicant to Personnel: demonstrates how to transfer 
applicant information from the applicant record to a new 
employee record when the record is created. 

Personnel to Applicant, Safety, COBRA: shows how to 
transfer employee information to the applicant, safety, and 
COBRA modules. 

Position Control to Personnel, Applicants: demonstrates 
how to load position information from the Position Control 
module into the Personnel and Applicant modules. 

Tutorial 33.1 
Applicant to Personnel 
One of the most common inter-module transfers is the transfer 
of applicant information to personnel when an applicant is 
hired.  Here is how it is done. 

1. Start People-Trak and select the Personnel Module. 

2. Select the Module Setup option on the Administration 
Menu.  Position to the Options tab.  Verify that the 
“Prompt for Applicants” checkbox is checked.  When 
checked, you will be prompted to import from applicants 
when a new record is created.  When not checked, the 
import from applicants feature is ignored. 

3. Position the cursor to the “Applicant Database” field.  
This field is used to indicate the company from which 
applicants are to be retrieved.  If the field is blank you 
will be prompted for the company.  When you know the 
company in advance, you can avoid the unnecessary 
prompt by specifying a company in this field.  To keep 
things simple, set this field to the DEMO company. 

4. Close the Module Setup dialog. 

5. Use the New Employee option on the File Menu or the 
New Employee button to create a new record.  The 
Personal screen is displayed followed by a list of the 
applicants in the DEMO company.  You can select any of 
the applicants to create an employee record for that 
applicant.  Pick the record for Julie Carrington. 

6. The Select Applicant dialog is cleared and the relevant 
information from the applicant record for Julie Carrington 
is displayed in the modified color just as if you had just 
keyed it. 

7. Move through the screens and you will find relevant 
information from the applicant record now stored in the 
employee record.  The amount of information is limited to 
the information that is common between the modules and 
the information that was actually entered in the applicant 
module.  If no background or skills information was 
entered, it cannot be transferred.  Add an employee ID 
and save the record. 

8. The applicant record remains in the Applicant module.  
Only a copy was moved to the Personnel module. 

9. Continue with the next tutorial. 

Tutorial 33.2 
Personnel to Applicants, Safety, 
COBRA 
Information can be transferred from the Personnel module to 
the Applicants module, the Safety Management module, and 
the COBRA Administration module.  The methods for each 
are unique. 

1. If you have an active internal hiring process, it can be 
beneficial to track employee records in the Applicants 
module.  The manner in which employee records are 
transferred to Applicants is very similar to the way 
applicant records are transferred to Personnel. 

2. Exit the Personnel module and start the Applicants 
module.  Select the Module Setup option from the 
Administration Menu and position to the Options tab.  
Activate the “Prompt for Employees” feature and set the 
Employee Company to be “DEMO”.  Close the Module 
Setup dialog. 

3. Use the New Applicant option on the File Menu or the 
New Applicant button on the Toolbar to create a new 
record.  The Personal screen is displayed followed by a 
list of the employees in the DEMO company.  You can 
select any of the employees to create an applicant record 
for that employee.  Pick the record for Donald Stern. 

4. The Select Employee dialog is cleared and the relevant 
information from the employee record for Donald Stern is 
displayed in the modified color just as if you had just 
keyed it. 

5. Move through the screens and you will find relevant 
information from the employee record now stored in the 
applicant record.  The amount of information is limited to 
the information that is common between the modules and 
the information that was actually entered in the Personnel 
module.  If no background or skills information was 
entered, it cannot be transferred.  Add an applicant ID and 
save the record. 

6. The employee record remains in the Personnel module.  
Only a copy was moved to the Applicant module. 

7. The way in which employee information is transferred to 
the Safety Management module is a little different.  We’ll 
demonstrate that now. 
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8. Close the Applicant module and select the Safety 
Management module. 

9. Use the New Incident option on the File Menu or the New 
Incident button on the Toolbar to create a new record.  
You will not be prompted for an employee ID because 
some incidents may not pertain to an employee and 
because there can be multiple incidents per employee. 

10. Position the cursor to the Employee ID field on the 
Incident screen. Use the button to display a list of the 
employees in the current company.  Select Donald Stern. 

11. The Select Employee dialog is cleared and the relevant 
information from the employee record for Donald Stern is 
displayed in the modified color just as if you had just 
keyed it.  With this transfer, the information is limited to 
the name, address, and demographic information.  
Normally, you would now add additional information to 
complete a basic incident record.  For now, however, 
abandon the record using the Delete Incident option on 
the File Menu. 

12. The way in which employee information is transferred to 
the COBRA Administration module is again different 
from the other two transfers.  We’ll demonstrate that now. 

13. Close the Safety Administration module and select the 
Personnel module. 

14. Select the record for Donald Stern and position to the 
Status screen.  Position to the Qualifying Event field in 
the COBRA section on that screen.  Complete the fields 
on the screen as follows. 
 
Qualifying Event:  Medicare Eligibility 
Qualifying Event Date: 07-01-2003 
Date Employer Notified 07-07-2003 
Election Letter Date:  07-10-2003 
Date of Election:  07-30-2003 

15. When complete, use the Elect button to start the transfer 
process.  The message shown below is displayed. 
 
Create COBRA record for this Employee? 

16. Press the Yes button to create the record.  A message 
confirming the record creation is displayed.  Clear the 
message.  Note that the “Elected COBRA” checkbox is 
now checked indicating that COBRA record has been 
created. 

17. Close the record for Donald Stern. 

18. Close the Personnel module and open the COBRA 
Administration module. 

19. Select the record for Donald Stern.  Move through the 
screens and note that all relevant information has been 
transferred including the fields you just entered.  Also, if 
Donald Stern was enrolled in any COBRA eligible benefit 
plans, enrollment in those plans has been started as well. 

20. Close the record for Donald Stern and close the COBRA 
Administration module. 

21. Continue with the next tutorial. 

Tutorial 33.3 
Position Control to Personnel, 
Applicants 
Information can be transferred from the Position Control 
module to the Personnel module and the Applicants module.  
The methods are similar, but we’ll show both. 

1. Start the Personnel module and select the record for 
Donald Stern.  Position to the Compensation screen and 
use the button at the far right of the first row to popup the 
Job Detail screen. 

2. On the Job Detail screen, you can complete job details 
using either the job table or the Position Control module.  
The job table brings in a number of fields, but the Position 
Control module can be used to populate virtually the 
entire screen.  Lets try it. 

3. Position to the Job Code field and select any job (other 
than the current job).  Note how much information is 
populated.   

4. Now position to the Position Number field and select any 
position (other than the current position).  Note how much 
more information is populated.   All of this information 
comes from the Position Control module. 

5. You can only use the Position Control module to populate 
position information if you have licensed the Position 
Control module.  Now lets see how position information 
can be transferred to the Applicant module. 

6. Close the record for Donald Stern. 

7. Close the Personnel module and start the Applicants 
module.  Select the applicant record for Donald Stern. 

8. Position to the Positions screen and use the button at the 
far right of the first row to popup the Position Detail 
screen.   

9. This screen is very similar to the Job Detail screen in the 
Personnel module. On the Position Detail screen, you can 
complete position details using either the job table or the 
Position Control module.  The job table brings in a 
number of fields, but the Position Control module can be 
used to populate virtually the entire screen.  Lets try it. 

10. Position to the Position Number field and select any 
position (other than the current position).  Note how much 
information is populated.   All of this information comes 
from the Position Control module. 

11. You can only use the Position Control module to populate 
position information if you have licensed the Position 
Control module.  

12. Close the record for Donald Stern. 

13. This tutorial and this lesson are now complete.  Exit 
People-Trak. 



 

Basic Training Guide - 111 

5 
Setup and 
Administration 
Lesson E – Enterprise/Company Setup 
Tutorial E.1 – Adding/Deleting Companies 
Tutorial E.2 – Changing Logo and Report Appearance 
Tutorial E.3 – Changing Formats 
Tutorial E.4 – Using External Programs 

Lesson F – Module Setup 
Tutorial F.1 – Changing Active Screens 
Tutorial F.2 – Changing Lookup Fields 
Tutorial F.3 – Using Auto-Numbering 

Lesson G – Security Setup 
Tutorial G.1 – Securing Companies and Modules 
Tutorial G.2 – Securing Menu Options 
Tutorial G.3 – Setting Field Security 
Tutorial G.4 – Setting Record Security 

Lesson H – Import 
Tutorial H.1 – Setting Up Import 
Tutorial H.2 – Performing the Import 
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Notes 
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Lesson E 
Enterprise/Company Setup  

This lesson describes the techniques used to maintain 
enterprise settings and to add, delete, and maintain individual 
company settings. 

Source Text 
People-Trak System Administration – Chapter 3 

Tutorials 
Adding/Deleting Companies: demonstrates how to add and 
delete companies.  Also shows how the enterprise settings act 
as defaults for each new company. 

Changing Logo and Report Appearance: shows how to 
modify the report header to fit your needs. 

Changing Formats: demonstrates how data formatting works 
and how you can modify the formats for dates, phone 
numbers, and social security numbers. 

Using External Programs: shows how to add external 
programs to the People-Trak main menu for execution from 
within People-Trak. 

Tutorial E.1 
Adding/Deleting Companies 
This tutorial describes how to add and delete companies.  This 
will only be applicable for your organization if you have 
licensed the multi-company feature. 

1. Start People-Trak and select the Personnel Module. 

2. Select the Enterprise Setup option on the Administration 
Menu.  The Enterprise Setup dialog determines the 
default settings that will apply whenever a new company 
is created.  Note the name and address information for the 
enterprise.  Close the Enterprise Setup dialog. 

3. Select the Company Setup option on the Administration 
Menu.  The dialog is very similar to the Enterprise Setup 
dialog except that the Company Setup dialog provides the 
ability to add and delete companies.  Let’s add a company 
now. 

4. Use the New Company option on the File Menu or the 
New Company button on the Toolbar to create a new 
company.  A new company will be created using the 
current information stored on the Enterprise Setup dialog.  
The name and address information that you noted will be 
present for the new company.  Note that a new company 
named NEW1 has been added to the list of companies.   

5. You can change this company ID quite readily by 
positioning to the Company ID field.  Change the ID from 
NEW1 to NEWGOO now.  Note that the name in the text 
box and the list of companies is changed for you. 

6. Move through the other tabs and note that the information 
from the Enterprise Setup dialog has all been moved into 
the new company.  You can change any of this 
information to reflect any required differences in the new 
company.  This includes name and address information, 
the company logo, and format settings.  Close the 
Company Setup dialog. 

7. Select the Enterprise Setup option and change the address 
for the enterprise. Then close the Enterprise Setup dialog 
and return to the Company Setup dialog.  Note that the 
address information on the company “NEWGOO” is 
unchanged.  Changing the enterprise information after a 
company has been created will not affect the company. 

8. Using what you have already leaned, create another new 
company.  Note that this new company does indeed have 
the new name and address from the enterprise.  Also, note 
that the company name is NEW1 again because NEW1 is 
no longer in use.  Create another company and note that 
the company name is set to NEW2. 

9. Companies can readily be deleted and we will readily 
delete these three companies now.  However, in real 
practice, a company could contain a vast amount of 
information you may wish to keep.  It would be a rare 
situation in which you would delete a company that 
contained valid information. 

10. Delete the company named NEWGOO by first selecting 
that company.  Then use the Delete Company option on 
the File Menu or the Delete Company button on the 
Toolbar to delete the company.  You will be asked to 
confirm the deletion.  Go ahead and delete the company.  
Now select and delete NEW1 and NEW2.   

11. Close the Company Setup dialog and continue with the 
next tutorial. 

Tutorial E.2 
Changing Logo and Report 
Appearance 
People-Trak provides flexibility in how report headers are 
formatted.  You can set the positions of the company logo and 
the report title to suit your requirements.  Here’s how. 

1. Select the Enterprise Setup option on the Administration 
Menu. 

2. Position the cursor to the Options tab.  Note that the 
Header Style is set to “right” and that the Logo Style is set 
to “left”. 

3. Use the Print button on the Toolbar to print an Enterprise 
Setup Listing.  We are not interested in the information 
shown, but in the format of the header.  As the settings 
indicated, the header is to the right and the logo is to the 
left.  You can change this.  Here’s how. 

4. Close the Document Viewer.  Reverse the header and 
logo styles and close the Enterprise Setup dialog to save 
the changes.  Now select Enterprise Setup again, position 
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to the Options tab and then print the report.  This time 
header is to the left and the logo is to the right.  Close the 
Document Viewer. 

5. You can position the header and logo however you wish.  
In fact, you can actually position them over each other.  
This might make sense if you have a gray scale logo that 
you wish to treat similar to a watermark.  Our sample logo 
is hardly a watermark, but let’s try this anyway. 

6. Set both the header and the logo to display on the left.  
Close the Enterprise Setup dialog to save the changes.  
Select the Enterprise Setup dialog again and print the 
report again.  Note that the text of the header is displayed 
over the logo.  Again, this may look ugly with this logo, 
but with a very light logo, the effect might be just what 
your organization wants.  Close the Document Viewer. 

7. The logo itself can be set on the Logo tab.  Position to the 
Logo tab and see how it works.  There are specific 
settings we will provide when you use your own logo and 
this is where you select your logo.  Once selected, the 
logo is stored within the People-Trak database and the 
original file is no longer required.   

8. To select a new logo from a file, select the “Select Logo” 
button.  A file dialog is displayed that will allow you to 
search your PC for the logo file.  Since we do not have 
another logo file available, let’s press the Cancel button to 
close the file dialog.  Now you know how to do it.  

9. For those organizations that do not wish to use a Logo in 
reports, the default logo can be cleared. 

10. Continue with the next tutorial. 

Tutorial E.3 
Changing Formats 
People-Trak has various pre-defined formats for dates, times, 
social security numbers, telephone numbers and currency 
values.  All data is stored in the People-Trak database 
unformatted.  The formatting is applied when the data is 
retrieved and displayed on the screen or in reports.  Because 
the formatting is applied when needed, it is possible to have 
different formats for different companies and to change the 
formats at any time.  Let’s do this now. 

1. Use the Open Employee feature to select Donald Stern for 
editing.  Position the cursor to the Personal screen. 

2. On the Personal screen, note the format for telephone 
numbers, dates, and the social security number. Then 
close the record. 

3. Select the Enterprise Setup option on the Administration 
Menu.  Position to the Formats tab.  At the Date Format 
field, select one of the other date formats.  At the Phone 
Format field, select one of the other phone formats.  At 
the Social Format field, switch to the 3-3-3 (Canadian) 
format.  Close the Enterprise Setup dialog. 

4. Open the record for Donald Stern and position to the 
Personal screen.  Note the telephone number fields.  They 

are now formatted according to the selected format.  The 
same is true for the dates and the social security number.  
The same will also be true for these fields when they are 
used in reports. 

5. Remember, data is actually stored in non-formatted.  It is 
formatted when it is actually displayed or printed.  Thus, 
you can change the format at any time and the data will 
always be formatted correctly.   

6. To demonstrate this, change the formats back to their 
original values using the Enterprise Setup dialog.  Save 
the changes and then select Donald Stern again.  Note that 
everything is back to how it was when we started this 
exercise. 

7. Continue with the next tutorial. 

Tutorial E.4 
Using External Programs 

You can use People-Trak to start up to three different 
programs other than People-Trak directly from the People-
Trak menu.  Here’s how. 

1. Select the Enterprise Setup option on the Administration 
Menu. 

2. Position the cursor to the Options tab.  Then position the 
cursor the External Program 1 field.  Use the button 
adjacent to the field to activate the file dialog. 

3. Use the file dialog to locate the EXPLORER.EXE 
program in the Windows directory on your PC.  When 
located close the file dialog to return the directory path to 
the EXPLORER.EXE.  You should see that path 
displayed in the External Program 1 field. 

4. Close the Enterprise Setup dialog.  When you close the 
dialog, an additional icon is added to the main menu.  The 
icon will be a stylized “1” representing external program 
1.  If you select external programs 2 and 3, similar icons 
will be displayed for those programs. 

5. Click on the new icon to launch the Explorer program.  
Then close the program to return to People-Trak. 

6. The external programs option is useful for specialty 
programs that you like to run when you are in People-
Trak.  This can include Word, Excel or any other program 
that can be executed under Windows. 

7. This tutorial and this lesson are complete.  Close any open 
dialogs and exit People-Trak. 
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Lesson F 
Module Setup  

This lesson describes the techniques used to navigate between 
the various screens in a People-Trak module.  It also describes 
the data validation and formatting features of People-Trak. 

Source Text 
People-Trak System Administration – Chapter 3 

Tutorials 
Changing Active Screens: show how to deactivate screens 
that the organization does not wish to use and how to 
reactivate those screens at any later time.  Also shows the 
process to activate and deactivate sub-screens. 

Changing Lookup Fields: demonstrates how to change the 
fields used to lookup record on the Lookup dialog and on 
Workflows. 

Using Auto-Numbering: shows how to activate, customize, 
and use the auto-numbering feature. 

Tutorial F.1 
Changing Active Screens 
People-Trak provides a number of screens and sub-screens 
within each module.  You can elect to use any combination of 
these screens.  If you deactivate a screen or sub-screen, you 
can reactivate it at any time.  We’ll show you how in this 
tutorial. 

1. Start People-Trak and select the Personnel Module. 

2. Use the Open Employee feature to open the record for 
Donald Stern.  Review the Screens drop-down and note 
the number of screens present.  Close the record for 
Donald Stern. 

3. Select the Module Setup option from the Administration 
Menu.  The cursor is positioned to the Screens tab. 

4. Use the mouse to single-click and disable three or four 
screens.  A screen is disabled if the check box is 
unchecked.  When you have deactivated some screens, 
close the Module Setup dialog. 

5. Use the Open Employee feature to open the record for 
Donald Stern.  Review the Screens drop-down and note 
the number of screens present.  The screens that you have 
deactivated should no longer be listed.  Close the record 
for Donald Stern. 

6. Select the Module Setup option from the Administration 
Menu.  The cursor is positioned to the Screens tab. 

7. Reactivate each of the screens that you have deactivated 
by setting the checkbox. 

8. Position to the Personal screen and place the mouse over 
the text part of the entry, not the check box.  Now double-
click on the text.  The Treeview control will open up and 
the sub-screens will be listed.  The sub-screens also use 
checkboxes for activation and deactivation.   

9. Use the checkbox to deactivate some of the sub-screens 
on the Personal screen.  When complete, close the 
Module Setup dialog. 

10. Open a record for Donald Stern and position to the 
Personal screen.  Note that the buttons for the sub-screens 
that you have deactivated are longer shown.  Without the 
button, you cannot display the screen.  Close the record 
for Donald Stern. 

11. Use the Module Setup dialog to reactivate the sub-screens 
and then close the dialog.  

12. Using the Module Setup dialog, screens and sub-screens 
are made available or unavailable for all users throughout 
People-Trak.  If you disable a screen, it is disabled in 
every place where a list of screens would be displayed.  It 
is possible to activate and deactivate screens by user.  
This will be explained in the User Setup lesson.   

13. Continue with the next tutorial. 

Tutorial F.2 
Changing Lookup Fields 
The fields used to lookup records on the first tab of the 
Lookup dialog as well as those used for Workflows are preset 
within each module, but can be changed at any time.  This is 
how you do it. 

1. Use the Open Employee feature to start the Lookup 
dialog.  Note that the order of the lookup fields on the ID 
and Name tab is Employee ID, Employee Last Name, 
First Name, and Hire Date. 

2. Press the Search button to select a group of records.  Note 
that the four fields in record grid match the lookup fields 
by name and order.  Close the Lookup dialog. 

3. Select the Address workflow from the Activities Menu.  
Note that the two lookup fields match the first two fields 
shown on the ID and Name tab on the Lookup dialog.  
Close the Address workflow. 

4. Select the Module Setup option from the Administration 
Menu and position the cursor to the Lookup tab.  The 
Lookup tab provides four fields in which to record the 
fields to be used for lookup.  Note that the list matches the 
list you verified in the first few steps.  Let’s change the 
list now. 

5. If you are the type of person that remembers employee 
names rather than employee numbers, you may find that 
having the Employee ID as the first lookup field forces 
you to move the cursor down one field so that you can 
perform a lookup by last name.  Let’s fix that situation by 
changing the order of the first two fields. 



 

Basic Training Guide - 116 

6. Use the button adjacent to Lookup Field 1 to display a list 
of the fields.  Find the Last Name field and select it.  This 
will make the Last Name field the first lookup field (as 
well as the second lookup field). 

7. Change the second field to the Employee ID.  Close the 
Module Setup dialog. 

8. Use the Open Employee feature to start the Lookup 
dialog.  Note that the order of the lookup fields on the ID 
and Name tab reflects the changes you have made.  Press 
the Search button to select a group of records.  Note that 
the four fields in the record grid match the modified order 
as well.  Close the Lookup dialog. 

9. Select the Address workflow from the Activities Menu.  
Note that the two lookup fields have been changed here as 
well.  Close the Address workflow. 

10. Use the Module Setup dialog to reset the original lookup 
field order.  In this tutorial, we modified the first two 
lookup fields.  You can actually change all four to any 
desired value and you can change again at any time. 

11. The lookup field changes made with the Module Setup 
dialog apply to all users throughout the module.  It is not 
possible for each user to have personal lookup 
preferences. 

12. Continue with the next tutorial. 

Tutorial F.3 
Using Auto-Numbering 
People-Trak provides an extensive auto-numbering feature 
that allows you to automatically assign employee numbers, 
applicant numbers, etc. when a record is first created.  These 
numbers can contain optional prefix and suffix values.  The 
feature is easy to setup and use.  Here’s how. 

1. Use the New Employee feature to create a new employee 
record.  Note that a new, blank record is automatically 
created and that no employee number is assigned.  Close 
the record. 

2. Select the Module Setup option from the Administration 
Menu and position the cursor to the AutoNumbering tab.  
The tab contains two sections: one to activate auto-
numbering for the Personnel module and set the optional 
prefixes and suffixes and another to set the starting 
number for each company. 

3. Use the checkbox to activate auto-numbering.  Then, set 
the starting number for the DEMO company to 1000.  
Close the Module Setup dialog. 

4. Use the New Employee feature to create a new employee 
record.  Note that a new, blank record is automatically 
created and that employee number 1000 is automatically 
assigned.  Add a last name to the record and then save the 
record. 

5. Use the Module Setup dialog to add a prefix to the auto-
numbering format.  Use the phrase “ABC-“ without the 
quotes, of course. 

6. Now create a new employee again.  This time, the 
employee number will be the following: 
 
ABC-1001   

7. Add a last name to the record and then save the record. 

8. Use the Module Setup dialog to add a suffix to the auto-
numbering format.  Use the phrase “-XYZ” without the 
quotes, of course. 

9. Now create another new employee.  This time, the 
employee number will be the following. 
 
ABC-1002-XYZ 

10. Add a last name to the record and then save the record. 

11. You can reset the starting number at any time and it will 
skip any numbers that are in use and reuse numbers that 
are not.  Let’s try this. 

12. Delete the employee we created that numbered 1000. 

13. Use the Module Setup option to remove the prefix and the 
suffix and to reset the starting number for the DEMO 
company to 1000.   

14. Create a new record.  Note that employee number 1000 is 
reused because it is available.  This is a nice feature if 
your organization insists on using all available numbers.  
Sometimes a record is started, saved, and then deleted.  
You can reset the number and be assured that the very 
next available number in the sequence will be used, even 
if that number was used and then deleted. 

15. Auto-numbering can be activated or deactivated at any 
time.  Use the Module Setup option to deactivate the 
feature now.  All you need to do is set the checkbox.  If 
the checkbox is not checked, the starting number and 
other values are ignored. 

16. If auto-numbering is activated, it applies to all companies 
for that module.  You can have entirely different number 
ranges within each company, but the prefix and suffix will 
be the same.  It is not possible to have one company with 
auto-number active and another without.  However, each 
module can activate or deactivate auto-numbering 
separately.  Thus, it is possible to use auto-numbering for 
applicants, but not for employees. 

17. This tutorial and this lesson are complete.  Close any open 
dialogs and exit People-Trak. 
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Lesson G 
Security Setup 

This lesson describes the techniques for establishing user 
security. 

Source Text 
People-Trak System Administration – Chapter 3 

Tutorials 
Securing Companies and Modules: shows how to secure 
companies and modules. 

Securing Menu Options: show to secure menu options for 
both administrative and other menus. 

Setting Field Security: demonstrates how to set the three 
different levels of field security. 

Using Simple Record Security: shows how to set simple 
record security. 

Tutorial G.1 
Securing Companies and 
Modules 
1. Start People-Trak and select the Personnel Module. 

2. Select the Security Setup option on the Administration 
Menu.  When you first enter the Security Setup dialog, the 
user ID you entered People-Trak with becomes the 
current user record being edited.  You can use the list of 
users to select any other user for editing. 

3. By default, the DEMO user is set to be an administrator.  
Administrators are not subject to any of the security 
features in People-Trak.  You can make security settings 
for an administrative user, but they will not be honored.  
On the General tab, change Administrator checkbox for 
the DEMO user to “Off”. 

4. Close the Security Setup dialog.  Use the Select Company 
option on the File Menu to display a list of the companies 
to which you currently have access.  There should be 
three: ACTIVE, ARCHIVE, and DEMO.  Close the 
dialog. 

5. Select the Security Setup option and position to the 
Database (company) tab.  The tab shows a list of the 
companies that have been defined.  If you have licensed 
the multi-company feature, this list will be dynamic and 
will change as companies are added or deleted.  If you 
have not licensed the multi-company feature, this list will 
contain the standard three companies: ACTIVE, 
ARCHIVE, and DEMO. 

6. Deactivate ACTIVE and ARCHIVE by setting the 
checkboxes.  Then close the Security Setup dialog. 

7. Use the Select Company option on the File Menu to 
display a list of the companies to which you currently 
have access.  There should be just one now: DEMO.  
Close the dialog.  Given that you can only select a 
company that is shown, you are not restricted to the 
DEMO company. 

8. Select the Security Setup option and position to the 
Database (company) tab.  Restore access to ACTIVE and 
ARCHIVE.  Close the Security Setup dialog and confirm 
that the companies have been reactivated.  Close all 
dialogs. 

9. Use the Exit Module option on the File Menu to return to 
the Select Module dialog.  One after another, select each 
module to verify that you have access.  Once you enter a 
module, simply use the Exit Module option to return to 
the Select Module dialog.  When you have verified that 
you have access to each module, return to the Personnel 
module. 

10. Select the Security Setup option and position to the 
Module tab.  Turn off the Safety Management module and 
close the Security Setup dialog. 

11. Use the Exit Module option on the File Menu to return to 
the Select Module dialog.  The Select Module dialog is 
not dynamic.  This means that is always shows all of the 
modules, even those to which you do not have access.  
This does not mean that the modules are not secured.  
Let’s find out. 

12. Select the Safety Management module.  What happens?  
You are denied access because you cannot access a 
secured module.  Try one of the other modules.  You will 
be granted access.  Return to the Personnel module. 

13. Use the Security Setup dialog to reactivate the Safety 
Management module.  Close the dialog. 

14. Continue with the next tutorial.  

Tutorial G.2 
Securing Menu Options 
The Security Setup dialog provides two different tabs for 
securing menu options.  The Administration tab provides a list 
of the menu options on the Administration menu.  This tab 
remains the same regardless of which module you are in.  The 
Menu tab provides a list of the menu options within the 
module and differs with the module you are in.  Both tabs 
work in the same way. 

1. Select the Security Setup option and position to the 
Administration tab. 

2. Deactivate the Enterprise Setup, Module Setup, and User 
Setup programs.  Then exit the Security Setup dialog. 

3. Click on the Administration Menu and leave the menu 
displayed.  Note that the three options you have just 
secured are not disabled or “grayed out”.  Because they 
cannot be selected, they are secure and you cannot use 
them.  (Please note that had you secured the Security 
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Setup option, we would be done for the day as we would 
not have been able to return to the Security Setup dialog 
to keep working.) 

4. From the menu, select Security Setup.  Position to the 
Administration tab and reactivate the three options. 

5. Position to the Menu tab.  This tab provides two lists.  
The first list is a list of the menus (other than the 
Administration Menu).  The second list is a list of the 
menu options on the menu currently selected.  Lets make 
a few settings and try it out. 

6. On the File Menu, disable the New Record and Delete 
Record options.  On the Tools Menu, disable the Field 
Customization option.  On the Screens Menu (actually a 
list of the screens) disable a few screens.  Finally, on the 
Tables Menu (actually a list of the tables that can edited, 
disable a few tables.  Close the Security Setup dialog.  
Now, let’s confirm that the security works. 

7. Click on the File Menu and leave the menu displayed.  
Note that the New Record and Delete Record options are 
disabled and cannot be selected.  Clear the File Menu. 

8. Click on the Tools Menu and leave the menu displayed.  
Note that the Field Customization option is disabled and 
cannot be selected.  Clear the Tools Menu. 

9. Select the record for Donald Stern. The screens that you 
have disabled will not be in the Screens dropdown and 
cannot be displayed.  Close the record for Donald Stern. 

10. Select the Table Edit option from the Tables Menu.  
When the list of tables that can be edited is displayed, 
note that the tables you disabled are not listed and cannot 
be edited.  Close the Select Table to Edit dialog. 

11. Use the Security Setup dialog to restore access to all of 
the menu options you disabled.  Close the Security Setup 
dialog when complete. 

12. Continue with the next tutorial. 

Tutorial G.3 
Setting Field Security 
Unlike the other security settings field security has three 
different states.  Fields can be set to editable, viewable but not 
editable, and not viewable.  Here’s how to do it. 

1. Select the record for Donald Stern for editing.  Position 
the cursor to the Last Name field on the Personal screen.  
The field is completely editable.  Position the cursor to 
the First Name field.  The field is completely editable.  
Now, let’s secure them. 

2. Close the record for Donald Stern.  Select the Security 
Setup option and position the cursor to the Screen/Field 
tab.  As with the Menu tab, this tab has two lists.  The left 
list is a list of the screens and the right list is a list of the 
fields on the current screen.  You can navigate through 
the screens to find the fields you want. 

3. On the Personal screen, position the cursor to Last Name 
field.  Use the mouse to toggle the security status from 
Full Access to Display Only. 

4. On the Personal screen, position the cursor to the First 
Name field.  Use the mouse to toggle the security status 
from Full Access to No Access. 

5. Close the Security Setup dialog. 

6. Select the record for Donald Stern for editing.  Position 
the cursor to the Last Name field on the Personal screen.  
This field was set to Display Only status.  You can put the 
cursor to the field, but you cannot edit the field. 

7. Now position the cursor to the First Name field.  Whoops, 
its not there.  We set this field to “No Access” and thus 
the field cannot be seen or edited. 

8. Close the record for Donald Stern. 

9. Use the Security Setup dialog to reactivate the fields that 
have been secured. 

10. Continue with the next tutorial. 

Tutorial G.4 
Setting Record Security 
People-Trak provides two different types of record security: 
simple security and advanced filter security.  This tutorial will 
show how to use simple security. 

1. Select the Open Employee feature.  Use the Search button 
to generate a list of all of the records in the DEMO 
company.  Note the list and the number of records 
indicated at the bottom of the dialog.  Close the dialog 
without selecting a record for editing. 

2. Select the Security Setup option and position to the 
Record tab.  This tab contains a list of all the records in 
the company.  Within each module, the list will be 
different.  For the personnel module, the list will be 
employees.  For the applicant module, the list will be 
applicants. 

3. Using the checkboxes, disable a group of employees.  
Close the Security Setup dialog. 

4. Select the Open Employee feature.  Use the Search button 
to generate a list of all of the records in the DEMO 
company.  This list will now be subject to the security just 
established.  Note the list and number of records indicated 
at the bottom of the dialog.  The list and the count should 
reflect the records you have secured.  Close the dialog 
without selecting a record for editing. 

5. Use the Security Setup dialog to reactivate the employee 
records you secured.  Then close Security Setup dialog. 

6. This tutorial and this lesson are complete.  Close any open 
dialogs and exit People-Trak. 
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Lesson H 
Import   

This lesson demonstrates how to use the export feature to 
export data for use in other products and application tools.  It 
also includes instructions for importing files into People-Trak 
that have been created from other applications. 

Source Text 
People-Trak Basics – Chapter 10 
 

Tutorials 
Setting Up Import: demonstrates how to setup a file for 
import. 

Performing the Import: shows how to perform an import and 
to verify the results. 

Tutorial H.1 
Setting Up Import 
In an earlier lesson we saved an export file that was modified.  
We will now demonstrate how to setup an import specification 
that will bring information into People-Trak.  We will be using 
the file you created in tutorial 23.1 for this example. 

1. Select the Import option on the Administration menu.  
The Import Specifications dialog is displayed. 

2. Use the New Specification option on the File Menu or the 
New Specification button on the Toolbar to start a new 
import specification.  The Import dialog is displayed. 

3. The first task required when creating an import 
specification is to identify the file to be imported.  Lets do 
that now. 

4. Position the cursor to the File Type field.  Use the button 
to select the “TAB” file type.  Note that the caption on the 
field “File or Database” is changed to “Directory Name” 
and the caption on the field “Table or Worksheet” is 
changed to “File Name”. 

5. At the “Directory Name” field, use the button to start the 
“Select Path” dialog and select the path to 
“C:\PEOPLETRAK”. 

6. At the “File Name” field, enter “TEST2”, or use the 
button to display a list of the TAB delimited files that 
exist in C:\PEOPLETRAK. 

7. Verify that the Header checkbox is checked and the press 
the “Connect” button.  The file will be opened and a list 
of the fields in the file will be displayed beneath the 
Import Field column on the grid.  To finish setting up the 
import, we need only map the fields in the file to the 
actual fields in People-Trak.  Here’s how. 

8. Position the cursor to the People-Trak column for the first 
row in the grid.  Use the button to display a list of fields 
and select the “Last Name” field from the list of fields on 
the Personal screen. 

9. Complete the other fields in the list in the same way.  As a 
hint, the People-Trak field names are the same as the 
Import Field names because the headings were taken 
directly from People-Trak. 

10. If you are ever uncertain about the contents of a field 
when determine which fields map to which fields, you can 
use the “View Sample Data” button.  Try it now. Position 
the cursor to the City field and press the button.  The 
sample data will show a collection of the cities in the 
database along with some other statistics.  Close the 
Sample Data dialog. 

11. When all fields have been mapped, continue with the next 
tutorial.  

Tutorial H.2 
Performing the Import 
We are now ready to import the data in the TEST2 file back in 
to People-Trak.  You will recall that we changed the employee 
ID for Donald Stern and the address for Jonathan Strauss in 
that file.  After import, that information in People-Trak should 
reflect those changes. 

1. Use the Run Import option on the File Menu or the Run 
Import button on the toolbar to start the import. 

2. The import will be processed.  A progress bar will 
indicate the records as they are being imported.  When the 
import is complete a summary report is displayed in the 
Document Viewer.  Close the Document Viewer.  Now it 
is time to verify the results of the import. 

3. For all records but Donald Stern and Jonathan Strauss, 
current data was imported over identical existing data.  
There is no way to validate.  For Jonathan Strauss, 
however, the address was changed.   

4. Select the record for Jonathan Strauss.  Position to the 
Address 1 field on the Personal screen.  Note that the 
address has indeed been changed to “XXX”.  Close the 
record for Jonathan Strauss. 

5. Use the Open Employee feature to display all of the 
records (just click on the Search button).  Click on the 
heading for the Last Name field on the grid to sort the 
records by Last Name.  Note that there are now two 
records for Donald Stern and that one has the original ID 
and the other has the ID “9999”.  Why? 

6. You will recall that we changed the employee ID for 
Donald Stern within Excel.  The import process compares 
employee ID’s during import.  If there is no record with a 
matching ID, the record is assumed to be an “add” rather 
than a “change”.  We did not change the ID for Jonathan 
Strauss and thus the existing record was selected and 
changed.  We did change the record for Donald Stern and 
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thus a new record was created.  The new record for 
Donald Stern will only contain those fields that were 
actually imported.   

7. Select the “9999” record for Donald Stern.  Note that on 
the Personal screen, only those fields that were imported 
are shown.  You can move through all of the screens and 
note that there is no additional information.  Import 
identified the second Donald Stern as an entirely new 
employee and created a blank record for him.  Then, the 
fields in the import file were recorded. 

8. Close the record for Donald Stern. 

9. This tutorial and this lesson are now complete.  Exit 
People-Trak. 


